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About This Guide

This guide describes how to install, upgrade, and update Novell® Open Enterprise Server (OES) 2 
SP1 Linux. Except where specifically stated, the content of this guide applies to installing OES 
Linux on a computer’s physical hardware rather than on a Xen* virtual machine host server.

“What's New” on page 11
“Preparing to Install OES 2 SP1 Linux” on page 13
“Installing Open Enterprise Server 2 SP1 Linux” on page 29
“Installing or Configuring OES 2 Services on an Existing OES 2 SP1 Linux or SLES 10 SP2 
Server” on page 89
“Upgrading to OES 2 SP1 Linux” on page 93
“Completing Installation or Upgrade Tasks on OES 2 SP1 Linux” on page 123
“Updating an OES 2 SP1 Linux Server” on page 127
“Using AutoYaST to Install and Configure Multiple OES 2 SP1 Linux Servers” on page 147
“Installing, Upgrading, or Updating OES 2 SP1 Linux on a Xen-based Virtual Machine” on 
page 157
“Disabling OES 2 SP1 Linux Services” on page 165
“Security Considerations” on page 167
“Installing Linux with EVMS as the Volume Manager of the System Device” on page 169
“OES 2 SP1 Linux File and Data Locations” on page 189
“Setting Up an Installation Source on NetWare” on page 191

Audience

This guide is intended for system administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

The latest version of the OES 2 SP1: Linux Installation Guide is available at the Open Enterprise 
Server 2 documentation Web site (http://www.novell.com/documentation/oes2/inst_oes_lx/data/
front.html).
About This Guide 9
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Additional Documentation

Table 1   Additional Documentation References

Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
within a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms, or a forward slash for 
other platforms, the pathname is presented with a forward slash to reflect the Linux convention. 
Users of platforms that require a backslash, such as Linux* or UNIX*, should use backslashes as 
required by the software.

For more information about See

Planning and implementing OES 2 SP1 for Linux OES 2 SP1: Planning and Implementation Guide

Migration from and coexistence with other products “Different Migration Tools” in the OES 2 SP1: 
Migration Tool Administration Guide

Installing OES 2 SP1 Linux on a Xen Virtual Host 
Server

Chapter 10, “Installing, Upgrading, or Updating 
OES 2 SP1 Linux on a Xen-based Virtual Machine,” 
on page 157

SLES 10 Installation and Administration details SUSE® LINUX Enterprise Server 10 Installation 
and Administration Guide (http://www.novell.com/
documentation/sles10/sles_admin/data/
sles_admin.html)
SP1: Linux Installation Guide
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1What's New

This section summarizes the features that have been updated with each release of Novell® Open 
Enterprise Server (OES) 2 Linux.

Section 1.1, “What’s New in OES 2 SP1,” on page 11
Section 1.2, “What’s New (OES 2 Initial Release),” on page 11

1.1  What’s New in OES 2 SP1
The following features were added or modified from the initial release installation:

Table 1-1   OES 2 SP1 Release

1.2  What’s New (OES 2 Initial Release)
In the initial release of OES 2 Linux, the following features were added to the OES Linux 
installation:

Table 1-2   OES 2 Initial Release

Functionality For More Information About

Unsupported packages are no longer removed by 
default. 

Installing OES 2 while installing SLES 10 SP1: See 
“Specifying the Add-On Product Installation 
Information” on page 37. 

Installing OES 2 services on a server that is already 
running SLES 10 SP1: See “Installing or 
Configuring OES 2 Services on an Existing OES 2 
SP1 Linux or SLES 10 SP2 Server” on page 89.

Functionality For More Information About

Open Enterprise Server 2 Linux is an add-on 
product that can be installed with SUSE® Linux 
Enterprise Server 10 SP1 or added to a server 
running SLES 10 SP1 with updates. 

Installing OES 2 while installing SLES 10 SP1: See 
“Specifying the Add-On Product Installation 
Information” on page 37. 

Installing OES 2 services on a server that is already 
running SLES 10 SP1: See “Installing or 
Configuring OES 2 Services on an Existing OES 2 
SP1 Linux or SLES 10 SP2 Server” on page 89.

DVD media is now also available to perform the 
installation.

See “Preparing Physical Media for a New Server 
Installation or Upgrade” on page 32.

OES 2 Linux can be installed on x86-64 bit 
hardware.

See Table 2-1 on page 14.
What's New 11
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Configuring OES services is easier to find and 
perform on multiple services.

See “Configuring Novell Open Enterprise Server 
Services” on page 59 and “Installing or Configuring 
OES 2 Services on an Existing OES 2 SP1 Linux or 
SLES 10 SP2 Server” on page 89.

A specific tool for extending the schema is available 
in YaST.

See “Extending the Schema” on page 16.

You can install OES 2 Linux on a Xen-based virtual 
machine host server.

See “Chapter 10, “Installing, Upgrading, or 
Updating OES 2 SP1 Linux on a Xen-based Virtual 
Machine,” on page 157.”

You can install OES 2 Linux as a Xen-based virtual 
machine host server.

See “Chapter 9, “Installing OES 2 SP1 Linux as a 
Xen VM Host Server,” on page 155.”

The method for updating OES matches the method 
for updating SLES 10 SP1.

“Updating an OES 2 SP1 Linux Server” on 
page 127.

Functionality For More Information About
SP1: Linux Installation Guide
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2Preparing to Install OES 2 SP1 
Linux

Before you install Novell® Open Enterprise Server (OES) 2 SP1 Linux, you should review the 
information in the following sections:

“Planning Your OES 2 Implementation” in the OES 2 SP1: Planning and Implementation 
Guide 
“Installing OES 2 SP1” and “Installation/Upgrade Issues” in the OES2 SP1: Readme

You should also perform the tasks and understand the information outlined in the following sections:

Section 2.1, “Don’t Mix 32-Bit and 64-Bit Options,” on page 13
Section 2.2, “Meeting All Server Software and Hardware Requirements,” on page 13
Section 2.3, “Preparing eDirectory for OES 2 SP1,” on page 15
Section 2.4, “eDirectory Rights Required to Install OES Linux,” on page 18
Section 2.5, “Deciding What Patterns to Install,” on page 20
Section 2.6, “Install Only One Server at a Time,” on page 27
Section 2.7, “What's Next,” on page 28

2.1  Don’t Mix 32-Bit and 64-Bit Options
OES 2 and SLES 10 both have 32-bit (i386) and 64-bit (x86_64) architectural versions. These 
versions cannot be mixed. In other words, you cannot install 32-bit OES with 64-bit SLES and the 
reverse is also true.

If you have a 64-bit server, you can install either the 32-bit or 64-bit versions of the software, but if 
your server is 32-bit, you can install only the 32-bit version of the software.

2.2  Meeting All Server Software and Hardware 
Requirements
Before installing OES 2 SP1 Linux, ensure that your system meets the following requirements.

Section 2.2.1, “Server Software,” on page 13
Section 2.2.2, “Server Hardware,” on page 14

2.2.1  Server Software
As part of the OES 2 SP1 Linux installation, you install SUSE® Linux Enterprise Server 10 SP2.

IMPORTANT: OES 2 SP1 services were developed and tested on a default SLES 10 server base. 
Preparing to Install OES 2 SP1 Linux 13
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As you install OES 2 SP1, do not change any of the SLES 10 Base Technologies package selections, 
such as Java support. Doing so can cause various problems, such as the installation failing or one or 
more OES 2 SP1 services not working properly.

If you are installing on an existing SLES 10 SP2 server, be sure to verify that all of the default SLES 
10 SP2 components are installed before attempting to install OES 2 SP1 services.

2.2.2  Server Hardware

Table 2-1   Server Hardware Requirements

System Component Minimum Requirements Recommended Requirements

Computer Server-class computer with 
Pentium* II or AMD* K7 450 
MHz processor

Server-class computer with Pentium III, 
Pentium III Xeon*, Pentium 4, Intel* Xeon 700 
MHz, AMD K8 CPUs (Athlon64 and Opteron*), 
Intel EM64T or higher processor. 

NOTE: Some OES services run in 32-bit mode 
only. 

Memory 512 MB of RAM 1 GB of RAM

Free Disk Space 7 GB of available, 
unpartitioned disk space

10 GB of available, unpartitioned disk space. 
Additional disk space might be required, 
depending on which OES components are 
selected and how they are used.

CD-ROM or DVD Drive 4X CD-ROM or DVD drive if 
installing from physical media

48X CD-ROM or DVD drive if installing from 
physical media

Hard Drive 20 GB

Network Board Ethernet 100 Mbps

IP address One IP Address on a 
subnet

If you install Novell 
iFolder®, you need an 
additional IP address. 
iFolder requires a 
separate IP address on 
Linux.

Subnet mask

Default gateway

Mouse N/A USB or PS/2

Server computer BIOS Using a CD-ROM or DVD 
installation source, prepare 
the BIOS on your server 
computer so that it boots from 
the CD-ROM or DVD drive 
first.
SP1: Linux Installation Guide
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NOTE: The RAM and disk space amounts shown here are for system components only. The OES 
Linux service components you install might require additional RAM and disk space. 

Be sure to complete the planning instructions found in the OES 2 SP1: Planning and 
Implementation Guide for each component you install. During that planning process, you are 
instructed to record and track the additional RAM and disk space you need on a worksheet.

2.3  Preparing eDirectory for OES 2 SP1
Section 2.3.1, “If Your Directory Tree Is Earlier than eDirectory 8.6,” on page 15
Section 2.3.2, “If Your LDAP Server Is Running NetWare 6.5 SP2 or earlier,” on page 16
Section 2.3.3, “If Your Tree Has Ever Had an OES 1 Linux Server with LUM Installed,” on 
page 16
Section 2.3.4, “Extending the Schema,” on page 16

2.3.1  If Your Directory Tree Is Earlier than eDirectory 8.6
If you are installing an OES 2 Linux server into an eDirectory tree that is earlier than eDirectory 8.6, 
do the following before installing your first OES Linux server in an existing NetWare tree:

1 Extend the schema using Deployment Manager. See “Schema Update” in the OES 2 SP1: 
NetWare Installation Guide.

2 Ensure that the schema is synchronized throughout the tree from [ROOT] by doing the 
following:
2a Verify that schema is synchronizing out from [ROOT] by entering the following 

commands at the System Console prompt of the NetWare server with the Master of 
[ROOT]:

set DSTRACE=on
set DSTRACE=nodebug
set DSTRACE=+Schema
set DSTRACE=*SSD
set DSTRACE=*SSA

2b Toggle to the Directory Services screen and look for the message: All Processed = 
YES

2c On each server that holds a Master of a partition, enter the following commands at the 
System Console prompt:

set DSTRACE=off

Video Card and Monitor 1024 X 768 resolution or 
higher NOTE: Although it is technically possible to run 

the ncurses installation at a lower resolution, 
some informational messages, etc. aren’t 
displayed because text strings don’t wrap to the 
constraints of the window.

System Component Minimum Requirements Recommended Requirements
Preparing to Install OES 2 SP1 Linux 15
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set DSTRACE=nodebug
set DSTRACE=+Schema
set DSTRACE=*SS

2d Toggle to the Directory Services screen and look for the message: All Processed = 
YES

2.3.2  If Your LDAP Server Is Running NetWare 6.5 SP2 or 
earlier
If you are installing into an eDirectory tree that is using a NetWare server to supply LDAP, upgrade 
the LDAP server that the OES Linux installation will communicate with to the NetWare 6.5 SP3 or 
later software. A server running NetWare 6.5 SP2 or earlier will probably abend.

2.3.3  If Your Tree Has Ever Had an OES 1 Linux Server with 
LUM Installed
<You need to fix the IDs for a couple of system users.>

2.3.4  Extending the Schema
An eDirectory tree must have its schema extended to accommodate OES 2 Linux servers and 
services as explained in the following sections.

“Who Can Extend the Schema?” on page 16
“Which OES 2 SP1 Services Require a Schema Extension?” on page 16
“Extending the Schema While Installing OES 2” on page 17
“Using the YaST Plugin to Extend the Schema” on page 17
“Extending the Schema for Novell Cluster Services (NCS)” on page 18

Who Can Extend the Schema?

Only an administrator with the Supervisor right at the [Root] of an eDirectory tree can extend the 
tree’s schema. 

Which OES 2 SP1 Services Require a Schema Extension?

The following service schema extensions are included with OES 2 SP1. 

A single asterisk (*) indicates a service that is either required for OES 2 Linux servers or for the 
default services that are installed on every OES 2 server. They are implemented when the first OES 
2 SP1 Linux server is installed in the tree. 

Unmarked  extensions are implemented the first time their respective services are installed, unless 
the schema was previously extended using another method, such as the YaST plugin (see “Using the 
YaST Plugin to Extend the Schema” on page 17).

CIFS
Directory Services*
iFolder
SP1: Linux Installation Guide
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iPrint
DHCP
DNS
Domain Services for Windows
Linux User Management*
NCP
NCS**
Novell Cluster Services requires extending the schema manually. Follow the instructions in 
“Extending the eDirectory Schema to Add Cluster Objects” in the OES 2 SP1: Novell Cluster 
Services 1.8.5 for Linux Administration Guide.
NetStorage
NMAS*
Novell Storage Services
Storage Management Services*

Extending the Schema While Installing OES 2

The simplest way to extend the schema for OES 2 Linux servers is to have a tree admin install the 
first OES 2 Linux server and the first instance of each OES 2 service that you plan to run on your 
network. 

After this initial installation, you can assign subcontainer admins with the required rights to install 
additional servers and services. For more information on the required rights for the various OES 
services, see Section 2.4.3, “eDirectory Rights Required for Subcontainer Administrators,” on 
page 19.

Using the YaST Plugin to Extend the Schema

If you want a subcontainer admin to install the first OES 2 Linux server or the first instance of an 
OES 2 service in an existing tree, and you don’t want to grant that admin the Supervisor right to the 
[Root] of the tree, you can extend the schema using YaST from either 

An OES 2 SP1 server running in another tree
An OES 2 SP1 server that was installed without any OES 2 services added (the YaST plugin is 
a default OES 2 component)
or
A SLES 10 SP2 server with the yast2-novell-schematool.rpm installed. The RPM is available 
on the OES 2 SP1 installation media and can be launched at a terminal prompt following 
installation by entering yast2 novell-schematool.

To run the Novell Schema Tool, do the following:

1 On the server’s desktop, click Computer and open the YaST Control Center.
2 Click Open Enterprise Server > Novell Schema Tool.
3 Depending on the installation method you used, you might be required to insert your OES 2 

installation media.
Preparing to Install OES 2 SP1 Linux 17
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4 On the Novell eDirectory Extension Utility page, enter the information for an eDirectory server 
with a Read/Write replica of the Root partition.
Be sure to enter the correct information to authenticate as an admin user with the Supervisor 
right at the [Root] of the target tree. Otherwise, the schema extension will fail.

5 If you are preparing the tree so that a subcontainer admin can install the first OES 2 SP1 Linux 
server, select the services marked with an asterisk (*) in “Which OES 2 SP1 Services Require a 
Schema Extension?” on page 16. 
Although this step is not required if the tree already has an OES 2 SP1 Linux server installed, 
selecting the marked services won’t cause any problems. 

6 Select all of the other services you plan to run on any of the OES 2 Linux servers in the tree.
7 Click Next.

The schema is extended.

Extending the Schema for Novell Cluster Services (NCS)

If you want a subcontainer administrator to install the first instance of NCS in a tree, you can extend 
the schema by following the instructions in “Extending the eDirectory Schema to Add Cluster 
Objects” in the OES 2 SP1: Novell Cluster Services 1.8.5 for Linux Administration Guide.

2.4  eDirectory Rights Required to Install OES 
Linux
The following eDirectory rights are discussed in this section:

Section 2.4.1, “eDirectory Rights Required to Install the First Three OES Linux Servers in an 
eDirectory Tree,” on page 18
Section 2.4.2, “eDirectory Rights Required to Run Deployment Manager,” on page 19
Section 2.4.3, “eDirectory Rights Required for Subcontainer Administrators,” on page 19

2.4.1  eDirectory Rights Required to Install the First Three OES 
Linux Servers in an eDirectory Tree
If you are installing the server into a new tree, the Admin user that is created during the OES Linux 
installation has full rights to the root of the tree. Using the account for user Admin allows the 
installer to extend the eDirectory schema for OES Linux as necessary. To install the first OES Linux 
server in an eDirectory tree, you must have the Supervisor right at the [Root] of the eDirectory tree. 

By default, the first three servers installed in an eDirectory partition automatically receive a replica 
of that partition. To install a server into a partition that does not already contain three replica servers, 
the user must have either the Supervisor right at the [Root] of the tree or to the container in which 
the server holding the partition resides.

Before letting a subcontainer administrator install subsequent OES Linux servers in a tree, a user 
with the Supervisor rights to the root of the tree must extend the schema in the tree. You can extend 
the schema by using the Novell Schema Tool in YaST or by having a user with Supervisor rights to 
the root of eDirectory tree install the first OES Linux server into the tree. For more information, see 
Section 2.3.4, “Extending the Schema,” on page 16.
SP1: Linux Installation Guide
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2.4.2  eDirectory Rights Required to Run Deployment Manager
If you are installing the first OES Linux server into an existing eDirectory tree, you can run 
Deployment Manager first to prepare the tree so it is compatible with the new version of eDirectory 
that comes with OES 2 SP1. This requires access to a server with a Read/Write replica of the Root 
partition.

2.4.3  eDirectory Rights Required for Subcontainer 
Administrators
For security reasons, you might want to create one or more subcontainer administrators 
(administrators that are in a container that is subordinate to the container that user Admin is in) with 
sufficient rights to install additional OES Linux servers, without granting them full rights to the 
entire tree. A subcontainer administrator needs the following rights to install an OES Linux server 
into the tree:

Supervisor right to the container where the server will be installed
Read right to the Security container object for the eDirectory tree
Read right to the NDSPKI:Private Key attribute on the Organizational CA object (located in 
the Security container)
Supervisor right to the W0 object located inside the KAP object in the Security container
Supervisor right to the Security container when installing the NMAS™ login methods
Create right to the container where the UNIX Config object is located.
Modify right to the UNIX Config object.

These rights are typically granted by placing all administrative users in a Group or Role in 
eDirectory, and then assigning the rights to the Group or Role.

When installing DNS/DHCP into an existing tree with DNS/DHCP, you need to give the sub-
container administrator the following rights:

Table 2-2   Rights Needed for Subcontainer Admin for Installing DNS/DHCP 

For more information on rights needed for managing DNS/DHCP on OES Linux, see “eDirectory 
Permissions” in the OES 2 SP1: Novell DNS/DHCP Administration Guide for Linux.

DNS/DHCP Objects Object Rights All Property Rights

Locator Browse Supervisor

Group Browse Supervisor

Existing Supervisor Supervisor
Preparing to Install OES 2 SP1 Linux 19
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2.5  Deciding What Patterns to Install
A default SLES 10 SP2 installation has the following base technology, Graphical Environment, and 
Primary Function patterns selected for installation by default. With the exception explained in the 
two Important notes below, you can accept or deselect these patterns and install additional patterns 
as desired.

Table 2-3   Standard SLES 10 SP2Installation Patterns

Pattern Description

Common Code Base The largest system. It includes all packages available with SUSE 
Linux, except those that would result in dependency conflicts. 

This pattern is selected for installation by default. 

IMPORTANT: You must either install this pattern or the Server Base 
System pattern.

Server Base System Consists of all packages that are common to all Novell SUSE Linux 
Enterprise products. Also provides a Linux Standard Base 3.0 
compliant runtime environment.

IMPORTANT: You must either install this pattern or the Common 
Code Base pattern.

Novell AppArmor Novell AppArmorTM is an open source Linux application security 
framework that provides mandatory access control for programs, 
protecting against the exploitation of software flaws and compromised 
systems. AppArmor includes everything you need to provide effective 
containment for programs (including those that run as root) to thwart 
attempted exploits and even zero-day attacks. AppArmor offers an 
advanced tool set that largely automates the development of per-
program application security so that no new expertise is required.

GNOME Desktop Environment The GNOME* desktop environment is an intuitive and attractive 
desktop for users. The GNOME development platform is an extensive 
framework for building applications that integrate into the rest of the 
desktop.

This pattern is selected for installation by default.

X Window System In continuous use for over 20 years, the X Window System* provides 
the only standard platform-independent networked graphical window 
system bridging the heterogeneous platforms in today's enterprise: 
from network servers to desktops, thin clients, laptops, and 
handhelds, independent of operating system and hardware.

This pattern is selected for installation by default.
SP1: Linux Installation Guide
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The OES add-on installation includes the following OES Services patterns.

Table 2-4   OES Services Pattern Descriptions

Print Server Sets up a print server to host print queues so that they can be 
accessed by other computers on the same network, including 
machines running Microsoft* Windows* operating systems. The print 
server may accept print jobs from client computers and direct them to 
locally attached printers or to network printers. lpd, cups, and smb 
print servers and queues are supported.

This pattern is selected for installation by default.

Pattern Description

Novell AFP Novell AFP server allows Mac clients to access data stored on NSS volumes 
in the same way they access data on a Mac OSX server.

This service selects and installs these services:

Novell Backup / Storage Management Services (SMS)

Novell eDirectory

Novell Storage Services (NSS)

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell Archive and 
Version Services

Novell Archive and Version Services systematically captures and stores 
versions of your network files in an archive database, on a schedule that you 
determine. Users can search for a previous version of a file and quickly 
restore it.

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell eDirectoryTM

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell Storage ServicesTM (NSS)

Novell Backup/Storage 
Management Services 
(SMS)

The Novell backup infrastructure (called Storage Management ServicesTM or 
SMS) provides backup applications with the framework to develop a complete 
backup and restore solution.

SMS helps back up file systems (such as NSS) or application data (such as 
data from GroupWise®) on NetWare® and SUSE Linux Enterprise Server 
(SLES) to removable tape media or other media for off-site storage. It provides 
a single consistent interface for all file systems and applications across 
NetWare and SLES.

This service selects and installs these services:

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)
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Novell CIFS CIFS (Common Internet File System) is a network charing protocol. Novell 
CIFS enables Windows, Linux, and UNIX client workstations to copy, delete, 
move, save, and open files on an OES 2 Linux server. CIFS allows read and 
write access from multiple client systems simultaneously.

This service selects and installs these services:

Novell Backup / Storage Management Services (SMS)

Novell eDirectory

Novell Storage Services (NSS)

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell Cluster Services 
(NCS)

Novell Cluster ServicesTM is a server clustering system that ensures high 
availability and manageability of critical network resources including data, 
applications, and services. It is a multinode clustering product for Linux that is 
enabled for Novell eDirectory and supports failover, failback, and migration 
(load balancing) of individually managed cluster resources.

Novell Cluster Services lets you add Linux nodes to an existing NetWare 6.5 
or OES NetWare cluster without bringing down the cluster, or it lets you create 
an all-Linux cluster. With a mixed cluster, you can migrate services between 
OS kernels, and if services are alike on both platforms (such as NSS), you can 
set the services to fail over across platforms.

Using Novell Cluster Services with iSCSI technologies included in OES, you 
can build inexpensive clustered SANs on commodity gigabit Ethernet 
hardware. You can leverage existing hardware into a high availability solution 
supporting Linux and NetWare clusters.

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell DHCP Novell DHCP (Dynamic Host Configuration Protocol) uses eDirectory to 
provide configuration parameters to client computers and integrate them into a 
network.

The eDirectory integration lets you have centralized administration and 
management of DHCP servers across the enterprise and lets you set up 
DHCP subnet replication via Novell eDirectory.

This service selects and installs these services: 

Novell Backup/Storage Management Services (SMS)

Novell eDirectory

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)
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Novell DNS Novell DNS uses Novell eDirectory to deliver information associated with 
domain names, in particular the IP address.

This eDirectory integration lets you have centralized administration and 
management of DNS servers across the enterprise and lets you set up a DNS 
zone via Novell eDirectory.

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell eDirectory

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell Domain Services 
for Windows

Novell Domain Services for Windows provides seamless cross-authentication 
capabilities between Windows/Active Directory and Novell OES 2 Linux 
servers. It is a suite of integrated technologies that removes the need for the 
Novell Client when logging on and accessing data from Windows workstations 
in eDirectory trees. This technology simplifies the management of users and 
workstations in mixed Novell-Microsoft environments.

This service selects and installs these services:

Novell Backup / Storage Management Services (SMS)

Novell eDirectory

Novell DNS

Novell iManager

Novell iPrint

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell Storage Services (NSS)

Novell NCP Server

Novell eDirectory Novell eDirectory services are the foundation for the world's largest identity 
management, high-end directory service that allows businesses to manage 
identities and security access for employees, customers, and partners. More 
than just an LDAP data store, eDirectory is the identity foundation for 
managing the relationships that link your users and their access rights with 
corporate resources, devices, and security policies.

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)
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Preparing to Install OES 2 SP1 Linux 23



24 OES2 

novdocx (en)  11 July 2008
Novell FTP Novell FTP (File Transfer Protocol) is integrated with Novell eDirectory so that 
users can securely transfer files to and from OES Linux or OES NetWare 
volumes.

This service selects and installs these services: 

Novell Backup/Storage Management Services (SMS)

Novell eDirectory

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell iFolder Novell iFolder 3.7 is a simple and secure storage solution that can increase 
user productivity by enabling users to back up, access, and manage their 
personal files from anywhere, at any time.

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell eDirectory

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell iManager Novell iManager is a Web-based administration console that provides secure, 
customized access to network administration utilities and content from virtually 
anywhere you have access to the Internet and a Web browser.

iManager provides the following benefits:

Single point of administration for Novell eDirectory objects, schema, 
partitions, and replicas

Single point of administration for many other network resources

Management of many Novell products by using iManager plug-ins

Role-Based Services (RBS) for delegated administration

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell iPrint Novell iPrint lets employees, partners, and customers access printers from a 
variety of locations across the network and the Internet. From a Web browser, 
users can easily install any printer on the network from any location.

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell eDirectory 

Novell iManager

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)
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Novell Linux User 
Management (LUM)

Linux User Management (LUM) enables eDirectory users to function as local 
POSIX* users on Linux servers. This functionality lets administrators use 
eDirectory to centrally manage remote users for access to one or more OES 
Linux servers.

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell Remote Manager (NRM)

Novell NCP Server / 
Dynamic Storage 
Technology

Novell NCPTM Server for Linux enables support for login scripts, mapping 
drives to OES Linux servers, and other services commonly associated with 
Novell Client access. This means that Windows users with the Novell Client 
installed can be seamlessly transitioned to file services on OES Linux.

NCP Server includes Novell Dynamic Storage Technology, which allows rarely 
accessed files on NCP volumes to be automatically moved, according to 
policies set by the administrator, from faster-access storage to lower-cost 
storage media where the files can be more easily managed and backed up.

Services included with NCP (NetWare Core Protocol) are file access, file 
locking, security, tracking of resource allocation, event notification, 
synchronization with other servers, connection and communication, print 
services and queue management, and network management.

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell eDirectory

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell NetStorage Novell NetStorage provides the solution for simple, Internet-based access to 
file storage. NetStorage is a bridge between a company's protected Novell 
storage network and the Internet. It lets users access files securely from any 
Internet location, with nothing to download or install on the user's workstation.

With Novell NetStorage, a user can securely access files from any Internet-
enabled machine. Users can copy, move, rename, delete, read, write, recover, 
and set trustee assignments (based on their privilege level) on files between a 
local workstation and a Novell storage network. Access is available from any 
Internet-attached workstation, anywhere in the world. There is no need to e-
mail or copy data from one machine to another.

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell iManager

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)
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Novell Pre-Migration 
Server

A Novell Pre-Migration Server is not actually a service. Rather, it is a special-
purpose server—the target of a Server ID Transfer Migration.

Selecting this option causes this server to be installed without an eDirectory 
replica, thus preparing it to assume the identity of another server that you plan 
to decommission. For more information, see the OES 2 SP1: Migration Tool 
Administration Guide.

You should also select and install all the services that you plan to migrate from 
the other server. Services that are not installed on this server prior to the 
migration cannot be migrated.

This service selects and installs these services:

Novell Backup / Storage Management Services (SMS)

Novell eDirectory (without a replica)

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell QuickFinder QuickFinderTM lets your users find the information they're looking for on any of 
your public and private Web sites, your partners' sites, and any number of 
additional Web sites across the Internet or internal file servers, all from a 
single search form on your Web page.

You can easily modify the look and feel of any of the sample search results 
pages to match your corporate design.

You can create full-text indexes of HTML, XML, PDF, Word, OpenOffice.org, 
and many other document formats in almost any language with the 
QuickFinder Unicode* indexing engine.

You can configure and maintain your indexes remotely from anywhere on the 
network with the QuickFinder Web-based administration module.

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell Remote Manager 
(NRM)

Novell Remote Manager lets you securely access and manage one or more 
servers from any location through a standard Web browser. You can use 
Novell Remote Manager to monitor your server's health, change the 
configuration of your server, or perform diagnostic and debugging tasks.

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell Linux User Management (LUM)
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If you want to install these services, you can select them to install with most other patterns during 
the initial server installation by customizing the installation or you can install them after installing 
your initial Open Enterprise Server. For more information, see “Customizing the Software 
Selections” on page 39 and “Installing or Configuring OES 2 Services on an Existing OES 2 SP1 
Linux or SLES 10 SP2 Server” on page 89.

2.6  Install Only One Server at a Time
You should install one server at a time into a tree, then wait for the installation program to complete 
before installing an additional server into the same tree.

Novell Samba Novell Samba provides Windows (CIFS and HTTP-WebDAV) access to files 
stored on an OES Linux server's file system using an eDirectory username 
and password.

This service selects and installs these services: 

Novell Backup/Storage Management Services (SMS)

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)

Novell Storage Services 
(NSS)

The Novell Storage Services (NSS) file system provides many unique and 
powerful file system capabilities. It is especially suited for managing file 
services for thousands of users in an organization. It also includes Novell 
Distributed File Services for NSS volumes.

Unique features include visibility, trustee access control model, multiple 
simultaneous namespace support, native Unicode, user and directory quotas, 
rich file attributes, multiple data stream support, event file lists, and a file 
salvage subsystem.

NSS volumes are cross-compatible between kernels. You can mount a non-
encrypted NSS data volume on either the Linux or NetWare kernel and move it 
between them. In a clustered SAN, volumes can fail over between kernels, 
allowing for full data and file system feature preservation when migrating data 
to Linux.

IMPORTANT: If you select this service, you might need to reconsider the disk 
partition setup you have chosen. For information, see Appendix A, “Installing 
Linux with EVMS as the Volume Manager of the System Device,” on 
page 169.

This service selects and installs these services:

Novell Backup/Storage Management Services (SMS)

Novell eDirectory

Novell NCP Server

Novell Linux User Management (LUM)

Novell Remote Manager (NRM)
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2.7  What's Next
Proceed to one of the following sections based on the task that you want to perform:

“Installing Open Enterprise Server 2 SP1 Linux” on page 29
“Upgrading to OES 2 SP1 Linux” on page 93
“Updating an OES 2 SP1 Linux Server” on page 127
“Using AutoYaST to Install and Configure Multiple OES 2 SP1 Linux Servers” on page 147
“Installing, Upgrading, or Updating OES 2 SP1 Linux on a Xen-based Virtual Machine” on 
page 157
“Installing Linux with EVMS as the Volume Manager of the System Device” on page 169
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3Installing Open Enterprise 
Server 2 SP1 Linux

Novell® Open Enterprise Server (OES) 2 SP1 Linux is an add-on product to SUSE® Linux 
Enterprise Server (SLES) 10 SP2. When you install and configure OES Linux, you can also install 
and configure SLES 10 SP2. Therefore, it is helpful to understand how to perform a SLES 10 SP2 
installation.

For detailed information on performing a SLES installation, see the SLES 10 SP2 Installation and 
Administration Guide.

Before installing OES 2 SP1 Linux, we recommend that you read the following documents and 
information:

OES 2 SP1: Planning and Implementation Guide
OES2 SP1: Readme
“Preparing to Install OES 2 SP1 Linux” on page 13

This section includes brief steps for performing a full installation of OES Linux and provides 
information on the following topics:

“Obtaining OES 2 Linux Software” on page 29
“Setting Up an Installation Source” on page 29
“Installing OES 2 SP1 Linux As a New Installation” on page 33

3.1  Obtaining OES 2 Linux Software
For information on obtaining OES Linux software, see “Getting and Preparing OES 2 Software” in 
the OES 2 SP1: Planning and Implementation Guide.

3.2  Setting Up an Installation Source
This section covers how to get the media you need for an installation and how to set up installation 
sources for installing OES Linux:

Section 3.2.1, “Preparing a Network Installation Source,” on page 29
Section 3.2.2, “Preparing Physical Media for a New Server Installation or Upgrade,” on 
page 32

3.2.1  Preparing a Network Installation Source
This section contains the following information:

“Requirements” on page 30
“Procedure” on page 30
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Requirements

To set up a network installation source, you need the following:

A server to act as the YaST Network Installation server: 

This server can be SLES 9, SLES 10, SUSE Linux 9.3 or later, OES 1 Linux or OES 2 Linux, 
Windows, NetWare 6.5, OES 1 NetWare, or OES 2 NetWare.
A computer to become the new OES Linux server

Both servers need to be connected to the network and able to communicate with each other. 

If you have DHCP on your network, using DHCP works well to begin the initial network 
installation. During the installation, you are prompted to configure your OES Linux server with a 
static IP address. The static IP address is required for the configuring OES network services on your 
server.

If you don't have DHCP on your network, you need to do a manual installation and configure your 
OES Linux server with a static IP address, subnet mask, a default gateway, and a name server. You 
do not need to redo this network configuration later in the installation because it is already set up. 
The instructions for this come later in the installation procedure. (See “Installing OES 2 SP1 Linux 
As a New Installation” on page 33.)

Procedure

To prepare a network installation source on a NetWare server, see Appendix C, “Setting Up an 
Installation Source on NetWare,” on page 191.

To prepare a network installation source on a Linux or Window server, see “Setting Up the Server 
Holding the Installation Sources” in the SLES 10 SP2 Installation and Administration Guide and the 
following instructions.

1 Download or copy the ISO image files to a directory of your choice.
For a list of images, see Table 3-1, “OES Linux ISO Images and Labels for i386,” on page 32 
or Table 3-2, “OES Linux ISO Images and Labels for x86_64,” on page 33.

2 Configure your Linux server to be a YaST installation server and select the location for the root 
of the network installation.
The three protocol options to choose from for configuring the YaST installation server are NFS, 
FTP, and HTTP. For the protocol configuration procedures, see the following:

“NFS Protocol Configuration” on page 31
“FTP Protocol Configuration” on page 31
“HTTP Protocol Configuration” on page 31

FTP and HTTP do not allow you to serve the files without possible modifications to .conf 
files. NFS is the simplest protocol to configure and is recommended.

3 Create a boot CD using the .iso image file for SUSE Linux Enterprise Server SP1 CD 1 and 
label it with that name.
For information on creating this CD, see “Preparing Physical Media for a New Server 
Installation or Upgrade” on page 32.
This CD will be the network installation boot CD.
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With these steps completed, you are ready to perform a new installation or upgrade using a network 
installation source. See “Installing OES 2 SP1 Linux As a New Installation” on page 33 or 
“Upgrading to OES 2 SP1 Linux” on page 93.

NFS Protocol Configuration

An NFS share can be shared easily from almost any location on your file system. Use the following 
procedure if you choose to use this protocol:

1 At your network installation server, launch YaST.
2 Select Network Services, then click NFS Server.

You might be prompted to install the NFS server.
3 On the NFS Server configuration screen, select Start in the NFS Server section, select Open 

Port in Firewall in the Firewall section, then click Next.
4 In the Directories section, click Add Directory and specify or browse to the directory where you 

have created the install root (source directory), then click OK.
5 Accept the defaults in the pop-up window for adding a Host. 

If you are experienced with NFS configurations, you can customize the configuration.
6 Click Finish.

FTP Protocol Configuration

These instructions use pure ftpd and can be installed using YaST. Depending on the FTP server you 
use, the configuration might be different. 

If you have created your install root (source directory) within your ftp root, you can forego the 
following procedure and simply start pure ftpd. 

The default configuration of pure ftpd runs in chroot jail, so symlinks cannot be followed. In order to 
allow ftp access to the install root created outside of the ftp root, you must mount the install root 
directory inside of the ftp root.

If you have not created your install root within your ftp root and you choose to use this protocol:

1 Create a directory inside of your ftp root.
2 Run the following command:
mount --bind /path_to_install_root /
path_to_directory_in_ftp_root

For example, 
mount --bind /tmp/OES /srv/ftp/OES

3 (Optional) If you want to make this install root permanent, add this command to the /etc/
fstab file.

4 Start pure ftpd.

HTTP Protocol Configuration

These instructions use Apache2 as provided by SLES 10.
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If you choose to use this protocol:

1 Modify the default-server.conf file of your HTTP server to allow it to follow 
symlinks and create directory indexes.
The default-server.conf file is located in the /etc/apache2 directory. In the 
Directory tag of the default-server.conf file, remove None if it is there, add 
FollowSymLinks and Indexes to the Options directive, then save the changes.

2 (Conditional) If the install root is outside of the http root, create a symbolic link to the install 
root with the following command:
ln -s /path_to_install_root /path_to_link 
For example, 
ln -s /tmp/OES /srv/www/htdocs/OES

3 Restart Apache.

3.2.2  Preparing Physical Media for a New Server Installation or 
Upgrade 
To prepare physical media for an installation or upgrade, you must first download then burn a CD or 
DVD for each ISO image file that you need.

1 Insert a blank, writable CD or DVD into your CD or DVD burner.
2 Select the option to create a CD or DVD from an image file.
3 Select ISO as the file type.
4 Select the first image file (see Table 3-1 or Table 3-2) from the location you downloaded it to.
5 Complete the CD or DVD creation process.
6 Repeat this process for each of the ISO image files.

When creating the installation source, you need the media listed in the following tables. The tables 
show the ISO image filename and how each CD or DVD should be labelled. For the SLES media, 
you can use the ISO files for CDs or the DVD ISO.

For information on downloading these image files, see the Novell Open Enterprise Server 2 
Download Instructions (http://www.novell.com/documentation/oes2/esd/di_oes2.html).

Table 3-1   OES Linux ISO Images and Labels for i386

ISO Image File CD or DVD Label

oes2-sp1-i386-CD1.iso Novell Open Enterprise Server 2 SP1 CD 1

SLES-10-SP2-CD-i386-CD1.iso   SUSE Linux Enterprise Server 10 SP2 CD 1

SLES-10-SP2-CD-i386-CD2.iso SUSE Linux Enterprise Server 10 SP2 CD 2

SLES-10-SP2-CD-i386-CD3.iso SUSE Linux Enterprise Server 10 SP2 CD 3

SLES-10-SP2-CD-i386-CD4.iso SUSE Linux Enterprise Server 10 SP2 CD 4

SLES-10-SP2-DVD-i386-DVD1.iso SUSE Linux Enterprise Server 10 SP2 DVD 1
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Table 3-2   OES Linux ISO Images and Labels for x86_64

3.3  Installing OES 2 SP1 Linux As a New 
Installation
This section does not provide step-by-step instructions on how to do the installation, but it provides 
the following important information specific to OES 2 SP1 Linux as you progress through the 
installation.

Section 3.3.1, “Starting the OES 2 SP1 Linux Installation,” on page 33
Section 3.3.2, “Specifying the Installation Mode,” on page 36
Section 3.3.3, “Specifying the Add-On Product Installation Information,” on page 37
Section 3.3.4, “Setting Up the Clock and Time Zone,” on page 38
Section 3.3.5, “Specifying the Installation Settings for the SLES Base and OES Linux 
Installation,” on page 38
Section 3.3.6, “Specifying Configuration Information,” on page 42

3.3.1  Starting the OES 2 SP1 Linux Installation
Insert SUSE Linux Enterprise Server 10 SP2 CD 1 into the CD-ROM drive of the computer that you 
want to be your OES Linux server, then boot the machine. Then continue with one of the following 
procedures:

“Installation Using a Network Installation Source with DHCP” on page 33
“Installation Using a Network Installation Source without DHCP” on page 34
“New Server Installation Using Physical Media or ISO” on page 36

Installation Using a Network Installation Source with DHCP

1 From the CD boot menu, select one of the following Installation options that matches your 
environment, but do not press Enter.

Installation: The normal installation mode. All modern hardware functions are enabled.
Installation—ACPI Disabled: If the normal installation fails, this might be because of 
the system hardware not supporting ACPI (advanced configuration and power interface). 
If this seems to be the case, use this option to install without ACPI support.

ISO Image File CD or DVD Label

OES2-sp2-x86_64-CD1.iso Novell Open Enterprise Server 2 SP1 CD 1

SLES-10-SP2-CD-x86_64-CD1.iso SUSE Linux Enterprise Server 10 SP2 CD 1

SLES-10-SP2-CD-x86_64-CD2.iso SUSE Linux Enterprise Server 10 SP2 CD 2

SLES-10-SP2-CD-x86_64-CD3.iso SUSE Linux Enterprise Server 10 SP2 CD 3

SLES-10-SP2-CD-x86_64-CD4.iso SUSE Linux Enterprise Server 10 SP2 CD 4

SLES-10-SP2-DVD-x86_64-DVD1.iso SUSE Linux Enterprise Server 10 SP2 DVD 1
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Installation—Local APIC Disabled: If the normal installation fails, this might be 
because of the system hardware not supporting local APIC (advanced programmable 
interrupt controllers). If this seems to be the case, use this option to install without local 
APIC support.
If you are not sure, try Installation—ACPI Disabled or Installation—Safe Settings first.
Installation—Safe Settings: Boots the system with the DMA mode (for CD-ROM 
drives) and power management functions disabled. Experts can also use the command line 
to enter or change kernel parameters.

2 (Conditional) You can specify boot option parameters to specify all the parameters that the 
manual installation steps will step you through or you can continue with Step 3.
If you do specify boot options parameters, press Enter then continue with Step 6 on page 34.
For more information on specifying boot option parameters, see “Using Custom Boot Options” 
in the SLES 10 SP2 Installation and Administration Guide.

3 Press F4, and then select the network installation type (CD or DVD, SLP, FTP, HTTP, NFS, 
SMB/CIFS) that you set up on your network installation server.
See Step 2 on page 30 of the Preparing a Network Installation Source procedure.

4 Specify the required information (server name and installation path), then select OK.
5 Press Enter to begin the installation.
6 Follow the screen prompts, using the information contained in the following sections:

6a “Specifying the Installation Mode” on page 36.
6b “Specifying the Add-On Product Installation Information” on page 37.
6c “Setting Up the Clock and Time Zone” on page 38.
6d “Specifying the Installation Settings for the SLES Base and OES Linux Installation” on 

page 38.
6e “Specifying Configuration Information” on page 42.
6f “Finishing the Installation” on page 60.

7 Complete the server setup by following the procedures in “Completing Installation or Upgrade 
Tasks on OES 2 SP1 Linux” on page 123.

Installation Using a Network Installation Source without DHCP

1 From the CD boot menu, select one of the following Installation options that matches your 
environment, then press Enter.

Installation: The normal installation mode. All modern hardware functions are enabled.
Installation—ACPI Disabled: If the normal installation fails, this might be because of 
the system hardware not supporting ACPI (advanced configuration and power interface). 
If this seems to be the case, use this option to install without ACPI support.
Installation—Local APIC Disabled: If the normal installation fails, this might be 
because of the system hardware not supporting local APIC (advanced programmable 
interrupt controllers). If this seems to be the case, use this option to install without local 
APIC support.
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If you are not sure, try Installation—ACPI Disabled or Installation—Safe Settings first.
Installation—Safe Settings: Boots the system with the DMA mode (for CD-ROM 
drives) and power management functions disabled. Experts can also use the command line 
to enter or change kernel parameters.

2 (Conditional) You can specify boot option parameters to specify all the parameters that the 
manual installation steps will step you through or you can continue with Step 3.
If you do specify boot options parameters, press Enter then continue with Step 19 on page 35.
For more information on specifying boot option parameters, see “Using Custom Boot Options” 
in the SLES 10 SP2 Installation and Administration Guide..

3 When you receive the following error, select OK and press Enter: 
Could not find the SUSE Linux Enterprise Server 10 Installation 
source. Activating manual set up program.

4 Select the language, then select OK and press Enter.
5 Select a keyboard map, then select OK and press Enter.
6 Select Start Installation or System, then select OK and press Enter.
7 Select Start Installation or Update, then select OK and press Enter.
8 Select Network, press Enter, then select OK and press Enter.
9 Select the network protocol that matches the configured protocol on your network installation 

server, then press Enter.
10 (Conditional) If you have more than one network interface card, select one of the cards, then 

press Enter.
We recommend eth0.

11 When prompted whether you want to use DHCP, select No, then press Enter.
12 Specify the IP address, then press Enter.
13 Specify the subnet mask, then press Enter.
14 Specify the gateway, then press Enter.
15 Specify the IP address of a name server, then press Enter.
16 Specify the IP address of the network installation server, then press Enter.
17 (Conditional) Depending on the protocol you specified, you might see additional screens for 

FTP or HTTP. Select the options that are appropriate for your network, then continue with 
Step 18.

18 Specify the path to your installation source on the network installation server, then press Enter.
19 Follow the prompts, using the information contained in the following sections:

19a “Specifying the Installation Mode” on page 36.
19b “Specifying the Add-On Product Installation Information” on page 37.
19c “Setting Up the Clock and Time Zone” on page 38.
19d “Specifying the Installation Settings for the SLES Base and OES Linux Installation” on 

page 38.
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19e “Specifying Configuration Information” on page 42.
19f “Finishing the Installation” on page 60.

20 Complete the server setup by following the procedures in “Completing Installation or Upgrade 
Tasks on OES 2 SP1 Linux” on page 123.

New Server Installation Using Physical Media or ISO

1 From the CD boot menu, select the second option (Installation), then press Enter.
2 Select the language that you want to use, then click Next.
3 Read and accept the license agreement, then click Next.
4 (Conditional) If you haven’t already verified that the media you burned is valid, you can check 

it using the Media Check; otherwise, click Next to continue with the installation.
The installation process prompts you for each CD at the appropriate time. The progress status 
at the bottom of the screen indicates which CD will be requested next.

5 Follow the prompts, using the information contained in the following sections:
5a “Specifying the Installation Mode” on page 36.
5b “Specifying the Add-On Product Installation Information” on page 37.
5c “Setting Up the Clock and Time Zone” on page 38.
5d “Specifying the Installation Settings for the SLES Base and OES Linux Installation” on 

page 38.
5e “Specifying Configuration Information” on page 42.
5f “Finishing the Installation” on page 60.

6 Complete the server setup by following the procedures in “Completing Installation or Upgrade 
Tasks on OES 2 SP1 Linux” on page 123.

3.3.2  Specifying the Installation Mode
When selecting the type of installation, select New Installation.

1 When the Installation Mode screen displays, select the following menu options, then click 
Next:

1. New Installation 
2. Include Add-On Products from Separate Media
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2 Continue with Section 3.3.3, “Specifying the Add-On Product Installation Information,” on 
page 37.

3.3.3  Specifying the Add-On Product Installation Information
When the Add-On Product Installation page displays:

1 Click Add.
2 In the Add-On Product Media dialog, click CD, then click Next.

If you are using an alternate installation source, click the appropriate option that matches your 
installation source selection.

3 In the Insert the Add-On Product CD dialog, select the appropriate drive where you want to 
insert the CD labeled Open Enterprise Server 2 SP1 CD 1.

4 Click Eject.
5 Insert the CD labeled Open Enterprise Server 2 SP1 CD 1, then click Continue.
6 Read and accept the Novell Open Enterprise Server 2 license agreement, then click Next.
7 Confirm that the Add-On Product Installation page shows the correct path to the OES media, 

then click Next.
8 Continue with Section 3.3.4, “Setting Up the Clock and Time Zone,” on page 38.
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3.3.4  Setting Up the Clock and Time Zone
1 Make sure the Clock, Region, Timezone, and Time and Date settings are what you want, then 

click Next. 
You can configure this information after the installation is complete, but it is easier to do it 
during the installation.

2 Continue with Section 3.3.5, “Specifying the Installation Settings for the SLES Base and OES 
Linux Installation,” on page 38.

3.3.5  Specifying the Installation Settings for the SLES Base 
and OES Linux Installation
The instructions in this section assume you are using the graphical YaST interface for installation. If 
you are installing from a shell prompt or the text-based YaST interface, you need to apply these 
installation instructions concepts to the interface you are using. 

This section does not provide step-by-step instructions on how to do the installation, but it provides 
important information specific to OES Linux as you progress through the installation and determine 
the Installation Settings.

For step-by-step information on performing a SLES installation, see “Deployment” in the SLES 10 
SP2 Installation and Administration Guide. However, the SUSE Linux Enterprise 10 Installation 
and Administration Guide does not contain instructions for OES-specific components.

You are presented with the Installation Settings proposal. You can accept the default settings or 
customize each setting to fit the needs of your organization. At this stage of the installation, you can 
change settings for the System, Keyboard Layout, Partitioning, Add-On Products (conditional), 
Software, Booting, Time Zone, Language, and Default Runlevel.

This section gives recommendations or procedures for the following tasks:

“Setting Up Disk Partitions” on page 38
“Customizing the Software Selections” on page 39
“Accepting the Installation Settings” on page 41

Setting Up Disk Partitions

In most cases, YaST proposes a reasonable partitioning scheme that can be accepted without change. 
You can also use YaST to customize the partitioning.

For OES Linux, Novell Storage Services™ (NSS) volumes can be used only as data volumes, not as 
system volumes. They cannot be created as part of the install process. You must also consider 
whether you will be creating NSS volumes in the future on the devices where you are installing 
Linux. The default volume manager for Linux POSIX volumes on SUSE Linux is LVM (Linux 
Volume Manager). However, NSS volumes cannot be created on devices managed by LVM; NSS 
requires EVMS (Enterprise Volume Management System) management of its devices. 

IMPORTANT: If you have only a single device on the server (such as a single physical disk or a 
hardware RAID 1 or RAID 5 device) and you plan to use NSS volumes as data volumes after the 
install, make sure to follow the partition configuration instructions in “Installing Linux with EVMS 
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as the Volume Manager of the System Device” on page 169. You can also follow this alternate setup 
if you have multiple devices and want to be able to create NSS volumes in the future on the same 
device that contains the system partitions.

Table 3-3 presents guidelines for setting up disk partitions on your OES Linux server. For more 
information, see “Installation Summary” in the SLES 10 SP2 Installation and Administration Guide.

Table 3-3   Partition Guidelines

Customizing the Software Selections

IMPORTANT: To install any of the OES patterns, you must customize the software selections. If 
you don’t make any selections, only the base SLES 10 and base OES packages are installed. 
However, you can install any of the patterns after the base SLES installation is complete. See 
“Installing or Configuring OES 2 Services on an Existing OES 2 SP1 Linux or SLES 10 SP2 
Server” on page 89.

To customize which software packages are installed on the server:

1 On the Installation Settings page, click Software.

Partition 
to Create Other Considerations

/boot Depending on the hardware, it might be useful to create a boot partition (/boot) to hold the boot 
mechanism and the Linux kernel. 

You should create this partition at the start of the disk and make it at least 8 MB or 1 cylinder. 
As a rule of thumb, always create such a partition if it was included in the YaST original 
proposal. If you are unsure about this, create a boot partition to be on the safe side.

IMPORTANT: In a Xen VM installation, format the /boot partition using Ext2 as the file 
system. For a technical explanation of why this is necessary, see “Paravirtual Mode and 
Journaling File Systems (http://www.novell.com/documentation/sles10/xen_admin/data/
sec_xen_filesystem.html)” in the Virtualization with Xen (http://www.novell.com/
documentation/sles10/xen_admin/data/bookinfo.html) guide.

swap This should normally be twice the size of the RAM installed on your server, up to 1 GB. If you 
create a /boot partition, create the swap partition second. Otherwise, create the swap partition 
first.

/ Define this partition as 3 GB or more. In all cases, create this partition after you create the 
swap partition.

/var Define this partition as 4 GB or more.

/opt Some (mostly commercial) programs install their data in /opt.

Define this partition as 4 GB or more.

/usr Define this partition as 4 GB or more.

/home You can allocate the rest of the disk space to this partition.
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The Open Enterprise Server add-on adds the OES Services category of patterns to the base 
software selection categories offered by the SLES 10 installation. OES Services include 
patterns that contain Novell services or products such as Novell DNS and DHCP services, 
iPrint, or iManager. 
None of the OES Services is selected by default. This lets you fully customize your OES server.

2 At this point, you can do the following to customize your software selections:
Select any of number of the OES Services patterns.

A description of each pattern displays to the right of the pattern when it is selected. For a 
description of OES Services patterns and the components selected with each pattern, see 
Table 2-4 on page 21.
You can manually change the default SLES selections by changing the install status and 
selecting the patterns offered in each category.

IMPORTANT: If you deselect a pattern after selecting it, you are instructing the 
installation program to not install that pattern and all of it dependent patterns. Rather than 
deselecting a pattern, click Cancel to cancel your software selections, then click the 
Software heading again to choose your selections again.
Selecting only the patterns that you want to install ensures that the patterns and their 
dependent patterns and packages are installed.
If you click Accept, then return to software pattern selection page, the selections that you 
made become your base selections and must be deselected if you want to remove them 
from the installation proposal.

You must install at least one of the SLES Base Technologies patterns.
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Selecting a pattern automatically selects the other patterns that it depends on to complete 
the installation.
You can view the details of your selection and add or remove specific packages for the 
installation by clicking Details.

3 When you have the software components selected that you want to install, click Accept.
4 If prompted with the license agreement for Professional TrueType Fonts, click Accept.
5 (Conditional) If the prompt for Automatic Changes displays, click Continue.
6 (Conditional) If prompted, resolve any dependency conflicts.

Accepting the Installation Settings

1 Review the final Installation Summary page to ensure that you have all the Installation settings 
you desire.

2 After you have changed all the Installation Settings as desired, click Accept. 
3 On the Confirm Installation page, click Install.

The base installation settings are applied and the packages are installed.
4 For installations using a network installation source, you can remove the network boot CD 

(SLES 10 SP2 CD 1) from the CD drive. 
5 For installations using a CD or DVD installation source, leave the CD or DVD in the CD-ROM 

or DVD drive.
6 After the server reboot, proceed with “Specifying Configuration Information” on page 42.
Installing Open Enterprise Server 2 SP1 Linux 41



42 OES2 

novdocx (en)  11 July 2008
3.3.6  Specifying Configuration Information
When the server reboots, you are required to complete the following configuration information:

1. “Specifying the Password for the System Administrator “root”” on page 42
2. “Specifying Network Configuration Settings” on page 42
3. “Testing the Connection to the Internet” on page 45
4. “Specifying Novell Customer Center Configuration Settings” on page 45
5. “Updating the Server Software During the Installation” on page 47
6. “Specifying Service Configuration Settings” on page 51
7. “Specifying LDAP Configuration Settings” on page 52
8. “Specifying eDirectory Configuration Settings” on page 54
9. “Configuring Novell Open Enterprise Server Services” on page 59

Specifying the Password for the System Administrator “root”

In the Password for the System Administrator root page, 

1 Specify the password for the root administrator.
For security reasons, the root user’s password should be between five and eight characters 
long and should contain a mixture of both uppercase and lowercase letters and numbers. The 
maximum length for passwords is 72 characters, and passwords are case sensitive. If you have 
a password longer than eight characters, click Expert Options > Blowfish > OK.

2 Confirm the password.
3 Click Next.

Specifying Network Configuration Settings

On the Network Configuration page, you can change the configuration for the components listed 
below. In this section, we only give details for the Network Interfaces and Firewall settings.

Configuration success is directly tied to specific networking configuration requirements. Make sure 
that the following settings are configured exactly as specified for the Network Interfaces dialogs.

1. Network Mode
2. Firewall
3. IPV6
4. Network Interfaces
5. DSL Connections
6. ISDN Adapters
7. Modems
8. VNC Remote Administration
9. Proxy
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Network Interface

Specify the setting for each network board on the server:

1 On the Network Configuration page, click Network Interfaces.
2 In the Network Card Configuration Overview dialog, select the network card you want to 

configure, then click Edit.
3 Select Static Address Setup, then specify the IP address and the subnet mask for the interface.

By default, the OES Linux installation requires you to configure the network card to use a static 
IP address.

4 In the Detailed Settings list, select Hostname and Name Server.
4a In the Name Servers and Domain Search List panel, specify from one to three DNS server 

IP addresses.
4b Click OK to return to the Detailed Settings list.

5 In the Detailed Settings list, select Routing.
5a Specify the IP address of the default gateway on the subnet where you are installing the 

OES Linux server.
5b Click OK to return to the Detailed Settings list.

6 Click Next to return to the Network Card Configuration Overview dialog.
7 Complete Step 2 through Step 6 for each network board, then click Next to return to the main 

Network Configuration page.

Firewall

For security reasons, a firewall is started automatically on each configured interface. The 
configuration proposal for the firewall is updated automatically every time the configuration of the 
interfaces or services is modified. 

To adapt the automatic settings to your own preferences, click Change > Firewall. In the dialog that 
opens, determine whether the firewall should be started. If you do not want the firewall to be started, 
select the appropriate option and exit the dialog.

To start and configure the firewall, click Next for a series of dialogs similar to those described in 
Section 44.4.1, “Configuring the Firewall with YaST” in the SUSE Linux Enterprise Server 
Installation and Administration Guide (http://www.novell.com/documentation/sles10/sles_admin/
data/sec_fire_suse.html).

Many of the OES services require an open port in the firewall. These ports are automatically opened 
when the service is configured.

Table 3-4   Open Enterprise Server Services and Ports

Service Default Ports

Domain Services for Windows 1636
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To disable the firewall:

1 On the Network Configuration page, under the Firewall heading, click enabled on the Firewall 
is enabled status line.

eDirectoryTM 389 (ldap)

636 (secure ldap)

8028 (http for iMonitor)

8030 (secure http for iMonitor)

524 (ncp)

iManager 80 http

443 secure http

iPrint 80 http

443 secure http

631 ipp

Novell AFP 548

Novell Archive and Version Services 26029

Novell CIFS 636 (secure ldap)

Novell DHCP 67

Novell DNS 53 http

953 secure http

Novell FTP 21

Novell Information Portal 80 http

443 secure http

Novell NetWare Core Protocol (NCPTM) 524

Novell Remote Manager 8008 http

8009 secure http

OpenWBEM 5988 http

5989 secure http

QuickFinderTM 80 http

443 secure http

Samba 139 (netbios)

445 microsoft-ds

Secure Shell 22

Storage Management Services (Backup) 40193 smdr daemon

UDP 524

Service Default Ports
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When the firewall is disabled, the status for Firewall should read Firewall is disabled. 
2 When all settings in the Network Configuration page are set as desired, click Next to save the 

configuration, then continue with “Testing the Connection to the Internet” on page 45.

Testing the Connection to the Internet

On the Test Internet Connection page:

1 Select Yes, Test Connection to the Internet, then click Next.
Obtaining the latest SUSE release notes might fail at this point. If it does, view the log to verify 
that the network configuration is correct, then, click Next.
If the network configuration is not correct, click Back > Back and fix your network 
configuration. See “Network Interface” on page 43.

2 Or, you can skip this test by clicking No, Skip This Test; however, most OES services 
configurations require a connection to the Internet.
Skipping this test also skips downloading release notes, configuring the Novell Customer 
Center, and updating online. 

3 Continue with “Specifying Novell Customer Center Configuration Settings” on page 45. If you 
skip this test, continue with “Specifying Service Configuration Settings” on page 51.

Specifying Novell Customer Center Configuration Settings

To receive support and updates for your OES 2 SP1 server, you need to register it in the Novell 
Customer Center (NCC). When the Novell Customer Center Configuration page is displayed, you 
have two options. You can choose to register the server during the installation or register it later. 

To register the server and get online update after the installation is complete:

1 Click Configure Later. 
2 Continue with “Specifying Service Configuration Settings” on page 51.
3 Register the server after the installation is complete by using the procedures in Section 7.2, 

“Registering the Server in the Novell Customer Center,” on page 128.

To register the server during the installation:

1 On the Novell Customer Center Configuration configuration page, select all of the following 
options, then click Next.

Option What it Does

Configure Now Proceeds with registering this server and the SLES 10 SP2 and OES 2 
SP1 product in the Novell Customer center.

Hardware Profile Sends the information to the Novell Customer Center about the hardware 
that you are installing SLES 10 SP2 and OES 2 SP1 on.

Optional Information Sends optional information to the Novell Customer Center for your 
registration. For this release, this option doesn’t send any additional 
information.

Registration Code Makes the registration with activation codes mandatory.
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2 After you click Next, the following message is displayed. Wait until this message disappears 
and the Manual Interaction Required page displays.

3 On the Manual Interaction Required page, note the information that you will be required to 
specify, then click Continue.

4 On the Novell Customer Center Registration page, specify the required information in the 
following fields, then click Submit:

5 When the message to complete the registration displays, click Continue.

Regularly Synchronize 
with the Customer 
Center

Keeps the installation sources for this server valid. It does not remove any 
installation sources that were manually added.

Field Information to Specify

Email Address The e-mail address for your Novell Login account.

Confirm Email Address The same e-mail address for your Novell Login account

Activation Code for 
SLES Components 
(optional):

Specify your permanent registration code for the SLES SP1 product.

If you don’t enter the permanent registration code now, a temporary code 
and organization are made for this server and the SLES SP1 product. This 
lets you have updates for 15 days, until you register this system in the 
NCC with the permanent activation code.

Activation Code for 
OES Components 
(optional):

Specify your permanent registration code for the OES product.

If you don’t enter the permanent registration code now, a temporary code 
and organization are made for this server and the OES 2 SP1 product. 
This lets you have updates for 15 days, until you register this system with 
the permanent activation code.

System Name or 
Description (optional):

The hostname for the system is specified by default. If you want to change 
this to a description for the Novell Customer Center, specify a description 
to identify this server.

Option What it Does
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6 After you click Continue, the following message is displayed with the Manual Interaction 
Required screen. Wait until this message disappears and Novell Customer Center 
Configuration page displays with the message that Your configuration was 
successful.

7 When you see the message Your configuration was successful on the Novell 
Customer Center Configuration, click OK.

8 Continue with “Updating the Server Software During the Installation” on page 47.

Updating the Server Software During the Installation

If you have a successful connection to the Internet and have registered the server in the Novell 
Customer Center, the server displays the Online Update dialog. You can run the online update now 
or skip it and get updates later.
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To skip getting updates during the installation:

1 On the Online Update page, click Skip Update.
2 Continue with “Specifying Service Configuration Settings” on page 51.

To get updates during the installation:

1 In the Online Updates dialog, click Run Update.

2 On the page that shows that updates are available, select the updates that you want to install, 
then click Accept. The check marks that are shown on the summary portion of the page are 
patches that have already been installed on your system.
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3 When you see the message, Installation finished on the Patch Download and 
Installation page, click Next.
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4 If the update makes changes to YaST, the following message displays. Click OK to restart 
YaST.

5 Because the installation was interrupted, the following message displays. Click Yes to continue 
with the installation.

6 The online update displays again with additional updates. If a patch has changes to the kernel, 
you might want to deselect it and install it later after the installation is complete. For 
procedures, see “Updating an OES 2 SP1 Linux Server” on page 127.
If you do install patches that have changes to the kernel, click OK when you see the following 
message.
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7 Because the installation was interrupted again, the following message displays. Click Yes to 
continue with the installation.

8 After all the patches are installed, continue with “Specifying Service Configuration Settings” 
on page 51.

Specifying Service Configuration Settings

1 In the Installation Settings page, select or deselect the following options:
CA Management: You can accept the default settings or change the settings for a greater 
security level.
The certificate that is created is used by the Apache Web server. If you disable this 
configuration, each service that uses Apache will not work. The option to run the CA 
Management configuration is selected by default.
For more information about Certificate Authority Management, see in the “Managing X.509 
Certification” in the SUSE LINUX Enterprise Server 10 Installation and Administration Guide 
(http://www.novell.com/documentation/sles10/sles_admin/data/cha_yast_ca.html).
Do Not Enable OpenLDAP Server: Because the Novell eDirectory LDAP server replaces the 
SLES 10 OpenLDAP server, you must not enable this option. It is disabled by default.

2 If you updated the server during the installation, the default settings for CA management loses 
the root password. You need to reset the password for root in this dialog’s settings.
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2a On the Installation Settings page, click the CA Management link.
2b On the Managing CA and Certificates page, click Edit Default Settings.
2c On the Edit Default Settings page, enter the password for root in the Password and 

Confirm Password fields, then click Next.
3 When the setting are as desired, click Next and continue with one of the applicable procedures 

as follows:
“Specifying LDAP Configuration Settings” on page 52.
“Specifying eDirectory Configuration Settings” on page 54.

Specifying LDAP Configuration Settings

Many of the OES services require eDirectory. If eDirectory was not selected as a product to install 
on this server but other OES services that do require LDAP services were installed, the LDAP 
Configuration service displays expecting you to in complete the required information.

To specify the required information on the Configured LDAP Server page:

1 In the eDirectory Tree Name field, specify the name for the existing eDirectory tree that you are 
installing this server into.

2 In the Admin Name and Context field, specify the name and context for user Admin in the 
existing tree.

3 In the Admin Password Name field, specify a password for user for user Admin in the existing 
tree.
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4 Add the LDAP servers that you want the services on this server to use. The servers that you add 
should hold the master or a read/write replica of eDirectory. Do the following for each server 
you want to add.
4a Click Add.
4b On the next dialog, specify the following information for the server to add, then click Add.

IP Address
LDAP port and secure LDAP port

5 When all the LDAP servers that you want to specify are listed, click Next.
6 Verify that the Novell Open Enterprise Server Configuration page displays the settings that you 

expected, then click Next.
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7 Continue with “Configuring Novell Open Enterprise Server Services” on page 59.

Specifying eDirectory Configuration Settings

When specifying eDirectory Configuration Settings, you can specify information to create a new 
tree and install the server in that new tree or you can install the server into an existing tree by 
specifying the information for it. Use the following instructions as applicable:

“Creating a New eDirectory Tree and Installing the Server in It” on page 54
“Installing the Server into an Existing eDirectory Tree” on page 55

Creating a New eDirectory Tree and Installing the Server in It

1 On the eDirectory Configuration - New or Existing Tree page, select New Tree.
2 In the eDirectory Tree Name field, specify a name for the eDirectory tree that you want to 

create.
3 Select the Use eDirectory Certificates for HTTPS Services check box to replace the existing 

YaST server certificate and key files with eDirectory server certificate and key files (default).
On an existing SLES 10 server that already has certificates installed and configured, leave this 
option deselected to preserve the existing certificate configuration.

IMPORTANT: Selecting the Use eDirectory Certificates for HTTPS Services check box 
overwrites existing certificate configuration files.
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Most OES services that provide HTTPS connectivity are configured by default to use the self-
signed common server certificate created by YaST. Self-signed certificates provide minimal 
security and limited trust, so you should consider using eDirectory certificates instead.
Selecting this option causes eDirectory to automatically back up the currently installed 
certificate and key files and replace them with files created by the eDirectory Organizational 
CA (or Tree CA).
The default YaST server certificate and key files are:

Key file: /etc/ssl/servercerts/serverkey.pem
Certificate file: /etc/ssl/servercerts/servercert.pem

 The eDirectory server certificate and key files are:
Key file: /etc/ssl/servercerts/eDirkey.pem
Certificate file: /etc/ssl/servercerts/eDircert.pem

For more information on certificate management, see “Certificate Management” in the OES 2 
SP1: Planning and Implementation Guide.

4 Click Next.
5 In the New Tree Information page, specify the following information:

The fully distinguished, typeful name for the user Admin.
A password for the user Admin.

6 Click Next.
7 On the eDirectory Configuration - Local Server Configuration page, specify the following 

information:
The context for the server object in the eDirectory tree.
A location for the eDirectory database. 
The default path is /var/opt/novell/eDirectory/data/dib, but you can use this option to 
change the location if you expect the number of objects in your tree to be large and the 
current file system does not have sufficient space.
The ports to use for servicing LDAP requests.
The default ports are 389 non-secure and 636 secure.
The ports to use for providing access to the iMonitor application.
The default ports are 8028 non-secure and 8030 secure.

8 Click Next, then continue with “Specifying Synchronizing Server Time Options” on page 56.

Installing the Server into an Existing eDirectory Tree

1 In the eDirectory Configuration - New or Existing Tree screen, select Existing Tree.
2 In the eDirectory Tree Name field, specify a name for the eDirectory tree you want to join.
3 Select the Use eDirectory Certificates for HTTPS Services check box to replace the existing 

YaST server certificate and key files with eDirectory server certificate and key files (default).
On an existing SLES 10 server that already has certificates installed and configured, leave this 
option deselected to preserve the existing certificate configuration.

IMPORTANT: Selecting the Use eDirectory Certificates for HTTPS Services check box 
overwrites existing certificate configuration files.
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Most OES services that provide HTTPS connectivity are configured by default to use the self-
signed common server certificate created by YaST. Self-signed certificates provide minimal 
security and limited trust, so you should consider using eDirectory certificates instead.
Selecting this option causes eDirectory to automatically back up the currently installed 
certificate and key files and replace them with files created by the eDirectory Organizational 
CA (or Tree CA).
The default YaST server certificate and key files are:

Key file: /etc/ssl/servercerts/serverkey.pem
Certificate file: /etc/ssl/servercerts/servercert.pem

 The eDirectory server certificate and key files are:
Key file: /etc/ssl/servercerts/eDirkey.pem
Certificate file: /etc/ssl/servercerts/eDircert.pem

For more information on certificate management, see “Certificate Management” in the OES 2 
SP1: Planning and Implementation Guide.

4 In the following fields on the eDirectory Configuration - Existing Tree Information dialog, 
specify the required information.

The IP address of an existing eDirectory server with a replica
The NCP port on the existing server
The LDAP and secure LDAP port on the existing server.
The fully distinguished name and context for the user Admin on the existing server
The password for user Admin on the existing server.

5 Click Next. 
6 In the eDirectory Configuration - Local Server Configuration dialog, specify the following 

information:
The context for the server object in the eDirectory tree.
A location for the eDirectory database. 
The default path is /var/opt/novell/eDirectory/data/dib, but you can use this option to 
change the location if you expect the number of objects in your tree to be large and the 
current file system does not have sufficient space.
The ports to use for servicing LDAP requests.
The default ports are 389 non-secure and 636 secure.
The ports to use for providing access to the iMonitor application.
The default ports are 8028 non-secure and 8030 secure.

7 Click Next and continue with “Specifying Synchronizing Server Time Options” on page 56.

Specifying Synchronizing Server Time Options

eDirectory requires that all OES servers, both NetWare and Linux, are time-synchronized. 

1 In the eDirectory Configuration - NTP & SLP page, use the Network Time Protocol (NTP) 
Server field to specify the time source that you want all the servers in the tree to use.
Specify the IP address or DNS hostname of an NTP server. 
For the first server in a tree, we recommend specifying a reliable, external time source.
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When installing multiple servers in to the same eDirectory tree, make sure that all servers point 
to the same time source and not to server holding the master replica. For example, 
time.novell.com or some other time source.
For servers joining a tree, specify the same external NTP time source that the tree is using, or 
specify the IP address of a configured time source in the tree. A time source in the tree should 
be running time services for 15 minutes or more before connecting to it, or the time 
synchronization request for the installation fails.
If the time source server is NetWare 5.0 or earlier, you must specify an alternate NTP time 
source, or the time synchronization request fails.

2 If you want to use the server’s hardware clock, select Use Local Clock.
For servers joining a tree, the installation does not let you proceed if you select this option. You 
must specify the same external NTP time source that the tree is using, or specify the IP address 
of a configured time source in the tree. A time source in the tree should be running time 
services for 15 minutes or more before connecting to it, or the time synchronization request for 
the installation fails.

3 Continue with “Specifying SLP Configuration Options” on page 57.

For information on this important topic, see Implementing Time Synchronization in the OES 2 SP1: 
Planning and Implementation Guide.

Specifying SLP Configuration Options

1 On the eDirectory Configuration - NTP & SLP page, specify the SLP options as desired.
You have the following options for configuring SLP:

Do Not Configure SLP: This option is good for eDirectory trees with three or fewer 
eDirectory servers.
Without SLP, users can’t see a tree list, but they should still be able to attach to a tree by 
name. Users can configure the Novell ClientTM to use DNS, or they can configure the local 
host file (%SystemDrive%\windows\system32\drivers\etc\hosts on 
WinXP) to resolve tree and server names. Users can also specify preferred tree and 
context information in the DHCP Settings page of the Novell Client.
Use Multicast to Access SLP: This option allows the server to request SLP information 
by using multicast packets. Use this in environments that have not established SLP DAs 
(Directory Agents).

IMPORTANT: If you select this option, you must disable the firewall for it to work 
correctly. Multicast creates a significant amount of network traffic and can reduce network 
throughput.

Configure SLP to use an existing Directory Agent: This option configures SLP to use 
an existing Directory Agent (DA) in your network. Use this in environments that have 
established SLP DAs. When selecting this option, you configure the servers to use by 
adding or removing them from the SLP Directory Agent list.
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Service Location Protocols and Scope: This option configures the scopes that a user 
agent (UA) or service agent (SA) is allowed when making requests or when registering 
services, or specifies the scopes a directory agent (DA) must support. The default value is 
DEFAULT. Use commas to separate each scope. For example, net.slp.useScopes = 
myScope1,myScope2,myScope3.
Configured SLP Directory Agents: This option lets you manage the list of hostname or 
IP addresses of one or more external servers on which a SLP Directory Agent is running.

2 Click Next, then continue with Selecting the Novell Modular Authentication Services (NMAS) 
Login Method.

Selecting the Novell Modular Authentication Services (NMAS) Login Method

1 On the Novell Modular Authentication Services page, select all the login methods you want to 
install.

IMPORTANT: The NMASTM client software must be installed on each client workstation 
where you want to use the NMAS login methods. The NMAS client software is included with 
the Novell Client software.

The following methods are available:
CertMutual: The Certificate Mutual login method implements the Simple Authentication 
and Security Layer (SASL) EXTERNAL mechanism, which uses SSL certificates to 
provide client authentication to eDirectory through LDAP.
Challenge Response: The Challenge-Response login method works with the Identity 
Manager password self-service process. This method allows either an administrator or a 
user to define a password challenge question and a response, which are saved in the 
password policy. Then, when users forget their passwords, they can reset their own 
passwords by providing the correct response to the challenge question.
DIGEST-MD5: The Digest MD5 login method implements the Simple Authentication 
and Security Layer (SASL) DIGEST-MD5 mechanism as a means of authenticating the 
user to eDirectory through LDAP.
NDS: The NDS® login method provides secure password challenge-response user 
authentication to eDirectory. This method supports the traditional NDS password when 
the NMAS client is in use and is installed by default. Reinstallation is necessary only if the 
NDS login method object has been removed from the directory.
Simple Password: The Simple Password NMAS login method provides password 
authentication to eDirectory. The Simple Password is a more flexible but less secure 
alternative to the NDS password. Simple Passwords are stored in a secret store on the user 
object.
SASL GSSAPI: The SASL GSSAPI login method implements the Generic Security 
Services Application Program Interface (GSSAPI) authentication. It uses the Simple 
Authentication and Security Layer (SASL), which enables users to authenticate to 
eDirectory through LDAP by using a Kerberos ticket.

For more information about installing and configuring eDirectory, see “Installing or Upgrading 
Novell eDirectory on Linux in Novell eDirectory 8.8 Installation Guide.
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For more information on these login methods, see the online help and “Managing Login and 
Post-Login Methods and Sequences” in the Novell Modular Authentication Services 3.3 
Administration Guide.

2 Click Next, then continue with “Configuring Novell Open Enterprise Server Services” on 
page 59.

Configuring Novell Open Enterprise Server Services

1 After you complete the LDAP configuration or the eDirectory configuration, the Novell Open 
Enterprise Server Configuration summary page is displayed, showing all the OES components 
you installed and their configuration settings. Review the setting for each component and click 
the component heading to change any settings. 
When specifying the configuration information for OES services, see the information in 
“Guidelines for Configuring OES 2 SP1 Linux Components” on page 61.

2 When you are satisfied with the settings for each component, click Next.
3 When confirming the OES component configurations, you might receive the following error:
The proposal contains an error that must be resolved before 
continuing.

If this error is displayed, check the summary list of configured products for a message 
immediately below each product heading that indicates the product or service needs to be 
configured. If you are running the YaST graphical interface, the text appears red. If you are 
installing using the YaST text-base interface, it is not red.
For example, if you have selected Linux User Management in connection with other OES 
products or services, you might see a message similar to the following:
Linux User Management needs to be configured before you can 
continue or disable the configuration.
If you see a message like this, do the following:
3a On the summary page, click the heading for the component.
3b Supply the missing information in each configuration page.

When specifying the configuration information for OES services, see the information in 
“Guidelines for Configuring OES 2 SP1 Linux Components” on page 61.
When you have finished the configuration of that component, you are returned to the 
Novell Open Enterprise Server Configuration summary page.

3c If you want to skip the configuration of a specific component and configure it later, click 
Enabled in the Configuration is enabled status to change the status to Configuration is 
disabled. 
If you change the status to Configuration is disabled, you will configure the OES 
components after the installation is complete. See “Installing or Configuring OES 2 
Services on an Existing OES 2 SP1 Linux or SLES 10 SP2 Server” on page 89.

4 After resolving all product configuration problems, click Next to proceed with the 
configuration of all components.

5 When the configuration has completed, continue with Section 3.4, “Finishing the Installation,” 
on page 60.
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3.4  Finishing the Installation
The installation concludes with the following steps:

1. User Authentication Method
2. Clean Up
3. Release Notes 
4. Hardware Configuration

After a successful configuration, YaST shows the Installation Completed dialog. In this dialog, do 
the following:

1 Optionally, select whether to clone your newly installed system for AutoYaST. To clone your 
system, select Clone This System for AutoYaST. The profile of the current system is stored in /
root/autoinst.xml. Cloning is selected by default.
AutoYaST is a system for automatically installing one or more SUSE Linux Enterprise systems 
without user intervention. AutoYaST installations are performed by using a control file with 
installation and configuration data. For detailed information, see Chapter 8, “Using AutoYaST 
to Install and Configure Multiple OES 2 SP1 Linux Servers,” on page 147.

IMPORTANT: If you select this option and haven’t updated the server during installation, see 
“Password for User Admin Written in Clear Text in y2log” on page 167

2 Finish the installation by clicking Finish in the Installation Completed dialog.
3 After the server reboots, continue with Section 3.5, “Verifying That the Installation Was 

Successful,” on page 60.

3.5  Verifying That the Installation Was 
Successful
One way to verify that your OES Linux server installation was successful and that the components 
are loading properly is to watch the server reboot. As each component is loaded, the boot logger 
provides a status next to it indicating if the component is loading properly. 

You can also quickly verify a successful installation by accessing the server from your Web browser.

1 In the Address field of your Web browser, enter the following URLs:
http://IP_or_DNS
where IP_or_DNS is the IP address or DNS name of your OES Linux server.
You should see a Web page displayed similar to the following:
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2 (Optional) If you want to look at the eDirectory tree and begin to see how iManager works, go 
to the OES Information and Management Web page, click Management Tools > iManager, then 
log in as user Admin (the user you created during product installation).
You can also access iManager by typing the following URL in a browser window and logging 
in as user Admin:
http://IP_or_DNS_name/nps/iManager.html

3 Continue with “What's Next” on page 87.

3.6  Guidelines for Configuring OES 2 SP1 Linux 
Components
Keep the following in mind as you configure the OES 2 SP1 Linux components:
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Table 3-5   Guidelines for Configuring OES Components

Issue Guideline

Software 
Selections When 
Using Text-Based 
YaST

Some older machines, such as Dell* 1300, use the text mode install by default when 
the video card does not meet SLES 10 specifications. When you go into the 
Software Selection, and then to the details of the OES software selections, YaST 
doesn’t bring up the OES selections like it does when you use the graphical YaST 
(YaST2). 

To view the Software Selection and System Task screen, select Filter > Pattern (or 
press Alt+F > Alt+I).

Specifying Typeful 
Admin Names

When installing OES, you must specify a fully distinguished admin name by using 
the typeful, LDAP syntax that includes object type abbreviations (cn=, ou=, o=, 
etc.). For example, you might specify the following:

cn=admin,ou=example_organization,o=example_company

Using Dot-
Delimited or 
Comma-Delimited 
Input for All 
Products

For all parameters requiring full contexts, you can separate the names by using 
comma-delimited syntax; you must be consistent in your usage within the field.

The OES installation routine displays all input in the comma-delimited (LDAP) 
format. However, it converts the name separators to dots when this is required by 
individual product components.

IMPORTANT: After the OES components are installed, be sure to follow the 
conventions specified in the documentation for each product. Some contexts must 
be specified using periods (.) and others using commas (,). However, eDirectory 
supports names like cn=juan\.garcia.ou=users.o=novell. The period (.) inside a 
name component must be escaped.

When using NDAP format (dot), you must escape all embedded dots. For 
example:cn=admin.o=novell\.provo

When using LDAP format (commas), you must escape all embedded commas. For 
example:cn=admin,o=novell\,provo

The installation disallows a backslash and period (\.) in the CN portion of the admin 
name. 

For example, these names are supported:

cn=admin.o=novell
cn=admin.o=novell\.provo
cn=admin.ou=deployment\.linux.o=novell\.provo

These names are not supported:

cn=admin\.first.o=novell
cn=admin\.root.o=novell

Before LUM-enabling users whose cn contains a period (.), you must remove the 
backslash (\) from the unique_id field of the User object container.

For example, cn=juan.garcia has a unique_id attribute = juan\.garcia. Before such a 
user can be LUM-enabled, the backslash (\) must be removed from the unique_id 
attribute.
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Each OES component and the configurable fields associated with it are listed in the following 
sections. These components also include the default or previously entered values, where applicable. 
Some components might require some additional configuration as part of the OES installation; this 
information is also included in the tables.

The following sections list the specific configuration information required for each component:

Section 3.6.1, “LDAP Configuration for Open Enterprise Services,” on page 63
Section 3.6.2, “Novell AFP for Linux,” on page 64
Section 3.6.3, “Novell Archive and Version Services,” on page 65
Section 3.6.4, “Novell Backup/Storage Management Services (SMS),” on page 66
Section 3.6.5, “Novell CIFS for Linux,” on page 66
Section 3.6.6, “Novell Cluster Services,” on page 67
Section 3.6.7, “Novell DHCP Services,” on page 69
Section 3.6.8, “Novell DNS Services,” on page 71
Section 3.6.9, “Novell Domain Services for Windows,” on page 72
Section 3.6.10, “Novell eDirectory Services,” on page 72
Section 3.6.11, “Novell FTP Services,” on page 77
Section 3.6.12, “Novell iFolder,” on page 77
Section 3.6.13, “Novell iManager,” on page 81
Section 3.6.14, “Novell iPrint,” on page 81
Section 3.6.15, “Novell Linux User Management,” on page 82
Section 3.6.16, “Novell NCP Server / Dynamic Storage Technology,” on page 84
Section 3.6.17, “Novell NetStorage,” on page 84
Section 3.6.18, “Novell Pre-Migration Server,” on page 85
Section 3.6.19, “Novell QuickFinder,” on page 85
Section 3.6.20, “Novell Remote Manager,” on page 85
Section 3.6.21, “Novell Samba,” on page 86
Section 3.6.22, “Novell Storage Services (NSS),” on page 86

3.6.1  LDAP Configuration for Open Enterprise Services

Table 3-6   LDAP Configuration for Open Enterprise Services Values

Parameter Default or Previously Entered 
Values

eDirectory Tree Name The new eDirectory tree name 
(default) or name of eDirectory 
tree you are installing the 
server into. 
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3.6.2  Novell AFP for Linux

Table 3-7   Novell Apple Filing Protocol Parameters and Values

Admin Name and Context

Specify the fully distinguished, typeful name of a user with 
administrative rights in the tree. Use LDAP format.

cn=admin,o=novell

Admin Password

Specify a password for the eDirectory Admin user. 

Configured LDAP Servers

A list of servers that can be used to configure other OES services on 
this server. Each added server must have either the master or read/
write replica of the eDirectory tree. The first server added to the list 
becomes the default server for the installed and configured OES 
services to use.

For each server you must specify an IP Address, LDAP Port, Secure 
LDAP Port, and Server Type

LDAP port: 389

Secure LDAP port: 636 

Server Type: local

Parameter Default or Previously Entered 
Values

AFP Proxy User

Select  Use existing user as AFP Proxy User to allow the user to use an 
existing proxy user to configure the AFP service.

Select Create a new AFP Proxy User to allow the user to create a new 
proxy user to configure the AFP service.

Create a new AFP Proxy User 

AFP Proxy User Name

Specify the FQDN (fully qualified distinguished name) of the AFP proxy 
user. 

For example: cn=user, o=novell

NOTE: This user is granted rights to read the passwords of any users, 
including non-AFP users, that are governed by any of the password 
policies you select in the Novell AFP Service Configuration page.

 

AFP Proxy User Password

Specify the password to authenticate to the AFP server.

 

Parameter Default or Previously Entered 
Values
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For additional configuration instructions, see “Installing and Setting Up AFP” in the  OES 2 SP1: 
Novell AFP For Linux Administration Guide

3.6.3  Novell Archive and Version Services

Table 3-8   Novell Archive and Version Services Parameters and Values

For additional configuration instructions, see “Setting Up Archive and Version Services ” in the OES 
2 SP1: Novell Archive and Version Services 2.1 for Linux Administration Guide.

eDirectory Context

Specify the context for the AFP server.

The context defines the position of an object within the directory tree 
structure. It is a list of container objects leading from the object to the 
root of the tree. 

Specifying the context preempts the need to specify the FQDN (fully 
qualified distinguished name) of the user.

Credential Storage Location

Specify where the user credentials of the AFP proxy server are to be 
stored. 

For security reasons, the default and recommended method of 
credential storage is CASA.

CASA

Parameter Default or Previously Entered 
Values

Database Port Number

Specify a port number to use for the archive database communications.

5432

Database Username

Specify a username for the administrator of the archive database (the 
PostgreSQL database for the archived data). 

IMPORTANT: The Postgres user must be an unprivileged user, not the 
root user.

arkuser

Database Password

Specify a password for the database user. 

The default is the password for 
the eDirectory Admin user.

Parameter Default or Previously Entered 
Values
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3.6.4  Novell Backup/Storage Management Services (SMS)

Table 3-9   Novell Backup / Storage Management Services Parameters and Values

For additional configuration instructions, see “Installing and Configuring SMS” in the Installing and 
Configuring SMS.

3.6.5  Novell CIFS for Linux

Table 3-10   Novell CIFS Parameters and Values

Parameter Default or Previously Entered 
Values

Directory Server Address

The IP address shown is the default LDAP server for this service. If you 
do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you 
select has a master replica or read/write replica of eDirectory. If you 
need to add another LDAP server to the list, add it by using the LDAP 
Configuration for Open Enterprise Services dialog.

The default is the first server 
selected in the LDAP 
Configuration list of servers.

Parameter Default or Previously Entered 
Values

eDirectory server address or host name

This is the default eDirectory server IP address. Select from the drop-
down list to change to a different server. 

 

Use secure channel for configuration

By default, this option is selected. This is preferred.

 Selected

LDAP port for CIFS Server

The default is 636. This is preferred. Do not change the default port 
value during a fresh installation of the tree.

NOTE: If the OES 2 Linux server is attached to an existing tree, the 
administrator can change this to another LDAP port.

 636

Local NCP Server context Displays the NCPTM Server 
context.

CIFS Proxy User Name

Create a new proxy user. Use the format 
cn=proxyusername,o=company.

CIFS Proxy User Password

The password specified here is set in the CIFS configuration file. It 
cannot be changed. The maximum length is 256 characters.
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For additional configuration instructions, see “Installing a CIFS Server on OES 2 SP1 Linux” in the 
OES 2 SP1: Novell CIFS for Linux Administration Guide OES 2 SP1: Novell AFP For Linux 
Administration Guide

3.6.6  Novell Cluster Services

Table 3-11   Novell Cluster Services Parameters and Values

eDirectory Contexts

Select or add a new context, indicating where the user resides. Use the 
Add and Delete buttons to add and delete contexts.

The default is displayed. 

Credential Storage Location

By default, the credential is stored in CASA. It is possible to store the 
credentials by using the Local File option. The password file is 
encrypted and encoded in the credential storage location.

CASA

Parameter Default or Previously Entered 
Values

New or Existing Cluster New Cluster

Cluster FDN

Specify the fully distinguished name (FDN) of the cluster. Use the 
comma format illustrated in the example. Do not use dots.

If you are creating a new cluster, this is the name you will give the new 
cluster and the eDirectory context where the new cluster object will 
reside. You must specify an existing context. Specifying a new context 
does not create a new context.

If you are adding a server to an existing cluster, this is the name and 
eDirectory context of the cluster that you are adding this server to.

Cluster names must be unique. You cannot create two clusters with the 
same name in the same eDirectory tree. Cluster names are case 
sensitive on Linux.

Directory Server Address

The IP address shown is the default LDAP server for this service. If you 
do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you 
select has a master replica or read/write replica of eDirectory. If you 
need to add another LDAP server to the list, add it by using the LDAP 
Configuration for Open Enterprise Services dialog.

The default is the first server 
selected in the LDAP 
Configuration list of servers.

Parameter Default or Previously Entered 
Values
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Cluster IP Address

If you are creating a new cluster, specify a unique IP address for the 
cluster.

The cluster IP address is separate from the server IP address and is 
required to be on the same IP subnet as the other servers in the cluster.

Storage Device With Shared Media

If you are creating a new cluster, select the device where the Split Brain 
Detector (SBD) partition will be created.

If you have a shared disk system attached to your cluster servers, 
Novell Cluster Services will create a small cluster partition on that 
shared disk system. This small cluster partition is referred to as the Split 
Brain Detector (SBD) partition. Specify the drive or device where you 
want the small cluster partition created.

You must have at least 20 MB of free space on one of the shared disk 
drives to create the cluster partition. If no free space is available, the 
shared disk drives cannot be used by Novell Cluster Services.

If you do not have a shared disk system connected to your cluster 
servers, accept the default (none). You must create the SBD manually 
before adding a second server to the cluster.

none

Optional Device for Mirrored Partitions

If you want to mirror the SBD partition for greater fault tolerance, select 
the device where you want to mirror to.

You can also mirror SBD partitions after installing Novell Cluster 
Services.

IP Address of this Node

This field contains the IP address of this node. If this server has multiple 
IP addresses, you can change the default address to another value if 
desired.

Start Cluster Services Now

Select this box if you want clustering to start now. If you want clustering 
to start after rebooting, or if you want to manually start it later, deselect 
this box.

This option applies only to installing Novell Cluster Services after the 
OES installation because it starts automatically when the server 
initializes during the installation. 

If you choose to not start Novell Cluster Services software, you need to 
either manually start it after the installation, or reboot the cluster server 
to automatically start it.

You can manually start Novell Cluster Services by going to the /etc/
init.d directory and entering ./novell-ncs start at the server 
console of the cluster server.

Later

Parameter Default or Previously Entered 
Values
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For additional instructions, see the OES 2 SP1: Novell Cluster Services 1.8.5 for Linux 
Administration Guide.

3.6.7  Novell DHCP Services

Table 3-12   Novell DHCP Services Parameters and Values

Parameter Default or Previously Entered 
Values

DHCP Server Context

Specify a context for the DHCP Server object.

o=example

DHCP Server Object Name

Specify the name of the Server object that these DHCP services will be 
running on.

This is the DHCP server object that contains a list of DHCP Services 
(configuration) served by the DHCP Server.

DHCP_example_server

DHCP Locator Object

Specify the context for the DHCP Locator object.

The DHCP Locator object has references to dhcpServer and 
dhcpService objects.

o=example

Group Context

Specify the context for the DHCP Group object.

This object is used to grant the necessary rights to the eDirectory user 
used by the DHCP server to access the DHCP objects.

o=example

Log File Location

Specify the path and filename for the DHCP Services log file. You can 
type the path manually or click Browse to locate the log. 

It is usually in the /var/log/ 
directory.

LDAP Method

Select Static if you do not want the DHCP server to query the LDAP 
server for host details.

Select Dynamic if you want the DHCP server to query for host details 
from the LDAP server for every request.

Selecting the dynamic LDAP method ensures that the responses you 
receive to queries are accurate, but the server takes a longer time to 
respond.

Static

Referrals

Select Chase Referral if you want the DHCP server to follow referrals. 
Otherwise, select the Do Not Chase Referral option.

A referral is a message that the LDAP server sends to the LDAP client 
informing it that the server cannot provide complete results and that 
more data might be on another LDAP server.
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eDirectory Server Address or Host Name

The IP address shown is the default LDAP server for this service. If you 
do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you 
select has a master replica or read/write replica of eDirectory. If you 
need to add another LDAP server to the list, add it by using the LDAP 
Configuration for Open Enterprise Services dialog.

The default is the first server 
selected in the LDAP 
Configuration list of servers.

Use Secure Channel for Configuration

This option is selected by default. When you are configuring DHCP 
services, it ensures that all configuration is transferred over a secure 
channel.

Deselecting this option lets a user with fewer privileges configure LDAP 
services.

Selected

LDAP User Name with Context

Specify a typeful, distinguished name and context for an LDAP user. 

This user should be an eDirectory user that can access the DHCP 
server.

cn=joe,o=example

LDAP User Password

Type a password for the LDAP user.

LDAP Port for DHCP Server

Select a port for the LDAP operations to use.

636

Use Secure LDAP Channel

This option is selected by default to ensure that the data transferred 
between the DHCP server and the LDAP server is secure and private. If 
you deselect this option, the data transferred is in clear text format.

Selected

Request Certificate

Specifies what checks to perform on server certificate in a SSL/TLS 
session. Select one of the following options:

Never: The server does not ask the client for a certificate.

Allow: The server requests a client certificate, but if a certificate is 
not provided or a wrong certificate is provided, the session still 
proceeds normally.

Try: The server requests the certificate. If none is provided, the 
session proceeds normally. If a certificate is provided and it cannot 
be verified, the session is immediately terminated

Hard: The server requests a certificate. A valid certificate must be 
provided, or the session is immediately terminated.

Never

Parameter Default or Previously Entered 
Values
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For additional configuration instructions, see “Installing and Configuring DHCP ” in the OES 2 
SP1: Novell DNS/DHCP Administration Guide for Linux.

3.6.8  Novell DNS Services

Table 3-13   Novell DNS Services Parameters and Values

Paths to Certificate Files

Specify or browse the path for the certificate files. 

The LDAP CA file contains CA Certificates

The LDAP client certificate contains the client certificate. 

The LDAP client key file contains the key file for the client certificate.

The default location for these 
files is /etc/opt/novell/
certs.

Network Boards for the Novell DHCP Server

From the available interfaces, select the network interfaces that the 
Novell DHCP server should listen to.

Parameter Default or Previously Entered 
Values

Directory server address

The IP address shown is the default LDAP server for this service. If you 
do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you 
select has a master replica or read/write replica of eDirectory. If you 
need to add another LDAP server to the list, add it by using the LDAP 
Configuration for Open Enterprise Services dialog.

The default is the first server 
selected in the LDAP 
Configuration list of servers.

Novell DNS Services Locator Object Context

Specify the context for the DNS Locator object.

The Locator object contains global defaults, DHCP options, and a list of 
all DNS and DHCP servers, subnets, and zones in the tree.

o=example

Novell DNS Services Root Server Info Context

Specify the context for the DNS Services root server.

The RootSrvrInfo Zone is an eDirectory container object that contains 
resource records for the DNS root servers.

o=example

Novell DNS Services Group Object Context

Specify the context for the DNS Group object.

This object is used to grant DNS servers the necessary rights to other 
data within the eDirectory tree.

o=example

Parameter Default or Previously Entered 
Values
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For additional configuration instructions, see “Installing and Configuring DNS ” in the OES 2 SP1: 
Novell DNS/DHCP Administration Guide for Linux.

3.6.9  Novell Domain Services for Windows
There are multiple configuration scenarios, depending on your deployment. For information, see 
“Installing and Configuring Domain Services for Windows” in the OES 2 SP1: Domain Services for 
Windows Administration Guide.

3.6.10  Novell eDirectory Services

Table 3-14   Novell eDirectory Parameters and Values

Local NCP Server Context

Specify a context for the local NCP Server object.

o=example

Use Secure LDAP Port

This option is selected by default to ensure that the data transferred by 
this service is secure and private. If you deselect this option, the 
transferred data is in clear text format.

Selected

eDirectory Username with Context for DNS

Specify the fully distinguished, typeful name of an existing eDirectory 
user. 

This user is used to authenticate to eDirectory to access information for 
DNS during runtime. The user must have eDirectory read, write, and 
browse rights under the specified context.

cn=jsmith,ou=users,o=example

Specify Password for eDirectory User

Type the password for the eDirectory user that you specified for 
accessing DNS.

Parameter Default or Previously Entered 
Values

New Tree

Creates a new tree. Use this option if this is the first server to go into the 
tree or if this server requires a separate tree. Keep in mind that this 
server will have the master replica for the new tree, and that users must 
log into this new tree to access its resources.

Selected

Existing Tree

Incorporates this server into an existing eDirectory tree. This server 
might not have a replica copied to it, depending on the tree 
configuration. For details, see the “Guidelines for Replicating Your Tree” 
in the Novell eDirectory 8.8 Administration Guide.

Parameter Default or Previously Entered 
Values
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Tree Name

Specify the name of the eDirectory tree you want to create or the name 
of the tree you want to install this server into. If you are creating a new 
tree, specify a unique tree name.

Use eDirectory Certificates for HTTPS Services

Most OES services that provide HTTPS connectivity are configured by 
default to use the self-signed common server certificate created by 
YaST. Self-signed certificates provide minimal security and limited trust, 
so you should consider using eDirectory certificates instead.

Selecting this option causes eDirectory to automatically back up the 
currently installed certificate and key files and replace them with files 
created by the eDirectory Organizational CA (or Tree CA).

For new server installations, this option is enabled by default and is 
recommended for the increased security it provides.

For add-on installations and upgrades to existing servers, this option is 
not selected by default. This prevents any certificates that you might 
have installed from a third-party CA from being accidentally backed up 
and overwritten. However, if you have not installed third-party 
certificates and your services are using the YaST-generated certificates, 
we recommend that you select this option for increased security.

For more information on certificate management and this option, see 
“Security” in the OES 2 SP1: Planning and Implementation Guide. 

Selected on new installs.

Deleted on add-on or upgrades 
to existing servers.

FDN Admin Name with Context

Specify the name of the administrative user for the new tree. This is the 
fully distinguished name of a User object that will be created with full 
administrative rights in the new directory.

When specifying a context, you can use LDAP (comma-delimited) or 
NDAP (dot delimited) format.

cn=admin,o=example

Admin Password

Specify the eDirectory administrator's password. This is the password of 
the user specified in the prior field.

Verify Admin Password

Retype the password to verify it.

Enter Server Context

Specify the location of the new server object in the eDirectory tree.

When specifying a context, you can use LDAP (comma delimited) or 
NDAP (dot-delimited) format.

Parameter Default or Previously Entered 
Values
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Enter Directory Information Base (DIB) Location

Specify a location for the eDirectory database. The default path is /
var/opt/novell/eDirectory/data/dib, but you can use this 
option to change the location if you expect the number of objects in your 
tree to be large and the current file system does not have sufficient 
space.

/var/opt/novell/
eDirectory/data/dib

Enter LDAP Port

Specify the LDAP port number this server will use to service LDAP 
requests.

389

Enter Secure LDAP Port

Specify secure LDAP port number this server will use to service LDAP 
requests.

636

Enter iMonitor Port

Specify the port this server will use to provide access to the iMonitor 
application. iMonitor lets you monitor and diagnose all servers in your 
eDirectory tree from any location on your network where a Web browser 
is available.

8028

Enter Secure iMonitor Port

Specify the secure port this server will use to provide access to the 
iMonitor application. 

8030

Network Time Protocol (NTP) Server

Specify the IP address or DNS hostname of an NTP server. For the first 
server in a tree, we recommend specifying a reliable, external time 
source, or you can select Local Clock to use the server hardware clock.

For servers joining a tree, specify the same external NTP time source 
that the tree is using, or specify the IP address of a configured time 
source in the tree. A time source in the tree should be running time 
services for 15 minutes or more before connecting to it, or the time 
synchronization request for the installation fails.

If the time source server is NetWare 5.0 or earlier, you must specify an 
alternate NTP time source, or the time synchronization request fails. For 
more information, see “Time Synchronization” in the OES 2 SP1: 
Planning and Implementation Guide.

Do Not Configure SLP

Do not configure the Service Location Protocol. SLP enables client 
applications to dynamically discover services in TCP/IP networks.

IMPORTANT: If the tree where you are installing this server has or will 
have more than three servers, you must configure SLP.

Parameter Default or Previously Entered 
Values
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Use Multicast to Access SLP

Sends SLP requests to multiple servers that are using the Service 
Location General Multicast Address (224.0.1.22). All Service Agents 
holding service information that satisfies the request unicast the reply 
directly to the requesting User Agent. Use this option if no Directory 
Agents are available.

IMPORTANT: If you select this option, you must disable the firewall.

Configure SLP to Use an Existing Directory Agent

Configures SLP to use an existing Directory Agent in your network. A 
Directory Agent stores and disseminates service information for the 
network.

Service Location Protocol Scopes

Specify the scopes a user agent (UA) or service agent (SA) is allowed 
when making requests or when registering services, or specify the 
scopes a directory agent (DA) must support. The default value is 
DEFAULT.

Use commas with no space to separate each scope. For example, 
net.slp.useScopes = myScope1,myScope2,myScope3

Default

This information is required 
when selecting the Use 
Multicast to Access SLP or 
Configure SLP to Use an 
Existing Directory Agent option 
is selected.

Configured SLP Directory Agent

Specify the hostname or IP address of one or more external servers on 
which a SLP Directory Agent is running. Do not specify the local host.

To add an agent, click Add. In the SLP DA Server field, specify a 
server's DNS name or IP address, then click Add.

To remove an agent, select one or more agents to remove, then click 
Delete.

Enabled only when configuring 
SLP to use an existing 
Directory Agent.

Parameter Default or Previously Entered 
Values
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For additional configuration instructions, see “Installing or Upgrading Novell eDirectory on Linux” 
in the Novell eDirectory 8.8 Installation Guide.

Novell Modular Authentication Services

Choose the login methods that you want to install into eDirectory by 
selecting the appropriate check boxes. 

If you want to install all of the login methods into eDirectory, click Select 
All. If you want to clear all selections, click Deselect All.

IMPORTANT: The NMASTM client software must be installed on each 
client workstation where you want to use the NMAS login methods. The 
NMAS client software is included with the Novell ClientTM software.

CertMutual: The Certificate Mutual login method implements the 
Simple Authentication and Security Layer (SASL) EXTERNAL 
mechanism, which uses SSL certificates to provide client 
authentication to eDirectory through LDAP.

Challenge Response: The Challenge-Response login method 
works with the Identity Manager password self-service process. 
This method allows either an administrator or a user to define a 
password challenge question and a response, which are saved in 
the password policy. Then, when users forget their passwords, 
they can reset their own passwords by providing the correct 
response to the challenge question.

DIGEST-MD5: The Digest MD5 login method implements the 
Simple Authentication and Security Layer (SASL) DIGEST-MD5 
mechanism as a means of authenticating the user to eDirectory 
through LDAP.

NDS: The NDS login method provides secure password 
challenge-response user authentication to eDirectory. This method 
supports the traditional NDS password when the NMAS client is in 
use. Reinstallation is necessary only if the NDS login method 
object has been removed from the directory.

Simple Password: The Simple Password NMAS login method 
provides password authentication to eDirectory. The Simple 
Password is a more flexible but less secure alternative to the NDS 
password. Simple Passwords are stored in a secret store on the 
user object.

SASL GSSAPI The SASL GSSAPI login method implements the 
Generic Security Services Application Program Interface 
(GSSAPI) authentication by using the Simple Authentication and 
Security Layer (SASL) that enables users to authenticate to 
eDirectory through LDAP by using a KerberosTM ticket. 

For more information on these login methods, see “Managing 
Login and Post-Login Methods and Sequences” in the Novell 
Modular Authentication Services 3.3 Administration Guide. 

Challenge Response and NDS 
selected

Parameter Default or Previously Entered 
Values
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3.6.11  Novell FTP Services
No additional configuration is required.

3.6.12  Novell iFolder
When you configure iFolder as part of the OES install and configuration, you can specify only an 
EXT3 or ReiserFS volume location for the System Store Path, which is where you are storing 
iFolder data for all your users. You cannot create NSS volumes during the system install.

If you want to use an NSS volume to store iFolder data, you must reconfigure iFolder after the initial 
OES installation. To reconfigure, use Novell iManager to create an NSS volume, then go to YaST > 
Open Enterprise Server > Install and Configure Open Enterprise Services and select iFolder 3.6 to 
enter new information. All previous configuration information is removed and replaced. 

Table 3-15   Novell iFolder 3.6 Parameters and Values

Parameter Default or Previously Entered 
Values

iFolder Component to Be Configured

iFolder Server: This option lets you configure the settings for the 
iFolder server. It is the central repository for storing user iFolders and 
synchronizing files for enterprise users.

iFolder Web Admin: This option lets you create and configure settings 
for the administrator user. The iFolder Admin user is the primary 
administrator of the iFolder Enterprise Server. The Web Admin server 
does not need to be configured on the iFolder Enterprise Server. 
Devoting a separate server to the Web Admin application improves the 
performance of the iFolder Enterprise Server by reducing the admin 
traffic.

iFolder Web Access: This option lets you configure the Web Access 
server, which is an interface that lets users have remote access to 
iFolders on the enterprise server. The Web Access server lets users 
perform all the operations equivalent to those of the iFolder client 
through using a standard Web browser. The Web Access server does 
not need to be configured in the same iFolder Enterprise Server. 
Directing the user tasks to a separate server and thereby reducing the 
HTTP requests helps to improve the performance of the iFolder 
Enterprise Server.

All three options are selected

Name Used to Identify the iFolder System to Users

Specify a unique name to identify your iFolder Enterprise Server.

iFolder

System Description (optional)

Specify a descriptive label for your iFolder Enterprise Server to identify 
it to the users.

iFolder Enterprise System
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Path to Server's Data Files

Specify the case-sensitive address of the location where the iFolder 
Enterprise Server stores iFolder application files as well as the user 
iFolders and files.

IMPORTANT: This location cannot be modified after install.

/var/simias/data/

Path to the Default Configuration Files

Specify the case-sensitive address of the location where the iFolder 
Enterprise Server stores iFolder configuration files.

IMPORTANT: This location cannot be modified after install, and it can 
be the same location as that of the server data files.

 /var/simias/conf

Path to the Recovery Agent Certificates (optional)

Specify the path to the recovery agent certificates that are used for 
recovering the encryption key.

Name of iFolder Server

Specify a unique name to identify your iFolder Enterprise Server. For 
example: Host1.

server_name

iFolder Public URL

Specify the public URL for users to reach the iFolder Enterprise Server.

local ip address

iFolder Private URL

Specify the private URL corresponding to the iFolder Enterprise Server 
to allow communication between the servers within the iFolder domain. 
The private URL and the public URL can be the same.

local ip address

iFolder Port to Listen On

Specify the port for the iFolder to listen on.

80

Install into Existing iFolder Domain

Select this option when you want to attach to an existing iFolder 
domain. If this option is not selected, this server becomes the Master 
iFolder server.

not selected

Private URL of the Master Server

Specify the private URL of the Master iFolder server that holds the 
master iFolder data for synchronization to the current iFolder Enterprise 
Server.

Parameter Default or Previously Entered 
Values
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Directory server address

The IP address shown is the default LDAP server for this service. If you 
do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you 
select has a master replica or read/write replica of eDirectory. If you 
need to add another LDAP server to the list, add it by using the LDAP 
Configuration for Open Enterprise Services dialog.

The default is the first server 
selected in the LDAP 
Configuration list of servers.

The iFolder Default Administrator

Specify the username for the default iFolder administrative user. Use 
the full distinguished name of the iFolder administrative user.

cn=admin,o=example

iFolder Admin Password

Specify a password for the iFolder administrative user.

Verify iFolder Admin Password

Type the password for the iFolder administrative user again.

LDAP Proxy User

Specify the full distinguished name of the LDAP Proxy user. 

This user must have the Read right to the LDAP service. This user is 
used to provision the users between iFolder Enterprise Server and the 
LDAP server. If it does not already exist, this user is created and 
granted the Read right to the root of the tree. The LDAP proxy user's 
domain name (DN) and password are stored by iFolder.

 cn=user,o=example

LDAP Proxy User Password

Specify a password for the LDAP Proxy user.

Verify LDAP Proxy User Password

Type the password for the LDAP Proxy user again.

LDAP Search Context

Click Add, then specify an LDAP tree context to be searched for users 
to provision them in iFolder. For example, o=acme, o=acme2, or 
o=acme3

If no context is specified, only the iFolder administrative user is 
provisioned for services during the install.

o=example

Parameter Default or Previously Entered 
Values
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LDAP Naming Attribute

Select which LDAP attribute of the User account to apply when 
authenticating users. This setting cannot be changed after the install.

Each user enters a username in this specified format at login time. 
Common Name (CN) is the default, and an e-mail address (email) is the 
other option.

For example, if a user named John Smith has a common name of jsmith 
and e-mail of john.smith@example.com, this field determines whether 
the user enters jsmith or john.smith@example.com as the username 
when logging in to the iFolder Enterprise Server.

Common Name (CN)

Require a Secure Connection Between the LDAP server and the iFolder 
Server.

If the LDAP server co-exists on the same computer as the iFolder 
Enterprise Server, you can deselect this option, which increases the 
performance of LDAP authentications.

Selected

iFolder Web Access Configuration

Apache Alias

Specify the Apache alias to point to the iFolder Web Access Application. 
This is a user-friendly pointer for the Apache service.

 /ifolder

Host or IP Address of the iFolder Server

Specify the host or IP address of the iFolder Enterprise Server to be 
used by the iFolder Web Access application. This Web Access 
application performs all the user-specific iFolder operations on the host 
that runs the iFolder Enterprise Server.

local server

Require a Secure Connection Options

These options are selected by default to establish a secure connection 
between the iFolder server and the iFolder Web Access application or 
the Web browser and the iFolder Web Access application. This enables 
a secure SSL channel between the two.

Selected

Web Admin Configuration 

Apache Alias

Specify an Apache alias to point to the iFolder Web Admin application. 
This is an admin-friendly pointer for the Apache service.

/admin

Host or IP Address of the iFolder Server

Specify the hostname or IP address of the iFolder Enterprise Server to 
be managed by the iFolder Web Admin application. The iFolder Web 
admin application manages this host.

local server

Parameter Default or Previously Entered 
Values
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For additional configuration instructions, see “Installing and Configuring iFolder Services” in the 
OES 2 SP1: Novell iFolder 3.7 Administration Guide.

3.6.13  Novell iManager

Table 3-16   Novell iManager Parameters and Values

For additional configuration instructions, see “Installing iManager” in the Novell iManager 2.7 
Installation Guide.

3.6.14  Novell iPrint

Table 3-17   Novell iPrint Parameters and Values

Secure Connection Options

These options are selected by default to establish a secure connection 
between the iFolder Enterprise Server and the iFolder Web Admin 
application or the Web browser and the iFolder Web Admin application. 
This enables a secure SSL channel between the two.

Selected

Parameter Default or Previously Entered 
Values

eDirectory Tree Name

Shows the name of a valid eDirectory tree that you specified when 
configuring eDirectory. To change this configuration, you must change 
the eDirectory configuration.

exampletree

eDirectory Admin with Context

Shows the eDirectory Admin name and context that you specified when 
configuring eDirectory. This is the user that has full administrative rights 
to perform operations in iManager.

cn=admin,o=example

Parameter Default or Previously Entered 
Values

Directory server address

The IP address shown is the default LDAP server for this service. If you 
do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you 
select has a master replica or read/write replica of eDirectory. If you 
need to add another LDAP server to the list, add it by using the LDAP 
Configuration for Open Enterprise Services dialog.

The default is the first server 
selected in the LDAP 
Configuration list of servers.

Parameter Default or Previously Entered 
Values
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For additional configuration instructions, see “Installing and Setting Up iPrint on Your Server” in 
the OES 2: iPrint for Linux Administration Guide.

3.6.15  Novell Linux User Management

Table 3-18   Novell Linux User Management Parameters and Values

Parameter Default or Previously Entered 
Values

Directory server address

The IP address shown is the default LDAP server for this service. If you 
do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you 
select has a master replica or read/write replica of eDirectory. If you 
need to add another LDAP server to the list, add it by using the LDAP 
Configuration for Open Enterprise Services dialog.

The default is the first server 
selected in the LDAP 
Configuration list of servers.

Unix Config Context

The Unix Config object holds a list of the locations (contexts) of Unix 
Workstation objects in eDirectory. It also controls the range of numbers 
to be assigned as UIDs and GIDs when User objects and Group objects 
are created.

Specify the eDirectory context (existing or created here) where the Unix 
Config object will be created. An LDAP search for a LUM User, a LUM 
Group, or a LUM Workstation object begins here, so the context must 
be at the same level or higher than the LUM objects searched for.

If the Unix Config Object is placed below the location of the User 
objects, the /etc/nam.conf file on the target computer must include 
the support-outside-base-context=yes parameter.

Geographically dispersed networks might require multiple Unix Config 
objects in a single tree, but most networks need only one Unix Config 
object in eDirectory.

o=example

Unix Workstation Context

Computers running Linux User Management (LUM) are represented by 
Unix Workstation objects in eDirectory. The object holds the set of 
properties and information associated with the target computer, such as 
the target workstation name or a list of eDirectory groups that have 
access to the target workstation.

Specify the eDirectory context (existing or created here) for the Unix 
Workstation object created by the install for this server. The context 
should be the same as or below the Unix Config Context specified 
above.

o=example

Proxy User Name with Context (Optional)

Specify a user (existing or created here) with rights to search the LDAP 
tree for LUM objects.

cn=proxy,o=novell
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For additional configuration instructions, see “Setting Up Linux User Management” in the OES 2 
SP1: Novell Linux User Management Technology Guide.

Proxy User Password

Specify a password (existing or created here) for the Proxy user.

Restrict Access to the Home Directories of Other Users

This option is selected by default to restrict read and write access for 
users other than the owner to home directories.

Using the default selection changes the umask setting in /etc/
login.defs from 022 to 077.

Selected

Services to LUM-enable for authentication via eDirectory:

login: no
ftp: no
sshd: no
su: no
rsh: no
rlogin: no
xdm: no
openwbem: yes
gdm: no
gdm-autologin: no
gnome-passwd: no
gnome-screensaver: no
gnomesu-pam: no

Select the services to LUM-enable on this server. The services will be 
available to authenticated LUM users.

OpenWBEM is selected by default because it is used by many of the 
OES services such as iPrint, NSS, SMS, Novell Remote Manager, and 
Samba. To get access to iManager, you must enable OpenWBEM.

SSHD and NetStorage: If you want to use the SSH protocol to define a 
NetStorage storage location object so your users can use SSH to have 
access to local files or files on another server in the same eDirectory 
tree, you must select SSHD as a LUM-enabled service.

If do not select SSHD, users cannot to log in to NetStorage through 
SSH to access their files.

IMPORTANT: Before you 
change the PAM-enabled 
service settings, be sure you 
understand the security 
implications explained in “User 
Restrictions—Some OES 2 
Linux Limitations” in the OES 2 
SP1: Planning and 
Implementation Guide.

Parameter Default or Previously Entered 
Values
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3.6.16  Novell NCP Server / Dynamic Storage Technology

Table 3-19   Novell NCP Server Parameters and Values

For additional configuration instructions, see “Installing and Configuring NCP Server for Linux” in 
the OES 2 SP1: NCP Server for Linux Administration Guide.

3.6.17  Novell NetStorage

Table 3-20   Novell NetStorage Parameters and Values

For additional configuration instructions, see “Installing NetStorage” in the OES 2 SP1: NetStorage 
for Linux Administration Guide.

Parameter Default or Previously Entered 
Values

Admin Name with Context

This value is a default value that is specified in the eDirectory 
configuration.

cn=admin,o=example

Parameter Default or Previously Entered 
Values

Authentication Domain Host

The IP address shown is the default LDAP server for this service. If you 
do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you 
select has a master replica or read/write replica of eDirectory. If you 
need to add another LDAP server to the list, add it by using the LDAP 
Configuration for Open Enterprise Services dialog.

The default is the first server 
selected in the LDAP 
Configuration list of servers.

Proxy User Name with Context

Enter the Proxy User Name including the context, or accept the default. 
This is required so that NetStorage has sufficient rights to get and save 
users iFolder passphrases the first time they access iFolder. This 
means that users do not need to enter a passphrase when accessing 
files and directories on an iFolder server. The default is the Admin user 
that is created during the eDirectory installation.

cn=admin,o=example

User Context

Enter the Users Context, or accept the default. This is the eDirectory 
context for the users that will use NetStorage. NetStorage searches the 
eDirectory tree down from the specified context for User objects. If you 
want NetStorage to search the entire eDirectory tree, specify the root 
context.

o=example
SP1: Linux Installation Guide



novdocx (en)  11 July 2008
3.6.18  Novell Pre-Migration Server
No additional configuration is required. For information, see “Preparing the Source Server for 
Migration” the OES 2 SP1: Migration Tool Administration Guide.

3.6.19  Novell QuickFinder

Table 3-21   Novell QuickFinder Parameters and Values

For additional configuration instructions, see “Installing QuickFinder Server” in the OES 2: Novell 
QuickFinder Server 5.0 Administration Guide.

3.6.20  Novell Remote Manager
No additional configuration for the installation is required. To change the configuration after the 
installation, see “Changing the Configuration” in the OES 2 SP1: Novell Remote Manager for Linux 
Administration Guide.

Parameter Default or Previously Entered 
Values

Novell QuickFinder Admin User Type

Make the QuickFinder administrator a LUM-enabled eDirectory user or 
a local Linux user.

Local: Select this option to give QuickFinder Server administration 
rights to a local Linux user (the default is the root user if no other local 
users exist).

Directory LUM Enabled: Gives QuickFinder Server administration rights 
to an eDirectory user.

Local

eDirectory Admin Name

Enter the QuickFinder administrator name. If you selected Directory 
LUM enabled as the user type, include the full context (such as 
cn=admin,o=novell). If you selected Local as the user type, enter only 
the admin name (such as root). If the user does not already exist, it will 
be created.

cn=admin.o=example

Add novlwww User to the Shadow Group

QuickFinder uses the Pluggable Authentication Modules (PAM) to 
authenticate users for both administration and rights-based searching. 
Because QuickFinder is a servlet under Tomcat, it has the same rights 
to the system as the Tomcat user (wwwrun). 

For QuickFinder to verify user credentials for local users (including 
root), the wwwrun user must be added to the local shadow group. If only 
LUM-enabled eDirectory users will use QuickFinder, this option does 
not need to be set.

Selected
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3.6.21  Novell Samba

Table 3-22   Novell Samba Parameters and Values

For additional configuration instructions, see “Installing the Novell Samba Components” in the 
OES2 SP1: Samba Administration Guide.

3.6.22  Novell Storage Services (NSS)

Table 3-23   Novell Storage Services Parameters and Values

Field or Selection Default or Previously Entered 
Values and Comments

Directory server address

The IP address shown is the default LDAP server for this service. If you 
do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you 
select has a master replica or read/write replica of eDirectory. If you 
need to add another LDAP server to the list, add it by using the LDAP 
Configuration for Open Enterprise Services dialog.

This is the primary IP address of the LDAP server to which CIFS client 
users (such as Windows users) authenticate, to use LDAP for access to 
the directories and files on this OES Linux server.

The default is the first server 
selected in the LDAP 
Configuration list of servers.

Base Context for Samba Users

The eDirectory context (existing or created here) where the default 
Samba group is created. By default, this is the same context as the 
LUM Workstation object. Do not change the default unless you are 
altering the standard Samba configuration.

o=example

Proxy User Name with Context

A user on the LDAP server specified that has rights to search the LDAP 
tree for Samba users. The name and context must be specified using 
typeful syntax. (cn=name,ou=organizational_unit,o=organization)

cn=admin.o=example

Proxy User Password

The password of the Proxy User specified above.

Parameter Default or Previously Entered 
Values

Directory Server Address

The IP address shown is the default LDAP server for this service. If you 
do not want to use the default, select a different LDAP server in the list.

If you are installing into an existing tree, ensure that the server you 
select has a master replica or read/write replica of eDirectory. If you 
need to add another LDAP server to the list, add it by using the LDAP 
Configuration for Open Enterprise Services dialog.

The default is the first server 
selected in the LDAP 
Configuration list of servers.
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For additional configuration instructions, see “Installing and Configuring Novell Storage Services” 
in the OES 2 SP1: NSS File System Administration Guide.

3.7  What's Next
After you've completed the initial installation, complete any additional tasks you might need to 
perform. See “Completing Installation or Upgrade Tasks on OES 2 SP1 Linux” on page 123 and 
“Updating an OES 2 SP1 Linux Server” on page 127.

FD NSS Admin Name with Context

Enter the NSS Admin name and context. This is the fully distinguished 
name of a User object with administrative rights to NSS. You must have 
a unique NSS admin name for each server that uses NSS. The default 
NSS Admin Name is the server host name concatenated with the LDAP 
Admin Name you entered for this server. For example: 
cn=HOSTNAMEadmin,o=acme

cn=servernameadmin.o=exam
ple

Parameter Default or Previously Entered 
Values
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4Installing or Configuring OES 2 
Services on an Existing OES 2 
SP1 Linux or SLES 10 SP2 Server

After installing or upgrading to Novell® Open Enterprise Server (OES 2 SP1) Linux, you can also 
install additional products or services and configure them to work in the new environment. If you 
have installed or upgraded a server to SUSE® Linux Enterprise Server (SLES) 10 SP2, you can also 
add OES 2 SP1 services to the server.

Section 4.1, “Installing or Configuring OES Services on an Existing Server,” on page 89
Section 4.2, “What's Next,” on page 92

IMPORTANT: If you have updated a server with a Support Pack, make sure the installation source 
is pointing to the latest Support Pack media. 

4.1  Installing or Configuring OES Services on an 
Existing Server
IMPORTANT: If you are adding supported OES2 components to a server that is running the Xen 
kernel, you must reset the boot loader to boot the standard kernel before adding the OES 2 SP1 
components.

1. In YaST, select System > Boot Loader > SuSE Linux Enterprise Server 10 SP2 > Set As 
Default > Finish. 

2. Reboot the server.

After adding the supported OES2 components, reset the boot loader option to XEN. 

1. In YaST, select System > Boot Loader > XEN > Set As Default > Finish.
2. Reboot the server.

Be sure to add only those OES 2 SP1 components that are supported on a VM host server. For more 
information, see “Step 3 on page 155.”

To install or configure OES 2 SP1 services on an existing OES 2 SP1 Linux server or SLES 10 SP2 
server:

1 Open YaST.
2 If an OES 2 SP1 installation source has not been added to the server: 

2a Click Software > Add-on Product.
2b Click Add.
2c In the Add-On Product Media dialog, click CD > Next.

If you are using an alternate installation source, click the appropriate option that matches 
your installation source selection.
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2d In the Insert the Add-On Product CD dialog, select the appropriate drive where you want 
to insert the CD labeled Open Enterprise Server 2 CD 1.

2e Click Eject.
2f Insert the CD labeled Open Enterprise Server 2 CD 1, then click Continue.

2g Read and accept the Novell Open Enterprise Server 2 license agreement, then click Next.
2h Confirm that the Add-On Product Installation page shows the correct path to the OES 

media, then click Next.
2i Continue with Step 4.

3 If an OES installation source has already been added to the server, click Open Enterprise 
Server > OES Install and Configuration.

4 On the Software Selection page, select the OES components that you want to install or 
configure. 
Services that you have already installed are indicated by a blue check mark in the status check 
box next to the service.

5 If you are only configuring or reconfiguring services that are already installed, click Accept, 
then skip to Step 7.

Not all OES components require eDirectory to be installed on the local server. Components that 
have a dependency on eDirectory being installed locally will prompt you to install eDirectory if 
it is not already installed. 

IMPORTANT: If you want the OES components to use a local eDirectory database, we 
recommend that you install eDirectory before installing any other OES component.
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If you need to reconfigure eDirectory, we recommend that you use tools provided by 
eDirectory such as iMonitor or iManager to change the configure rather than YaST. The 
configuration provided in YaST is for the initial eDirectory installation and configuration only.

The following services have eDirectory dependencies:
Novell Cluster ServicesTM

Novell DHCP
Novell DNS
Novell FTP
Novell iFolder®

Novell iPrint
Novell NCPTM Server
Novell NetStorage
Novell NSS
Novell iManager (eDirectory must be somewhere in the network)

6 After selecting the services to install, click Accept.
7 Change the default configuration information as required.

Figure 4-1   Example of the OES Configuration Dialog with Configuration and Re-Configuration Statuses
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In most cases, the default configuration is acceptable. You need to change the configuration at 
the following times:

When the installation indicates that more information is required by displaying the 
following message:
service_name service requires additional configuration 
information before continuing or disable the configuration.

You want to change the default configuration settings, such as enabling services for LUM.
You want to reconfigure a service that has already been configured.

7a To change the configuration of a newly installed service or a service that has already been 
configured, change its configuration status to Enabled, then click the service heading link 
to access the configuration dialog for that service.
Newly installed services that have not been configured have the status of Configure 
is enabled.
Services that have already been configured have a status of Reconfigure is 
disabled.

7b To enable the configuration status of any disabled service configuration, click the 
Disabled link to change the status to Enabled.

7c To delay the configuration of newly installed services to a later time, click the Enabled 
link to change the status to Configure is disabled.

8 When all the services have complete configuration information and the configuration or 
reconfiguration status is set to enable for the services that you want to configure, click Next to 
continue with the configuration process.

4.2  What's Next
After you've completed the configuration process, complete any additional tasks you might need to 
perform. See “Completing Installation or Upgrade Tasks on OES 2 SP1 Linux” on page 123 and 
“Updating an OES 2 SP1 Linux Server” on page 127.
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5Upgrading to OES 2 SP1 Linux

Novell® Open Enterprise Server 2 provides the option of updating an existing system to the new 
version without completely reinstalling it. No new installation is needed. Existing data such as home 
directories and system configuration is kept intact. During the life cycle of the product, you can 
apply Service Packs to increase system security and correct software defects.

Section 5.1, “About Upgrading,” on page 93
Section 5.2, “Planning for the Upgrade to OES 2 SP1,” on page 94
Section 5.3, “Meeting the Upgrade Requirements,” on page 96
Section 5.4, “Upgrading the Server,” on page 98
Section 5.5, “Finishing the Upgrade,” on page 119
Section 5.6, “Verifying That the Upgrade Was Successful,” on page 120
Section 5.7, “What's Next,” on page 121

5.1  About Upgrading
Section 5.1.1, “Down-Server Upgrading Is Required,” on page 93
Section 5.1.2, “Supported Upgrade Paths,” on page 93

5.1.1  Down-Server Upgrading Is Required
SLES 10 supports an upgrade method referred to in the SLES documentation as an “online 
migration.” Basically, you can upgrade a SLES 10 server to a newer support pack through the patch 
channel.

Unlike the services on SLES 10, OES 2 services are tightly integrated with eDirectory. The online 
migration mechanisms in SLES 10 do not support the eDirectory configuration changes that must 
happen when an OES server is upgraded. 

Therefore, upgrading an OES 2 server through the patch channel is not supported.

5.1.2  Supported Upgrade Paths
Table 5-1 outlines the supported paths for upgrading to OES 2 SP1. 

Table 5-1   Supported OES 2 SP1 Upgrade Paths

Source Destination

OES 1 SP2 (32-bit) OES 2 SP1 (32-bit)

OES 2 (32-bit) OES 2 SP1 (32-bit)

OES 2 (64-bit) OES 2 SP1 (64-bit)
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IMPORTANT: Source servers must have all patches applied from the appropriate SLES and OES 
patch channels prior to an upgrade.

5.2  Planning for the Upgrade to OES 2 SP1
Section 5.2.1, “Be Sure to Check the Readme:,” on page 94
Section 5.2.2, “Always Upgrade SLES and OES at the same time:,” on page 94
Section 5.2.3, “Understanding the Implications for Other Products Currently Installed on the 
Server,” on page 94

5.2.1  Be Sure to Check the Readme:
The “Installation/Upgrade Issues” section documents issues that Novell plans to address in a future 
release.

5.2.2  Always Upgrade SLES and OES at the same time:
You must upgrade SUSE® Linux Enterprise Server (SLES) 10 and OES 2 Linux at the same time.

5.2.3  Understanding the Implications for Other Products 
Currently Installed on the Server

“OES 1: Non-OES 2 Packages Are Deleted by Default:” on page 94
“OES 2: Non-OES 2 Packages Are Retained but Might Not Work After Upgrading:” on 
page 95

OES 1: Non-OES 2 Packages Are Deleted by Default:

During the upgrade process from OES 1 to OES 2 SP1, packages that are not part of the SLES 10 
and OES 2 distributions are automatically selected for deletion. 

Examples include:

OES 1 services not included in OES 2: Such as iFolder 2, eGuide, and Virtual Office. For 
more information, see “eGuide, IFolder 2, and Virtual Office Are Still Available on Netware” 
in the OES 2 SP1: Planning and Implementation Guide.
Other Novell products: Such as GroupWise®, ZENworks®, and Identity Manager.

For Information About This Novell Product See This Documentation

GroupWise GroupWise 7 online documentation (http://
www.novell.com/documentation/groupwise.html)

ZENworks ZENworks online documentation (http://
www.novell.com/documentation/zenworks.html)

Identity Manager Identity Management online documentation 
(http://www.novell.com/documentation/
secure_identity_management.html)
SP1: Linux Installation Guide

http://www.novell.com/documentation/groupwise.html
http://www.novell.com/documentation/zenworks.html
http://www.novell.com/documentation/secure_identity_management.html


novdocx (en)  11 July 2008
SLES 9 services not included in SLES 10: If you installed open source products that were 
included with the SLES 9 distribution, it is possible although unlikely that they have been 
removed in SLES 10.
Third-party products: If you have installed third-party products, be sure to check that it is 
supported on SLES 10 and follow the upgrade instructions that should be included with it.

To manually retain packages, you must follow the steps outlined in Section 5.4.6, “Reviewing the 
Delete Unmaintained Packages Notification,” on page 106.

IMPORTANT: There is no guarantee that packages you have manually retained will run on the 
SLES 10 kernel. For specific compatibility information, see the documentation for the impacted 
product.

OES 2: Non-OES 2 Packages Are Retained but Might Not Work After Upgrading:

During the upgrade process from OES 2 to OES 2 SP1, packages that are not part of the SLES 10 
SP2 and OES 2 SP1 distributions are automatically retained unless you select them for deletion.

This includes third-party products you have installed as well as other Novell products, such as  
GroupWise®, ZENworks®, and Identity Manager.

There is no guarantee that these products will continue to work after you upgrade. Therefore, it is 
critical that you check the product documentation for compatibility information before you upgrade 
servers with any Novell product installed.

If you have installed a third-party product, be sure to check that it is supported on SLES 10 SP2 and 
follow the upgrade instructions that should be included with it.

All other All Novell online documentation (http://
www.novell.com/documentation/)

For Information About This Novell Product See This Documentation

GroupWise GroupWise 7 online documentation (http://
www.novell.com/documentation/groupwise.html)

ZENworks ZENworks online documentation (http://
www.novell.com/documentation/zenworks.html)

Identity Manager Identity Management online documentation (http://
www.novell.com/documentation/
secure_identity_management.html)

All other All Novell online documentation (http://
www.novell.com/documentation/)

For Information About This Novell Product See This Documentation
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5.3  Meeting the Upgrade Requirements 
Meet the following OES Linux requirements before you upgrade and install any OES Linux 
components:

Section 5.3.1, “Secure the Current Data,” on page 96
Section 5.3.2, “Storage Space on the Root Partition,” on page 96
Section 5.3.3, “SLES 10 SP2,” on page 97
Section 5.3.4, “OES 1 SP2,” on page 97
Section 5.3.5, “OES 2,” on page 97
Section 5.3.6, “IP Address,” on page 97
Section 5.3.7, “DNS,” on page 97
Section 5.3.8, “Common Server Certificate,” on page 98
Section 5.3.9, “Installation Source,” on page 98

5.3.1  Secure the Current Data
Before upgrading, secure the current data on the server. For example, make a backup copy of the 
data, so you can restore the data volumes later from a backup copy if needed.

Save your configuration files. Copy all configuration files to a separate medium, such as a streamer, 
removable hard disk, USB stick, or ZIP drive, to secure the data. This primarily applies to files 
stored in /etc as well as some of the directories and files in /var and /opt. You might also want 
to write the user data in /home (the HOME directories) to a backup medium. Back up this data as 
root. Only root has read permission for all local files.

5.3.2  Storage Space on the Root Partition
Before starting your upgrade, make note of the root partition and space available.

If you suspect you are running short of disk space, secure your data before updating, and repartition 
your system. There is no general rule of thumb regarding how much space each partition should 
have. Space requirements depend on your particular partitioning profile and the software selected.

WARNING: If your root partition resides in an EVMS container, you might not be able to 
repartition or expand the size of the root partition without destroying data elsewhere on the device.

The df -h command lists the device name of the root partition. In the following example, the root 
partition to write down is /dev/hda3 (mounted as /).

Example: List with df -h.
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5.3.3  SLES 10 SP2
Ensure that the products and services you have running on the server can run on the new SLES 
10 SP2 kernel.
Make sure the server meets the hardware requirements for SLES 10 SP2. See “System 
Requirements for Operating Linux” in the Architecture-Specific Information Guide (http://
www.novell.com/documentation/sles10/sles_x86/data/cha_sysreqs.html).
Itanium is not a supported platform for OES 2 SP1 Linux.

5.3.4  OES 1 SP2
Patch the OES 1 server to the latest patch level and ensure that the server and services are still 
running as desired. For procedures, see “Patching an OES Linux Server” in the OES 1 Linux 
Installation Guide. (http://www.novell.com/documentation/oes/install_linux/data/
bxlu3xc.html#bxlu3xc)

To determine the OES 1 server version:

1 At the terminal console command prompt, enter

cat /etc/novell-release

5.3.5  OES 2
Run YaST > Software > Online Update to patch the OES 2 server to the latest patch level. Then 
ensure that the server and services are still running as desired. 

5.3.6  IP Address
Make sure the server has a static IP address.

5.3.7  DNS
Make sure DNS returns the server's DNS name when presented with the server's IP address. You can 
use the host to validate this item.

File System Size Used Avail Use% Mounted on

/dev/hda3 74G 22 G 53 G 29%

/tmpfs 506M       0 506M 0% /dev/shm

/dev/hda5 116G 5.8G 111G 5% /home

/dev/hda1 39G 1.6G 37G 4% /window/C

/dev/hda2 4.6G 2.6G 2.1G /window/D
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5.3.8  Common Server Certificate
Make sure the server has a server certificate that has been generated and exported as a Common 
Server certificate.

To check for or add a certificate, do the following:

1 Launch YaST.
2 Click Security and Users > CA Management.
3 If no certificate authorities (CAs) are listed, create one by clicking Create Root CA.

If a CA is listed, you can use it by selecting the CA and clicking Enter CA.
4 If you are using a listed CA, you must provide the CA password (generally the root password).
5 Click Certificates > Add.
6 Fill out the forms required for a server certificate. After the last form is complete, a server 

certificate is created and listed in the certificate list.
7 Select the certificate you just created.
8 Click the Export button, then select Export as Common Server Certificate.

5.3.9  Installation Source
Review and complete the instructions for “Setting Up an Installation Source” on page 29. We 
recommend using the network installation option, especially if you are upgrading multiple servers.

5.4  Upgrading the Server
Use the following instructions to complete the upgrade applicable to the installation source you are 
using:

Section 5.4.1, “For Servers with EVMS and NSS on the System Device,” on page 98
Section 5.4.2, “Starting the Upgrade,” on page 99
Section 5.4.3, “Selecting the Installation Mode Options,” on page 102
Section 5.4.4, “Specifying the Partition to Update,” on page 103
Section 5.4.5, “Specifying the Add-On Product Installation Information,” on page 105
Section 5.4.6, “Reviewing the Delete Unmaintained Packages Notification,” on page 106
Section 5.4.7, “Verifying and Customizing the Update Options in Installation Settings,” on 
page 106
Section 5.4.8, “Accepting the Installation Settings,” on page 110
Section 5.4.9, “Specifying Configuration Information,” on page 110

5.4.1  For Servers with EVMS and NSS on the System Device
If your server has EVMS and NSS on the system device (the device that contains the root, boot, and 
swap), you must prepare the server prior to upgrading or the upgrade will fail. Because completing 
the instructions in the following sections hides the server’s NSS partition, you should do so just prior 
to upgrading the server.
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Preparing an OES 1 SP2 Server

If you are upgrading a server that has EVMS as the volume manager for the system device (the 
device that contains the /boot, swap, and / (root) partitions), and might also have Novell Storage 
ServicesTM (NSS) pools and volumes on the system device, you need to enable boot.lvm and 
boot.md.

Do the following just before you begin the upgrade:

1 In YaST, click System > Runlevel Editor > Expert Mode.
2 Select boot.lvm.
3 Click Set/Reset > Enable the Service.
4 Select boot.md.
5 Click Set/Reset > Enable the Service.
6 Click Finish, then click Yes.

Preparing All OES Servers

Prior to starting the upgrade, be sure to complete the instructions in “EVMS-Managed System 
Devices Require Special Handling or the Upgrade Will Fail” in the OES2 SP1: Readme.

5.4.2  Starting the Upgrade
“Upgrade Using a Network Installation Source with DHCP” on page 99
“Upgrade Using a Network Installation Source without DHCP” on page 100
“Upgrade Using Physical Media or ISO” on page 102

Upgrade Using a Network Installation Source with DHCP

1 Ensure that the server meets the upgrade requirements. See “Meeting the Upgrade 
Requirements” on page 96.

2 Insert SUSE Linux Enterprise Server 10 SP2 CD 1 into the CD-ROM drive of the server you 
want to upgrade to OES 2 SP1 Linux, then reboot the server.

3 From the CD boot menu, select one of the following Installation options that matches your 
environment, but do not press Enter.

Installation: The normal installation mode. All modern hardware functions are enabled.
Installation—ACPI Disabled: If the normal installation fails, this might be because of 
the system hardware not supporting ACPI (advanced configuration and power interface). 
If this seems to be the case, use this option to install without ACPI support.
Installation—Local APIC Disabled: If the normal installation fails, this might be 
because of the system hardware not supporting local APIC (advanced programmable 
interrupt controllers). If this seems to be the case, use this option to install without local 
APIC support.
If you are not sure, try Installation—ACPI Disabled or Installation—Safe Settings first.
Installation—Safe Settings: Boots the system with the DMA mode (for CD-ROM 
drives) and power management functions disabled. Experts can also use the command line 
to enter or change kernel parameters.
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4 (Conditional) You can specify boot option parameters to specify all the parameters that the 
manual installation steps will step you through or you can continue with Step 5.
If you do specify boot options parameters, press Enter then continue with Step 10.
For more information on specifying boot option parameters, see “Using Custom Boot Options” 
in the SUSE Linux Enterprise Server Installation and Administration Guide (http://
www.novell.com/documentation/sles10/sles_admin/data/
sec_deployment_remoteinst_bootinst.html#sec_deployment_remoteinst_bootinst_custom).

5 Press F3, and then select the network installation type (NFS, FTP, HTTP) that you set up on 
your network installation server.
See Step 2 on page 30 of the Preparing a Network Installation Source procedure.

6 Specify the required information (server name and installation path), then select OK.
7 Press Enter to begin the upgrade.
8 Select a language, then click Accept.
9 On the License Agreement page, click Yes, I Agree to the License Agreement > Next.

10 Follow the prompts, using the information contained in the following sections:
10a “Selecting the Installation Mode Options” on page 102.
10b “Specifying the Partition to Update” on page 103.
10c “Specifying the Add-On Product Installation Information” on page 105.
10d “Verifying and Customizing the Update Options in Installation Settings” on page 106.
10e “Accepting the Installation Settings” on page 110.
10f “Specifying Configuration Information” on page 110.
10g “Finishing the Upgrade” on page 119.

11 Verify that the upgrade was successful. See the procedures in “Verifying That the Installation 
Was Successful” on page 60.

12 Complete the server setup by following the procedures in “Completing Installation or Upgrade 
Tasks on OES 2 SP1 Linux” on page 123.

Upgrade Using a Network Installation Source without DHCP

1 Ensure that the server meets the upgrade requirements. See “Meeting the Upgrade 
Requirements” on page 96.

2 Insert SUSE Linux Enterprise Server 10 SP2 CD 1 into the CD-ROM drive of the server you 
want to upgrade to OES 2 SP1 Linux, then reboot the machine.

3 From the CD boot menu, select one of the following Installation options that matches your 
environment, then press Enter.

Installation: The normal installation mode. All modern hardware functions are enabled.
Installation—ACPI Disabled: If the normal installation fails, this might be because of 
the system hardware not supporting ACPI (advanced configuration and power interface). 
If this seems to be the case, use this option to install without ACPI support.
Installation—Local APIC Disabled: If the normal installation fails, this might be 
because of the system hardware not supporting local APIC (advanced programmable 
interrupt controllers). If this seems to be the case, use this option to install without local 
APIC support.
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If you are not sure, try Installation—ACPI Disabled or Installation—Safe Settings first.
Installation—Safe Settings: Boots the system with the DMA mode (for CD-ROM 
drives) and power management functions disabled. Experts can also use the command line 
to enter or change kernel parameters.

You can specify boot option parameters to specify all the parameters that the manual 
installation steps will step you through or you can continue with Step 4.
If you do specify boot options parameters, press Enter then continue with Step 21 on page 101.
For more information on specifying boot option parameters, see “Using Custom Boot Options” 
in the SUSE Linux Enterprise Server Installation and Administration Guide (http://
www.novell.com/documentation/sles10/sles_admin/data/
sec_deployment_remoteinst_bootinst.html#sec_deployment_remoteinst_bootinst_custom).

4 When you receive the following error, select OK and press Enter: 
Could not find the SUSE Linux Enterprise Server 10 Installation 
source. Activating manual set up program.

5 Select the language, then select OK and press Enter.
6 Select a keyboard map, then select OK and press Enter.
7 Select Start Installation or System, then select OK and press Enter.
8 Select Start Installation or Update, then select OK and press Enter.
9 Select Network, press Enter, then select OK and press Enter.

10 Select the network protocol that matches the configured protocol on your network installation 
server, then press Enter.

11 (Conditional) If you have more than one network interface card, select one of the cards, then 
press Enter.
We recommend eth0.

12 When prompted whether you want to use DHCP, select No, then press Enter.
13 Specify the IP address, then press Enter.
14 Specify the subnet mask, then press Enter.
15 Specify the gateway, then press Enter.
16 Specify the IP address of a name server, then press Enter.
17 Specify the IP address of the network installation server, then press Enter.
18 (Conditional) Depending on the protocol you specified, you might see additional screens for 

FTP or HTTP. Select the options that are appropriate for your network, then continue with 
Step 19.

19 Specify the path to your installation source on the network installation server, then press Enter.
20 On the License Agreement page, click Yes, I Agree to the License Agreement > Next.
21 Follow the prompts, using the information contained in the following sections:

21a “Selecting the Installation Mode Options” on page 102.
21b “Specifying the Partition to Update” on page 103.
21c “Specifying the Add-On Product Installation Information” on page 105.
21d “Verifying and Customizing the Update Options in Installation Settings” on page 106.
21e “Accepting the Installation Settings” on page 110.
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21f “Specifying Configuration Information” on page 110.
21g “Finishing the Upgrade” on page 119.

22 Verify that the upgrade was successful. See the procedures in “Verifying That the Installation 
Was Successful” on page 60.

23 Complete the server setup by following the procedures in “Completing Installation or Upgrade 
Tasks on OES 2 SP1 Linux” on page 123.

Upgrade Using Physical Media or ISO

1 Ensure that the server meets the upgrade requirements. See “Meeting the Upgrade 
Requirements” on page 96.

2 Insert the SUSE Linux Enterprise Server 10 SP2 CD 1 or SUSE Linux Enterprise Server 10 SP2 
DVD 1 into the CD-ROM or DVD drive of the server you want to upgrade to OES 2 SP1 
Linux, then reboot the machine.

3 From the CD boot menu, select the Installation option that best fits your environment, then 
press Enter.

4 Select the language that you want to use.
5 On the License Agreement page, click Yes, I Agree to the License Agreement > Next.
6 Follow the prompts, using the information contained in the following sections:

6a “Selecting the Installation Mode Options” on page 102.
6b “Specifying the Partition to Update” on page 103.
6c “Specifying the Add-On Product Installation Information” on page 105.
6d “Verifying and Customizing the Update Options in Installation Settings” on page 106.
6e “Accepting the Installation Settings” on page 110.
6f “Specifying Configuration Information” on page 110.

6g “Finishing the Upgrade” on page 119.
7 Verify that the upgrade was successful. See the procedures in “Verifying That the Installation 

Was Successful” on page 60.
8 Complete the server setup by following the procedures in “Completing Installation or Upgrade 

Tasks on OES 2 SP1 Linux” on page 123.

5.4.3  Selecting the Installation Mode Options
1 When the Installation Mode screen displays, select the following menu options:

1. Update
2. Include Add-On Products from Separate Media

IMPORTANT: To upgrade previously installed OES services and install any additional 
OES services, you must select the Include Add-On Products from Separate Media option. 
If you don’t, the server is only updated from SLES 9 to SLES 10 and none of the OES 
services are upgraded.
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2 Click Next.
3 Continue with “Specifying the Partition to Update” on page 103 or “Specifying the Add-On 

Product Installation Information” on page 105, depending on which matches your installation.

5.4.4  Specifying the Partition to Update
YaST tries to determine which is the correct root (/) partition. If there are several possibilities, or if 
YaST can’t definitely determine the correct root partition, the Select for Update page displays. 

NOTE: If no partitions are listed, you are attempting to upgrade an i386 installation using x86_64 
media. Mixing architectures in an upgrade is not permitted. See Section 5.1.2, “Supported Upgrade 
Paths,” on page 93.

1 If there is only one partition listed, click Next.
2 If there are several partitions, select the partition with /evms in the path. 

For example, make sure you select the /dev/evms/lvm/... partition rather than the /dev/
lvm/... partition. 
then click Next. YaST reads the old fstab on this partition to analyze and mount the file systems 
listed there.
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3 Next, YaST tries to mount the boot (/boot) partition. 
If no error displays, skip to “Specifying the Add-On Product Installation Information” on 
page 105. 

4 If you have EVMS on your system disk, you might get an error stating that the partition could 
not be mounted:

If this error displays, click Specify Mount Options. 
The Mount Options dialog appears.
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5 Remove /evms from the Device path.

6 Click OK.
7 Continue with “Specifying the Add-On Product Installation Information” on page 105.

5.4.5  Specifying the Add-On Product Installation Information
1 When the Add-On Product Installation page displays, click Add.
2 In the Add-On Product Media dialog, if you are installing from physical media, click CD > 

Next.
2a In the Insert the Add-On Product CD dialog, select the appropriate drive where you want 

to insert the CD labeled Open Enterprise Server 2 SP1 CD 1 if there is more than one 
drive, then click Eject.

2b Insert the CD labeled Open Enterprise Server 2 SP1 CD 1, then click Continue.
3 If you are using an alternate installation source, such as a network location, click the 

appropriate option, such as the network protocol that matches your installation source, then 
click Next and specify the information for the source you have specified.

4 Read and accept the Novell Open Enterprise Server 2 license agreement, then click Next.
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5 Confirm that the Add-On Product Installation page shows the correct path to the OES media, 
then click Next.

6 Continue with “Verifying and Customizing the Update Options in Installation Settings” on 
page 106.

5.4.6  Reviewing the Delete Unmaintained Packages 
Notification
After the OES 2 SP1 installation source has been added, if you are upgrading from OES 1 SP2, the 
following notification is displayed:

1 Carefully read the notification.
2 Decide how you want to proceed. For more information, see Section , “OES 1: Non-OES 2 

Packages Are Deleted by Default:,” on page 94.
3 Click OK, then continue with Verifying and Customizing the Update Options in Installation 

Settings.

5.4.7  Verifying and Customizing the Update Options in 
Installation Settings

IMPORTANT: To verify that previously installed services are selected for installation and to install 
any additional OES services during the upgrade, you must customize the Update Options on the 
Installation Settings dialog.

To verify or customize the software packages that are installed on the server:

1 On the Installation Settings dialog, make sure Novell Open Enterprise Server 2 is listed under 
the Add-On Products link. If it is, proceed with Step 2.
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If it is not, click the Add-On Products link and follow the steps in “Specifying the Add-On 
Product Installation Information” on page 105. When the Installation Setting dialog shows 
Novell Open Enterprise Server 2 as an installation setting, proceed with Step 2.

2 If you see package conflict errors (red text under the Packages link), refer to the OES2 SP1: 
Readme for resolution instructions.

3 On the Installation Settings dialog, click Update Options.
4 In the Update Options dialog, click Select Patterns.
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5 All of the OES Services patterns that were previously installed are selected by default.
Ensure that the patterns for the services you are upgrading are selected, and select the patterns 
for any new OES Services patterns that you might want to also install, such as Novell AFP or 
Novell CIFS.
A description of each pattern displays to the left of the pattern when it is selected. For a 
description of OES Services patterns and the components selected with each pattern, see Table 
2-4 on page 21.

IMPORTANT: If you deselect a pattern after selecting it, you are instructing the installation 
program to not install that pattern and all of it dependent patterns. Rather than deselecting a 
pattern, click Cancel to cancel your software selections, then click the Select Patterns heading 
again to choose your selections again.
Selecting only the patterns that you want to install ensures that the patterns and their dependent 
patterns and packages are installed.
If you click Accept, then return to software pattern selection page, the selections that you made 
become your base selections and must be deselected if you want to remove them from the 
installation proposal.

Selecting a pattern automatically selects the other patterns that it depends on to complete the 
installation.
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6 If you want to see the details of your selections, click Details. 
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7 When you have the software components selected that you want to install, click Accept.
8 (Conditional) If the prompt for the AGFA Fonts license displays, read the agreement, then click 

Accept.
9 (Conditional) If the prompt for Automatic Changes displays, click Continue.

10 (Conditional) If prompted, resolve any dependency conflicts.
11 If the Update Options dialog displays again, click Accept.
12 Continue with “Accepting the Installation Settings” on page 110.

5.4.8  Accepting the Installation Settings
1 Review the final Installation Summary page to ensure that you have all the Installation settings 

you desire. Make sure that it shows all the OES Services that you want to update and install.
2 After you have changed all the Installation Settings as desired, click Accept. 
3 In the Confirm Update dialog, click Start Update.

The base installation settings are applied and the packages are installed.
4 While the server is updating the files, do one of the following:

For installations using a network installation source, remove the boot CD 
(SUSE Linux Enterprise Server 10 SP2 CD 1) from the CD drive. 
For installations using a CD or DVD installation source, leave the CD or DVD in the CD-
ROM or DVD drive. When the installation process prompts you for each CD at the 
appropriate time, insert the CD. The progress status at the bottom of the screen indicates 
which CD will be prompted for next.

5 After the server reboots, continue with “Specifying Configuration Information” on page 42.

5.4.9  Specifying Configuration Information
When the server reboots, you are required to complete the following configuration information:

“Testing the Connection to the Internet” on page 111
“Specifying Novell Customer Center Configuration Settings” on page 111
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“Updating the Server Software During the Upgrade” on page 114
“Upgrading eDirectory” on page 116
“Specifying LDAP Configuration Settings” on page 117
“Configuring Novell Open Enterprise Server Services” on page 118

Testing the Connection to the Internet

On the Test Internet Connection page:

1 Select Yes, Test Connection to the Internet, then click Next.
Obtaining the latest SUSE release notes might fail at this point. If it does, view the log to verify 
that the network configuration is correct, then, click Next.
If the network configuration is not correct, click Back > Back and fix your network 
configuration. See “Network Interface” on page 43.

2 Or, you can skip this test by clicking No, Skip This Test; however, most OES services 
configuration require a connection to the Internet.
Skipping this test also skips downloading release notes, configuring the Novell Customer 
Center, and updating online.

3 Continue with “Specifying Novell Customer Center Configuration Settings” on page 111. If 
you skip this test, continue with “Upgrading eDirectory” on page 116.

Specifying Novell Customer Center Configuration Settings

To receive support and updates for your OES 2 SP1 server, you need to register it in the Novell 
Customer Center (NCC). When the Novell Customer Center Configuration page is displayed, you 
have three options:

“Updating a Registered Server” on page 111
“Registering the Server Later / Skipping a Registered Server Update” on page 111
“Registering the Server During the Upgrade” on page 112

Updating a Registered Server

1 If you have already registered your OES 2 server and you want to download the available 
patches, which is recommended, leave Configure Now selected and click Next. 
YaST contacts the server (which might take a few minutes) and then downloads the available 
patches. 

2 Go to Step 7 on page 113.

Registering the Server Later / Skipping a Registered Server Update

To register the server later or to skip the update process for a registered server:

1 Click Configure Later. 
2 Continue with “Upgrading eDirectory” on page 116.
3 Register the server after the installation is complete by using the procedures in Section 7.2, 

“Registering the Server in the Novell Customer Center,” on page 128.
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Registering the Server During the Upgrade

To register the server during the upgrade:

1 On the Novell Customer Center Configuration configuration page, select all of the following 
options, then click Next.

2 After you click Next, the following message is displayed. Wait until this message disappears 
and the Manual Interaction Required page displays.

3 On the Manual Interaction Required page, note the information that you will be required to 
specify, then click Continue.

4 On the Novell Customer Center Registration page, specify the required information in the 
following fields, then click Submit:

Option What it Does

Configure Now Proceeds with registering this server and the SLES 10 SP2 and OES 
product in the Novell Customer center.

Hardware Profile Sends the information to the Novell Customer Center about the hardware 
that you are installing SLES 10 SP1 and OES 2 on.

Optional Information Sends optional information to the Novell Customer Center for your 
registration. For this release, this option doesn’t send any additional 
information.

Registration Code Makes the registration with activation codes mandatory.

Regularly Synchronize 
with the Customer 
Center

Keeps the installation sources for this server valid. It does not remove any 
installation sources that were manually added.

Field Information to Specify

Email Address The e-mail address for your Novell Login account.

Confirm Email Address The same e-mail address for your Novell Login account

Activation Code for 
SLES Components 
(optional):

Specify your permanent registration code for the SLES SP1 product.

If you don’t enter the permanent registration code now, a temporary code 
and organization are made for this server and the SLES SP1 product. This 
let you have updates for 15 days, until you register this system in the NCC 
with the permanent activation code.

Activation Code for 
OES Components 
(optional):

Specify your permanent registration code for the OES product.

If you don’t enter the permanent registration code now, a temporary code 
and organization are made for this server and the OES 2 SP1 product. 
This lets you have updates for 15 days, until you register this system with 
the permanent activation code.
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5 When the message to complete the registration displays, click Continue.

6 After you click Continue, the following message is displayed with the Manual Interaction 
Required screen. Wait until this message disappears and Novell Customer Center 
Configuration page displays with the message that Your configuration was 
successful.

7 When you see the message Your configuration was successful on the Novell 
Customer Center Configuration, click OK.

System Name or 
Description (optional):

The hostname for the system is specified by default. If you want to change 
this to a description, for the Novell Customer Center, specify a description 
to identify this server.

Field Information to Specify
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8 Continue with “Updating the Server Software During the Installation” on page 47.

Updating the Server Software During the Upgrade

If you have a successful connection to the Internet and have registered the server in the Novell 
Customer Center, the server displays the Online Update dialog. You can run the online update now 
or skip it and get updates later.

To skip getting updates during the upgrade

1 On the Online Update page, click Skip Update.
2 Continue with “Upgrading eDirectory” on page 116.

To get updates during the upgrade: 

1 On the Online Updates page, click Run Update.

2 On the page that shows that updates are available, select the updates that you want to install, 
then click Accept. The check marks that are shown on the summary portion of the page are 
patches that have already been installed on your system.
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3 When you see the message, Installation finished on the Patch Download and 
Installation page, click Next. 

4 If the update makes changes to YaST, the following message displays. Click OK to restart 
YaST.
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If the installation was interrupted, the following message might display. If so, click Yes to 
continue with the installation and enter the root password.

5 The online update displays again with additional updates. If a patch has changes to the kernel, 
you might want to deselect it and install it later after the installation is complete. For 
procedures, see “Updating an OES 2 SP1 Linux Server” on page 127.
If you do install patches that have changes to the kernel, click OK when you see the following 
message.

6 After all the patches are installed, continue with “Upgrading eDirectory” on page 116.

Upgrading eDirectory

OES 2 SP1 includes eDirectory 8.8.4. 

1 When the following dialog appears, click Upgrade.

2 On the eDirectory Upgrade - Existing Server Information page, type the Admin password and 
click Next.

3 On the Novell Modular Authentication Service page, click Next.
4 Continue with with  “Specifying LDAP Configuration Settings” on page 117.
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Specifying LDAP Configuration Settings

Many of the OES services require eDirectory. If eDirectory was not selected as a product to upgrade 
or install but other OES services that do require LDAP services were installed, the LDAP 
Configuration service displays expecting you to in complete the required information.

To specify the required information on the Configured LDAP Server page:

1 In the eDirectory Tree Name field, specify the name for the existing eDirectory tree that you are 
installing this server into.

2 In the Admin Name and Context field, specify the name and context for user Admin on the 
existing tree.

3 In the Admin Password Name field, specify a password for user for user Admin on the existing 
tree.

4 Add the LDAP servers that you want the services on this server to use. The servers that you add 
should hold the master or a read/write replica of eDirectory. Do the following for each server 
you want to add.
4a Click Add.
4b On the next dialog, specify the following information for the server to add, then click Add.

IP Address
LDAP port and secure LDAP port
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5 When all the LDAP servers that you want to specify are listed, click Next.
6 Continue with “Configuring Novell Open Enterprise Server Services” on page 118.

Configuring Novell Open Enterprise Server Services

1 After you complete the LDAP configuration or eDirectory configuration, the Novell Open 
Enterprise Server Configuration summary page is displayed, showing all the OES components 
you updated and installed and their configuration settings. Review the setting for each 
component and click the component heading to change any settings.

When specifying the configuration information for OES services, see the information in 
“Guidelines for Configuring OES 2 SP1 Linux Components” on page 61.

2 When you are satisfied with the settings for each component, click Next.
3 When confirming the OES component configurations, you might receive the following error:
The proposal contains an error that must be resolved before 
continuing.

If this error is displayed, check the summary list of configured products for a message 
immediately below each product heading that indicates the product or service needs to be 
configured. If you are running the YaST graphical interface, the text appears red. If you are 
installing using the YaST text-base interface, it is not red.
For example, if you have selected Linux User Management in connection with other OES 
products or services, you might see a message similar to the following:
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Linux User Management needs to be configured before you can 
continue or disable the configuration.
If you see a message like this, do the following:
3a On the summary page, click the heading for the component.
3b Supply the missing information in each configuration page.

When specifying the configuration information for OES services during the upgrade, see 
the information in “Guidelines for Configuring OES 2 SP1 Linux Components” on 
page 61.
When you have finished the configuration of that component, you are returned to the 
Novell Open Enterprise Server Configuration summary page.

3c If you want to skip the configuration of a specific component and configure it later, click 
Enabled in the Configuration is enabled status to change the status to Configuration is 
disabled. 
If you change the status to Configuration is disabled, you must configure the OES 
components after the installation is complete. See “Installing or Configuring OES 2 
Services on an Existing OES 2 SP1 Linux or SLES 10 SP2 Server” on page 89.

4 After resolving all product configuration problems, click Next to proceed with the 
configuration of all services and installation of iManager Plug-ins.

5 When the Readme page displays, click Next and continue with Section 5.5, “Finishing the 
Upgrade,” on page 119.

5.5  Finishing the Upgrade
After a successful configuration, YaST shows the Installation Completed dialog. In this dialog, do 
the following:

1 Deselect Clone This System for AutoYaST. Cloning is selected by default.
This will increase the speed of finishing the installation update. 
AutoYaST is a system for automatically installing one or more SUSE Linux Enterprise systems 
without user intervention. Although you can create a profile from a system that has been 
upgraded, it will not work to upgrade a similar system.

IMPORTANT: If you did not deselect this option and haven’t updated the server during the 
upgrade, see “Password for User Admin Written in Clear Text in y2log” on page 167.

2 Finish the upgrade by clicking Finish in the Installation Completed dialog.
3 If you have upgraded a server that has NSS pools and volumes on the system device (the device 

that contains the root, boot, and swap), you must do the following:
3a Verify that the /etc/fstab file is correct. For example, make sure that the path to /

boot is complete—/dev/evms/sda1 (or hda1) and not just /dev/evms. If the 
path to the /boot partition is incomplete or doesn’t contain /evms, change it and save 
the fstab file.

3b Open a terminal and run the following command to ensure that the initrd file is 
correctly created:
mkinitrd -f evms
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3c Return to “EVMS-Managed System Devices Require Special Handling or the Upgrade 
Will Fail” in the OES2 SP1: Readme and follow the instructions there to unhide your NSS 
partitions.

3d Reboot the server before continuing with “Verifying That the Upgrade Was Successful” on 
page 120.
A script runs automatically during the OES 2 SP1 Linux upgrade to install and enable 
boot.evms.
These changes are applied when you reboot your system after the upgrade is completed. 
Make sure that you reboot after the upgrade and before you do anything that would alter 
the changes made in this step.

4 After the server completes the upgrade, continue with “Verifying That the Upgrade Was 
Successful” on page 120. 

5.6  Verifying That the Upgrade Was Successful
One way to verify that your OES Linux server upgrade was successful and that the components are 
loading properly is to watch the server boots. As each component is loaded, the boot logger provides 
a status next to it indicating if the component is loading properly. 

You can also quickly verify a successful installation by accessing the server from your Web browser.

1 In the Address field of your Web browser, enter the following URLs:
http://IP_or_DNS
where IP_or_DNS is the IP address or DNS name of your OES Linux server.
You should see a Web page displayed similar to the following:
SP1: Linux Installation Guide



novdocx (en)  11 July 2008
2 (Optionally) If you want to look at the eDirectory tree and begin to see how iManager works, 
go to on the OES Information and Management Web page, click Management Tools > 
iManager, then log in as user Admin (the user you created during product installation).
You can also access iManager by typing the following URL in a browser window and logging 
in as user Admin:
http://IP_or_DNS_name/nps/iManager.html

3 Continue with “What's Next” on page 121.

5.7  What's Next
After you've completed the upgrade and verified that it was successful, see “Completing Installation 
or Upgrade Tasks on OES 2 SP1 Linux” on page 123 and “Updating an OES 2 SP1 Linux Server” 
on page 127.
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6Completing Installation or 
Upgrade Tasks on OES 2 SP1 
Linux

This section provides information for completing the following tasks:

Section 6.1, “Determining Which Services Need Additional Configuration,” on page 123
Section 6.2, “Completing Additional Tasks for Networks or Servers Running NSS on OES 
Linux Servers,” on page 125
Section 6.3, “Resolving the Certificate Store Error,” on page 125
Section 6.4, “Restarting Tomcat,” on page 126
Section 6.5, “Launching and Configuring Firefox,” on page 126

6.1  Determining Which Services Need Additional 
Configuration
Depending on the products you have installed, there might be some tasks that you must complete 
before you can use individual service components.

For more information, see “Caveats for Implementing OES 2 Services” in the OES 2 SP1: Planning 
and Implementation Guide.

If a component requires additional configuration that is not part of the Novell® Open Enterprise 
Server (OES) 2 Linux installation, see the component's administration guide for more information. 
The following table include links to the Installation and Configuration information for most OES 2 
SP1 services.

Table 6-1   OES 2 SP1 Services Additional Installation and Configuration Instructions

OES 2 SP1 Service For Additional Installation and Configuration 
Information

Domain Services for Windows See “Installing and Configuring Domain Services 
for WindowsInstalling and Setting Up AFP” in the 
OES 2 SP1: Domain Services for Windows 
Administration Guide OES 2 SP1: Novell AFP For 
Linux Administration Guide.

Novell AFP See “Installing and Setting Up AFP” in the  OES 2 
SP1: Novell AFP For Linux Administration Guide.

Novell Archive and Version Services See “Setting Up Archive and Version Services ” in 
the OES 2 SP1: Novell Archive and Version 
Services 2.1 for Linux Administration Guide.

Novell Backup/Storage Management Services 
(SMS)

See “Installing and Configuring SMS” in the 
Installing and Configuring SMS.
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Novell CIFS See “Installing and Setting Up AFPInstalling a CIFS 
Server on OES 2 SP1 Linux” in the OES 2 SP1: 
Novell CIFS for Linux Administration Guide.

Novell Cluster ServicesTM See “Installing Novell Cluster Services on OES 2 
Linux” in the OES 2 SP1: Novell Cluster Services 
1.8.5 for Linux Administration Guide.

Novell DHCP See “Installing and Configuring DHCP ” in the OES 
2 SP1: Novell DNS/DHCP Administration Guide for 
Linux.

Novell DNS See  “Installing and Configuring DNS ” in the OES 2 
SP1: Novell DNS/DHCP Administration Guide for 
Linux.

Novell eDirectoryTM 8.8 See “Installing or Upgrading Novell eDirectory on 
Linux” in the Novell eDirectory 8.8 Installation 
Guide.

Novell iFolder® 3.7 When you configure iFolder as part of the OES 
install and configuration, you can specify only an 
EXT3 or ReiserFS volume location for the System 
Store Path, which is where you are storing iFolder 
data for all your users. You cannot create NSS 
volumes during the system install.

If you want to use an NSS volume to store iFolder 
data, you must reconfigure iFolder after the initial 
OES installation. To reconfigure, use Novell 
iManager to create an NSS volume, then go to 
YaST > Open Enterprise Server > Install and 
Configure Open Enterprise Services and select 
iFolder 3.6 to enter new information. All previous 
configuration information is removed and replaced. 

See “Installing and Configuring iFolder Services” in 
the OES 2 SP1: Novell iFolder 3.7 Administration 
Guide.

Novell iManager 2.7.2 See “Installing iManager” in the Novell iManager 
2.7 Installation Guide.

Novell iPrint See “Installing and Setting Up iPrint on Your 
Server” in the OES 2: iPrint for Linux Administration 
Guide.

Novell Linux User Management See “Setting Up Linux User Management” in the 
OES 2 SP1: Novell Linux User Management 
Technology Guide.

Novell NCPTM Server See “Installing and Configuring NCP Server for 
Linux” in the OES 2 SP1: NCP Server for Linux 
Administration Guide.

Novell NetStorage See “Installing NetStorage” in the OES 2 SP1: 
NetStorage for Linux Administration Guide.

OES 2 SP1 Service For Additional Installation and Configuration 
Information
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.

6.2  Completing Additional Tasks for Networks or 
Servers Running NSS on OES Linux Servers
If you use Novell Storage ServicesTM (NSS) on Open Enterprise Server servers in your network or 
have just installed it on a server, complete the following procedures as applicable.

Section 6.2.1, “Checking for an nssid.sh File,” on page 125
Section 6.2.2, “Rebooting Server after Installing NSS,” on page 125

6.2.1  Checking for an nssid.sh File
If you use Novell Storage Services (NSS) on OES Linux, after installing the first OES Linux server 
in a tree, you should check every subsequent server to see whether the /opt/novell/
oes_install/nssid.sh file exists.

If this script file exists, you must run it on the server to synchronize the file ownership information 
for specific system users. For more information, see “Always Check for an nssid.sh File” in the OES 
2 SP1: Planning and Implementation Guide.

6.2.2  Rebooting Server after Installing NSS
If you install NSS on an existing OES Linux server, enter rcnovell-smdrd restart at the 
command prompt or reboot the server before performing any backups, restores, or server 
consolidations on the NSS file system.

6.3  Resolving the Certificate Store Error
After installing OES, you might receive the following error:

Novell QuickFinderTM See “Installing QuickFinder Server” in the OES 2: 
Novell QuickFinder Server 5.0 Administration 
Guide.

Novell Remote Manager See “Changing the Configuration” in the OES 2 
SP1: Novell Remote Manager for Linux 
Administration Guide.

Novell Samba See “Installing the Novell Samba Components” in 
the OES2 SP1: Samba Administration Guide.

Novell Storage ServicesTM See “Installing and Configuring Novell Storage 
Services” in the OES 2 SP1: NSS File System 
Administration Guide.

Pre-Migration Server See “Preparing for Transfer ID” in the OES 2 SP1: 
Migration Tool Administration Guide.

OES 2 SP1 Service For Additional Installation and Configuration 
Information
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Warning - Unable to change the group owner of the certificate store 
to www

To resolve this error, run the chgrp command on the /opt/novell/lib/java2/jre/lib/
security/cacerts certificate file using the following command in a command shell:

chgrp www /opt/novell/lib/java2/jre/lib/security/cacerts

6.4  Restarting Tomcat
If you install iManager after the server has been installed, Tomcat is not running and you must 
restart it to run iManager.

To restart Tomcat, enter the following command at a commandline prompt.

./etc/init.d/tomcat5 restart

6.5  Launching and Configuring Firefox
After upgrading from OES 2 to OES 2 SP1, you need to launch and configure Mozilla* Firefox* 
before accessing other applications via a URL.

For example, you cannot configure the Novell Customer Center from the YaST until Firefox is 
configured.

To configure Firefox, 

1 On the GNOME desktop, click Computer > Firefox.
or
On the KDE desktop, click the Main Menu icon > Browse > Web Browser > Firefox.

2 Configure the browser.
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7Updating an OES 2 SP1 Linux 
Server

Updating an Novell® Open Enterprise Server (OES) 2 Linux server is essentially the same as 
updating a SUSE® Linux Enterprise Server (SLES) 10 SP2 server except that you apply patches for 
both SLES 10 and OES 2 SP1 Linux.

To update your server with the patches released from Novell requires you to perform the following 
tasks during the installation or upgrade or after the installation or upgrade is complete. The 
instructions in this section are for patching the server after the installation or upgrade is complete.

Section 7.1, “Preparing the Server for Updating,” on page 127
Section 7.2, “Registering the Server in the Novell Customer Center,” on page 128
Section 7.3, “Updating the Server,” on page 132

The following sections contain more information about patching:

Section 7.1, “Preparing the Server for Updating,” on page 127
Section 7.2, “Registering the Server in the Novell Customer Center,” on page 128
Section 7.3, “Updating the Server,” on page 132
Section 7.4, “Frequently Asked Questions about Updating,” on page 139
Section 7.5, “For More Information About Updating,” on page 140
Section 7.6, “Updating the Server Quick Path,” on page 141

7.1  Preparing the Server for Updating
1 Make sure you have installed all the services that you need on the server.
2 Before starting your update, make note of the root partition and available space.

If you suspect you are running short of disk space, secure your data before updating and 
repartition your system. There is no general rule of thumb regarding how much space each 
partition should have. Space requirements depend on your particular partitioning profile and 
the software selected.
The df -h command lists the device name of the root partition. In the following example, the 
root partition to write down is /dev/hda2 (mounted as /).
Example: List with df -h.

In particular, ensure that you have enough space where the update process downloads all the 
updates to in /var/cache/zmd/.
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Depending on the number of patches that you are going to apply, you might need about 3 GB 
for OES 2 SP1.

3 Before updating the server, secure the current data on the server.
Copy all configuration files to a separate medium, such as a streamer, removable hard disk, 
USB stick, or ZIP drive, to secure the data. This primarily applies to files stored in /etc as 
well as some of the directories and files in /var and /opt. You might also want to write the 
user data in /home (the HOME directories) to a backup medium. Back up this data as root. 
Only root has read permission for all local files.

7.2  Registering the Server in the Novell 
Customer Center
Before you can patch an OES 2 SP1 Linux server with updates from Novell, you need to register the 
server if you didn’t do so during the installation. You need to register each server with the Novell 
Customer Center only once. After you have registered the server, you can update the server any time 
it is needed. You can use the desktop interface (GUI) or command line commands to accomplish this 
task.

This section contains the following information:

Section 7.2.1, “Prerequisites,” on page 128
Section 7.2.2, “Registering the Server in the Novell Customer Center (Command Line),” on 
page 129
Section 7.2.3, “Registering the Server in the Novell Customer Center (GUI),” on page 129

7.2.1  Prerequisites
To complete these procedures, you must have the following:

A Novell Customer Center (NCC) account or access to an account.

For more information about creating a Novell Customer Center account, see “Creating an 
Account” in the Novell Customer Center User Guide (http://www.novell.com/documentation/
ncc/ncc/data/b5exp8k.html#b5exj2f). (This is the same account that you use for Bugzilla.)
The activation codes for SLES and OES 2 SP1 that you received when you purchased your 
product.
An installation source that contains the update patches.
An installation source is automatically added to the server when you register with the Novell 
Customer Center or you can add a different source manually.
An established connection to the Internet. 
If the server doesn’t have a connection to the Internet, you can update the server by using 
support pack media (if available), or you can create a local server as your installation source. 
See “Deploying and Mirroring SUSE Linux Enterprise 10 Updates” (http://www.novell.com/
linux/technical_library/deploying_mirroring.pdf)
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7.2.2  Registering the Server in the Novell Customer Center 
(Command Line)

1 Log in to the server as root or su to root
2 At the command line, enter
suse_register -a email=email_address -a regcode-
sles=SLES_registration_code -a regcode-
oes=oes2_registration_code 
For example,
suse_register -a email=joe@example.com -a regcode-
sles=4adab769abc68 -a regcode-oes=30a74ebb94fa

3 Verify that the server is registered by seeing whether you have the service types and catalogs 
needed for updates.
3a To verify the service type, enter

rug sl

The results should be similar to the following:

The URIs you see for the ZYPP type will differ based on your installation source.
3b To verify the catalogs, enter

rug ca

The results should be similar to the following:

7.2.3  Registering the Server in the Novell Customer Center 
(GUI)
If the server is already registered in the Novell Customer Center, continue with “Updating the 
Server” on page 132.

1 In the YaST Control Center, click Software > Novell Customer Center Configuration.
2 On the Novell Customer Center Configuration configuration page, select all of the following 

options, then click Next.
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After you click Next, the following message is displayed. Wait until this message disappears 
and the Manual Interaction Required page displays.

3 On the Manual Interaction Required page, note the information that you will be required to 
specify, then click Continue.

4 On the Novell Customer Center Registration page, specify the required information in the 
following fields, then click Submit:

5 When the message to complete the registration displays, click Continue.

Option What it Does

Configure Now Proceeds with registering this server and the OES product with the Novell 
Customer Center.

Hardware Profile Sends the information to the Novell Customer Center about the hardware 
that you are installing SLES 10 SP1 and OES 2 on.

Optional Information Sends optional information to the Novell Customer Center for your 
registration. For this release, this option doesn’t send any additional 
information.

Registration Code Makes the registration with activation codes mandatory.

Regularly Synchronize 
with the Customer 
Center

Keeps the installation sources for this server valid. It does not remove any 
installation sources that were manually added.

Field Information to Specify

Email Address The e-mail address for your Novell Login account.

Confirm Email Address The same e-mail address for your Novell Login account

Activation Code for 
SLES Components 
(optional)

Specify your permanent registration code for the SLES SP1 product.

If you don’t enter the permanent registration code now, a temporary code 
and organization are made for this server and the SLES SP1 product. This 
lets you have updates for 15 days, until you register this system in the 
NCC with the permanent activation code.

Activation Code for 
OES Components 
(optional)

Specify your permanent registration code for the OES product.

If you don’t enter the permanent registration code now, a temporary code 
and organization are made for this server and the OES 2 SP1 product. 
This lets you have updates for 15 days, until you register this system with 
the permanent activation code.

System Name or 
Description (optional)

The hostname for the system is specified by default. If you want to change 
this to a description for the Novell Customer Center, specify a description 
to identify this server.
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After you click Continue, the following message is displayed with the Manual Interaction 
Required page. Wait until this message disappears and Novell Customer Center Configuration 
Was Successful page displays.

6 When you see the message that the Novell Customer Center was successful, click OK.

When the registration is successful, the server is registered in the Novell Customer Center and the 
installation sources for patches are configured on the server.
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7.3  Updating the Server
After the server has been registered in the Novell Customer Center, you can apply updates via 
packages and patches. The default GNOME desktop indicates when there are updates available to 
the server. You can update the server from any of the following interfaces.

Section 7.3.1, “Updating the Server by Using the Command Line,” on page 132
Section 7.3.2, “Updating the Server from the GNOME or KDE Desktop,” on page 138

7.3.1  Updating the Server by Using the Command Line
After you have registered the server in the Novell Customer Center, you can update the server by 
using commands at the command line. The following procedure specifies steps for updating the 
server with all available patches for SLES 10 SP2 and OES 2 SP1.

1 Log in to the server as root or su to root.
2 At the command line, enter the following commands:

2a Refresh all services:

2b See whether updates are available for SLES 10 SP2 and OES 2 SP1:

Command Example Results

rug ref
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2c Update the server with all available SLES10 SP2 and OES 2 SP1 patches:

2d Repeat Step 2b and Step 2c until no more updates are available.

Command Example Results

rug lu catolog1 
catalog2

For example,

rug lu SLES10-
SP2-Updates 
OES2-Updates

No updates are available:

Updates available:

Command Results

rug up -t patch 
SLES10-SP2-
Updates OES2 
Updates
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2e To finish the update, reboot the server.
Rebooting the server activates the new kernel if it has been updated and ensures that OES 
services that need restarting after patching are restarted.

You can also update your server with specific maintenance patches by using commands at the 
command line:

1 Log into the server as root or su to root.
2 At the command line, enter the following commands:

2a Refresh all services

2b See whether updates are available, see a list of patches and their status, or see information 
for a specific patch: 

Command Example Results

rug lu SLES10-
SP2-Updates 
OES-Updates

No updates are available in the specified catalogs:

Command Example Results

rug ref
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Command Results

See whether patches are available:

rug lu catalog1 catalog2

No updates are available in the specified catalogs.

Updates available:

See a list of patches from all catalogs 
and their status:

rug pch
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2c Update the server with specific patches:

See a list of all installed patches:

rug pch -i

Before patches are installed:

After two patches are installed:

After all patches have been installed:

See information for a specific patch:

rug patch-info patch_name

For example:

rug patch-info oes2-oes-
SPident

Command Results
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3 To finish the update, reboot the server.
Rebooting the server activates the new kernel if it has been updated and ensures that OES 
services that need restarting after patching are restarted.

The following table shows some additional commands you might want to use:

Table 7-1   Additional Rug Commands

Command Results

Install all patches from the one or more catalogs 
of a particular category.

rug up -t patch catalog1 catalog2 -g 
category_name

security

recommended

optional

For example:

rug up -t patch SLES10-SP2-Updates 
OES2-Updates -g security

Install one version of a patch without 
confirmation:

rug in -t patch -y patchname-version

For example:

rug in -t patch -y oes2-CASA-3904-0

Install all versions of a patch with confirmation:

rug in -t patch patch_name*

For example:

rug in -t patch oes2-oes-SPident*

Task Command

 Halts the ZLM daemon. Accepts the following option flags:

 -f, --force: Force the shutdown.

-n, --no-wait: Don’t wait for confirmation that the daemon was shut 
down.

rug shutdown [options]

Restarts the ZLM daemon. Accepts the following option flags:

 -f, --force: Forc

-n, --no-wait: Does not wait for confirmation that the daemon has 
restarted.

 --clean: Cleans up at restart

rug restart [options]
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7.3.2  Updating the Server from the GNOME or KDE Desktop
1 Log into the server as root or su to root.
2 Click the Novell Updater icon  that indicates that updates are available

On the GNOME Desktop, the icon is on the taskbar.
On the KDE Desktop, click G > System > Novell Updater icon 
If no updates are available, the Novell Updater icon  changes appearance to a globe.

3 On the Software Available for Updates page, select the updates that you want to install, then 
click Update. 
Updates that have a Security or Recommended status are usually preselected.

4 When the Software Updater Information status indicates that the update was successful, click 
Close.

Access help for all the rug commands rug

Access the rug man page man rug

Task Command
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5 If necessary, rerun the updater until all the desired patches have been installed.
6 To finish the update, reboot the server.

Rebooting the server activates the new kernel if it has been updated and ensures that OES 
services that need restarting after patching are restarted.

7.4  Frequently Asked Questions about Updating
This section contains the following information:

Section 7.4.1, “Do I apply all the patches in the catalogs or how do I know which patches to 
apply?,” on page 139
Section 7.4.2, “Can I Set Up a Local Server to Get Patches From?,” on page 140
Section 7.4.3, “How do I re-add the catalogs for OES 2 SP1 in my ZENworks Management 
Daemon (ZMD) configuration after removing one or more of them?,” on page 140

7.4.1  Do I apply all the patches in the catalogs or how do I 
know which patches to apply?
In OES 1, we recommended that all the patches in the channel be applied. However, in OES 2 SP1 
the dependency checking has been improved to help you understand more about each patch listed in 
the catalogs.

Each patch has a category and a status associated with it. The categories state whether the patch is a 
security patch, a recommended patch, or an optional patch. The rug pch command shows whether 
the patch is needed or not needed and whether it has been applied. When you are using the Novell 
Updater, only the patches that are needed and have not been applied display in the list of patches.

Therefore, you can just apply all the security patches and wait to apply other patches that might 
change how a feature or product works.
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7.4.2  Can I Set Up a Local Server to Get Patches From?
Yes. You can set up a server using the technology available from your SLES 10 base server, or you 
can set up a patching server by using ZENworks 7.2.

For specific procedures, see Table 7-2.

Table 7-2   More Information About Updating

7.4.3  How do I re-add the catalogs for OES 2 SP1 in my 
ZENworks Management Daemon (ZMD) configuration after 
removing one or more of them?
To re-add the catalogs and services need for updating OES 2 SP1 to the ZMD configuration:

1 Delete the /var/cache/SuseRegister/lastzmdconfig.cache file.
rm /var/cache/SuseRegister/lastzmdconfig.cache

2 At the command line, enter
suse_register -a email=email_address -a regcode-
sles=SLES_registration_code -a regcode-
oes=oes2_registration_code 
For example,
suse_register -a email=joe@example.com -a regcode-
sles=4adab769abc68 -a regcode-oes=30a74ebb94fa

Performing this procedure removes the complete ZMD configuration, then registers the server 
in the Novell Customer Center again. When you register the server in the Novell Customer 
Center again, it adds all the catalogs and services that are need for updating OES 2 SP1.

7.5  For More Information About Updating
Additional information about updating a server via patching is available in these document sources:

Task For More Information, See

Update from a local update mirror server at my site “Deploying and Mirroring SUSE Linux Enterprise 10 
Updates” (http://www.novell.com/linux/
technical_library/deploying_mirroring.pdf)

Update the server using ZENworks Linux 
Management 7.2

AppNote: “Advanced Patching of SUSE Linux 
Enterprise Server 10 with ZENworks Linux 
Management 7.2” (http://www.novell.com/
coolsolutions/appnote/19124.html)
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Table 7-3   More Information About Updating

7.6  Updating the Server Quick Path
This section contains the following Quick Path steps for patching an OES 2 SP1 Linux server:

“Command Line Quick Path for Updating OES 2 SP1 Linux” on page 141
“GUI Quick Path for Updating OES 2 SP1 Linux” on page 144

7.6.1  Command Line Quick Path for Updating OES 2 SP1 Linux 
1 Make sure you have the following:

A Novell Customer Center account (If you don’t have one, create it at http://
www.novell.com/register. This is the same account that you use for Bugzilla.)
Activation Code for SLES and OES 2 SP1
A valid installation source
An established connection to the Internet
Make sure you have installed all the services that you need on the server.
Before starting your update, make note of the root partition and available space.
In particular, ensure you have enough space where the update process downloads all the 
updates to in /var/cache/zmd/. Depending on the number of patches that you are 
going to apply, you might need about 3 GB.
Before updating the server, secure the current data on the server.

2 Register the server in the Novell Customer Center (one time only).
2a Log in to the server as root or su to root.
2b At the command line, enter

Task For More Information, See

Update software using the Novell ZENworks® Linux 
Management that is integrated in SLES 10.

“Managing Software with ZENworks” in the SUSE 
Linux Enterprise Server 10 Installation and 
Administration Guide (http://www.novell.com/
documentation/sles10/sles_admin/data/
cha_zmd.html)

Update from a local update mirror server at my site “Deploying and Mirroring SUSE Linux Enterprise 10 
Updates” (http://www.novell.com/linux/
technical_library/deploying_mirroring.pdf)

Update the server using ZENworks Linux 
Management 7.2

AppNote: “Advanced Patching of SUSE Linux 
Enterprise Server 10 with ZENworks Linux 
Management 7.2” (http://www.novell.com/
coolsolutions/appnote/19124.html)

Update the server from behind a proxy server TID 3132246: “Getting the SLES 10 / SLED 10 
Software Updater to work if you use a Proxy 
Server:” (https://secure-support.novell.com/
KanisaPlatform/Publishing/289/
3132246_f.SAL_Public.html)
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suse_register -a email=email_address -a regcode-
sles=SLES_registration_code -a regcode-
oes=oes2_registration_code 
For example,
suse_register -a email=joe@example.com -a regcode-
sles=4adab769abc68 -a regcode-oes=30a74ebb94fa

2c Verify that the server is registered by seeing whether you have the service types and 
catalogs needed for updates.
To verify the service types, enter
rug sl

To verify that you have the catalogs you need, enter
rug ca

3 Update the server with all available updates:
3a Refresh all services by entering:

rug ref

3b See whether updates are available by entering:
rug lu SLES10-SP2-Updates OES2-Updates

3c Update the server with all available SLES10-SP2 and OES 2 SP1 patches by entering:
rug up -t patch SLES10-SP2-Updates OES2-Updates

3d Repeat Step 3b and Step 3c until there are no more SLES10-SP2 or OES 2 SP1 patches.
When there are no more SLES10-SP2 patches, continue with Step 3e.

3e Reboot the server to finish the update.
Rebooting the server activates the new kernel and ensures that OES services that need 
restarting after patching are restarted.

You can also update your server with specific maintenance patches.

1 Log into the server as root or su to root.
2 At the command line, enter the following commands:

2a Refresh all services by entering:
rug ref

2b See whether updates are available by entering:
rug lu SLES10-SP2-Updates OES2-Updates

2c See a list of patches and their status by entering:
rug pch SLES10-SP2-Updates OES2-Updates

2d See information about a specific patch by entering:
rug patch-info patch_name

For example:
rug patch-info slesp1-xpdf

2e See a list of all installed patches:
rug pch -i
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2f Update the server with specific patches:
To install all patches from one or more catalogs of a particular category.
rug up -t patch catalog1 catalog2 -g category_name

Replace category name with: security, recommended, or optional.
For example, 
rug up -t patch SLES10-SP2-Updates OES2-Updates -g 
security 

To install one version of a patch without confirmation, enter:
rug in -t patch -y patch_name-version

For example:
rug in -t patch -y oes2-CASA-3904-0

To install all versions of a patch, enter:
rug in -t patch patch_name*

For example:
rug in -t patch oes2-oes-SPident*

2g Reboot the server to ensure that any changes to the kernel are activated, and applicable 
OES 2 services are restarted.

The following table shows some additional commands you might want to use:

Table 7-4   Additional Rug Commands

Task Command

 Halts the ZLM daemon. Accepts the following option flags:

 -f, --force: Force the shutdown.

-n, --no-wait: Don’t wait for confirmation that the daemon was shut 
down.

rug shutdown [options]

Restarts the ZLM daemon. Accepts the following option flags:

 -f, --force: Forces the shutdown.

-n, --no-wait: Does not wait for confirmation that the daemon has 
restarted.

 --clean: Cleans up at restart

rug restart [options]

Access help for all the rug commands rug

Access the rug man page man rug
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7.6.2  GUI Quick Path for Updating OES 2 SP1 Linux
To update your server with the patches released from Novell after the server has been installed and 
configured:

1 Make sure you have the following:
A Novell Customer Center account (If you don’t have one, create it at http://
www.novell.com/register. This is the same account that you use for Bugzilla.)
Activation Code for SLES and OES 2 SP1
A valid installation source
An established connection to the Internet
Make sure you have installed all the services that you need on the server.
Before starting your update, make note of the root partition and space available.
In particular, ensure you have enough space where the update process downloads all the 
updates to in /var/cache/zmd/. Depending on the amount of patches that you are going to 
upgrade, you might need about 3 GB.
Before updating the server, secure the current data on the server.

2 Register the server in the Novell Customer Center. 
If the server is already registered in the Novell Customer Center, skip to Step 3.
2a In the YaST Control Center, click Software > Novell Customer Center Configuration.
2b On the Novell Customer Center Configuration configuration page, select all of the 

following options, then click Next.
Configure Now
Hardware Profile
Optional Information
Registration Code
Regularly Synchronize with the Customer Center

After you click Next, a Contacting Server message is displayed. Wait until this message 
disappears and the Manual Interaction Required page displays.

2c On the Manual Interaction Required page, note the information that you will be required 
to specify, then click Continue.

2d On the Novell Customer Center Registration page, specify the required information in 
each field, then click Submit:

2e When the message to complete the registration displays, click Continue. After clicking 
Continue, the Contacting Server message is displayed with the Manual Interaction 
Required message. Wait until this message disappears and Novell Customer Center 
Configuration Was Successful page displays.

2f When you see the message that the Novell Customer Center was successful, click OK.
2g Confirm that you get the registration e-mails from the Novell Customer Center. You can 

perform Step 3 before you receive these e-mails.
3 Update the server from GNOME Desktop or KDE desktop:

3a Log into the server as root.
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3b Click the Novell Updater icon  that indicates that updates are available. If no updates are 
available, the Novell Updater icon  changes appearances to a globe.

3c On the Software Available for Updates patches, select the updates that you want to install, 
then click, Update.

3d When the Software Updater Information status indicates that the update was successful, 
click Close.

3e Repeat Step 3c and Step 3d until all available patches are applied.
3f Reboot the server to finish the update.

Rebooting the server activates the new kernel and ensures that OES services that need 
restarting after patching are restarted.
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8Using AutoYaST to Install and 
Configure Multiple OES 2 SP1 
Linux Servers

If you need to install OES Linux to multiple systems that perform similar tasks and that share the 
same environment and similar but not necessarily identical hardware, you might want to use 
AutoYaST to perform the installation. 

You use the Configuration Management tool (YaST > Miscellaneous > Autoinstallation) to generate 
an XML profile file (referred to as a control file) and use it to perform OES Linux installations to 
multiple servers that share the same hardware and environments. You can also tailor this control file 
for any specific environment. You then provide this control file to the YaST2 installation program.

This section does not provide complete AutoYaST instructions. It provides only the additional 
information you need when setting up AutoYaST to install multiple OES 2 SP1 Linux servers.

For complete instructions on using AutoYaST2, see Automatic Linux Installation and Configuration 
with Yast2 (http://forgeftp.novell.com/yast/doc/SLES10/autoinstall/index.html). You can also access 
the documentation locally on an OES server in /usr/share/doc/packages/autoyast2/
html/index.html or autoyast.pdf.

This section contains the following information:

Section 8.1, “Security Considerations,” on page 147
Section 8.2, “Prerequisites,” on page 147
Section 8.3, “Setting Up a Control File with OES Components,” on page 148
Section 8.4, “Setting Up an Installation Source,” on page 153

8.1  Security Considerations
The following issues exist when using or creating control files for use with AutoYaST.

Password for User Admin Written in Clear Text in y2log (page 167)
Password for User Admin Written in Clear Text in control.xml (page 167)

8.2  Prerequisites
You need at least the following components to install an OES 2 SP1 Linux server using AutoYaST:

A server with OES 2 SP1 Linux already installed
One or more target computers to install the server software to and the following information 
about each:

Number of hard disks
MAC address
Monitor types and graphics hardware
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A control file
For information on setting up a control file with OES components, see “Setting Up a Control 
File with OES Components” on page 148.
A boot scenario set up
You can boot from media or from an installation source. For more information, see “Setting Up 
an Installation Source” on page 153.
A source or server that contains the AutoYaST profile (control file) 
For more information, see “Setting Up an Installation Source” on page 153.

8.3  Setting Up a Control File with OES 
Components
The control file is an XML file that contains an installation profile for the target computer. This 
installation profile contains all the information to complete software installation and configuration 
on the target computer.

To create a control file:

You can create the control file manually in a text editor (not recommended).
When completing an installation, you can click Clone for AutoYaST. If you use this option, the 
resulting file is /root/autoinst.xml. This file must be edited manually before using it. 
See Section 8.3.1, “Fixing an Automatically Created Control File,” on page 148.
You can create or modify a control file by using the AutoInstallation module in YaST. For 
procedures, see Section 8.3.2, “Using the AutoInstallation Module to Create the Control File,” 
on page 149.
This system depends on existing modules that are usually used to configure a computer after 
OES 2 SP1 Linux is installed on a server.

8.3.1  Fixing an Automatically Created Control File
Review the following issues and solutions to fix the automatically created control file.

Issue 1:  If you install all OES Services using AutoYaST, Apache does not run.

Solution:  Reboot the server when the installation is complete; or when creating the profile or 
control file, deselect the Print Server pattern in the Primary Functions category. If you have 
already created the control file, remove the following section:

- <printer>
  <cups_installation config:type="symbol">server< cups_installation>
  <default />
  <printcap config:type="list" />
  <server_hostname />
  <spooler>cups</spooler>
  </printer>

Issue 2:  The Certificate Authorities section of the control file is not created. 
Solution:  You must insert the CA section manually. 
To add this information to the control file, do the following:
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1. Open YaST as root.
2. Click Miscellaneous > Autoinstallation.
3. Select Security and Users > CA Management, then click Configure.
4. In the Common Name File field, specify a name for the certificate. For example 
YaST_Default_CA(hostname).
5. Specify an e-mail name in the Email field.
6. Specify a password in the Password field.
7. Click File Save to save the file. Ignore any error messages that you receive.
8. Click View Source to ensure that the CA entry was entered.
See the following syntax:

<ca_mgm>
    <CAName>YaST_Default_CA</CAName>
    <ca_commonName>YaST_Default_CA(hostname)</ca_commonName>
    <country>US</country>
    <importCertificate config:type="boolean">false</importCertificate>
    <locality></locality>
    <organization></organization>
    <organizationUnit></organizationUnit>
    <password>actual_password</password>
    <server_email>name@example.com</server_email>
    <state></state>
    <takeLocalServerName config:type="boolean">true</takeLocalServerName>
  </ca_mgm>

Issue 3:  If you install Novell Cluster ServicesTM, one package does not install correctly.
Solution:  Comment out the following line in the control file.

<package>novell-cluster-services-kmp-smp</package>

For example:

<!--<package>novell-cluster-services-kmp-smp</package>-->

Issue 4:  If you did not patch the server during the installation, the OES product is not identified 
correctly in the control file.

Solution:  When creating the profile or control file, change the product line from:

<product>Novell Open Enterprise Server 2</product> 

to

<product>OPEN_ENTERPRISE_SERVER</product>

8.3.2  Using the AutoInstallation Module to Create the Control 
File
The following procedure contains a quick list of steps to create the control file using the 
AutoInstallation module in YaST on a server running OES 2.

1 On a server that has OES 2 installed, open the YaST2 Control Center.
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2 Click Miscellaneous > Autoinstallation.
3 Click Tools > Create Reference Control File.
4 In the Create a Reference Control File dialog box, select the Network card check box in the 

Select Additional Resources field, then click Create.
AutoYaST probes the system for software, partitioning, boot loader, network card information, 
language settings, mouse, and other system settings.

5 Verify the package selections.
5a Click Software > Package Selection.
5b On the Package Selection page, make sure the items are the same as you previously 

selected. For more information on the add-ons (software selections) that are selected in the 
base selections or patterns, see “Deciding What Patterns to Install” on page 20. If the 
configuration contains the packages and selections you need, skip to Step 7. If not, 
continue with Step 6.

6 If you need to change the package selections for the target servers, do the following:
6a In the Package Selection dialog box, click Configure.
6b On the Software Selection page, click Patterns in the Filter field.
6c Select the specific software items that you want to be added, then click Accept.
6d If you are prompted to accept the AGFA Monotype Corporation End User License 

Agreement, click Accept.
6e Accept the automatic changes by clicking Continue in the Changed Packages dialog box.

7 Specify the Partitioning parameters for the target server:
7a From the Main YaST AutoInstallation menu, click Hardware > Partitioning > Configure.
7b Set up partitioning on the first drive as desired, then click Finish. 

See the online help for details about limitations.
For more information on partitioning options, see “Partitioning” in Automatic Linux 
Installation and Configuration with Yast2 (http://forgeftp.novell.com/yast/doc/SLES10/
autoinstall/CreateProfile.Partitioning.html).

8 Specify the settings for the graphics card and monitor:
8a From the Main YaST AutoInstallation menu, click Hardware > Graphics Card and 

Monitor > Configure.
8b In the General Options field of the X11 Configuration page, specify the settings that you 

want.
8c In the Desktop field of the X11 Configuration page, select the settings that you want for 

the Display Manager and Window Manager, then click Next.
8d On the Configure Monitor page, select the applicable monitor vendor and model, then 

click Next.
8e Verify the X11 settings. If they are not correct, repeat Step 8a and Step 8d.

If you skip this step, the server keyboard mappings might be German.
9 (Optional) Insert a script to perform a task that you might want, such as a script for removing 

partitions:
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For more information on custom user scripts, see “Custom User Scripts” (http://
forgeftp.novell.com/yast/doc/SLES10/autoinstall/createprofile.scripts.html)in Automatic Linux 
Installation and Configuration with Yast2.
9a From the Main YaST AutoInstallation menu, click Miscellaneous > Custom Scripts > 

Configure.
9b On the User Script Management page, click New.
9c In the File Name field, specify a descriptive name for the script, such as 

hello_world_script.
9d In the Script Source field, specify commands such as the following example script:

#!/bin/sh
‘echo "hello world" > /tmp/post-script-output'

9e Click the Type drop-down box, then select Post.
This script runs after the installation is complete. For additional options, see the online 
help for this dialog box.

9f Click Save.
9g Make sure your script appears in the Available Scripts section of the User Script 

Management page, then click Finish.
9h Make sure your script appears in the Post Scripts section of the Custom Scripts page.

10 Set the password for the root user:
10a From the Main YaST AutoInstallation menu, click User Management > Configure.
10b Click Set Filter, then select Select System Users from the drop-down menu.
10c Select user root, then click Edit.
10d Type a password for the root user in the Password and Verify Password fields, click 

Accept, then click Finish.
10e Verify that the root user appears in the Users section of the User Management dialog 

box.
11 Set a password for Certificate Authority management:

11a From the Main YaST AutoInstallation menu, click Security and Users > CA Management 
> Configure.

11b Type a password for the certificate in the Password and Confirm Password fields, then 
click Finish.

11c Verify that the Password status appears as Set on the CA Management page.
12 Configure OES Services:

12a From the Main YaST AutoInstallation menu, click Open Enterprise Server > 
module_name > Configure.
All OES services are in the Open Enterprise Server category. 
We recommend configuring eDirectory first. Although there are dependencies for some of 
the components, in this release AutoYaST does not verify whether one module is 
configured or not.
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See the following table for category names and dependencies. You should configure all 
the modules that were selected for the software selections in Step 5 on page 150. For more 
information about which modules are in each pattern, see “Deciding What Patterns to 
Install” on page 20.

Module Name Other Module Dependencies

Novell Archive and 
Version Services

Novell Backup/Storage Management Services (SMS), Novell 
eDirectory, Novell Linux User Management, Novell Remote Manager, 
and Novell Storage Services

Novell Backup/
Storage 
Management 
Services (SMS)

Novell Linux User Management and Novell Remote Manager

Novell Cluster 
ServicesTM (NCS)

Novell Backup/Storage Management Services (SMS), Novell Linux 
User Management, and Novell Remote Manager

Novell DHCP Novell Backup/Storage Management Services (SMS), Novell 
eDirectory, Novell Linux User Management, and Novell Remote 
Manager

Novell DNS Novell Backup/Storage Management Services (SMS), Novell 
eDirectory, Novell Linux User Management, and Novell Remote 
Manager

Novell eDirectoryTM Novell Backup/Storage Management Services (SMS), Novell Linux 
User Management, and Novell Remote Manager

Novell FTP Novell Backup/Storage Management Services (SMS), Novell 
eDirectory, Novell Linux User Management, and Novell Remote 
Manager

iFolder 3.6 Novell Backup/Storage Management Services (SMS), Novell 
eDirectory, Novell Linux User Management, and Novell Remote 
Manager

iManager Requires eDirectory in the network and Novell Backup/Storage 
Management Services (SMS), Novell Linux User Management, and 
Novell Remote Manager

Novell iPrint Novell Backup/Storage Management Services (SMS), Novell 
eDirectory, Novell Linux User Management, and Novell Remote 
Manager

Novell Linux User 
Management (LUM)

Novell Backup/Storage Management Services (SMS) and Novell 
Remote Manager

Novell NCPTM 
Server/Dynamic 
Storage Technology

Novell Backup/Storage Management Services (SMS), Novell 
eDirectory, Novell Linux User Management, and Novell Remote 
Manager

Novell NetStorage Novell Backup/Storage Management Services (SMS), Novell iManager, 
Novell Linux User Management, and Novell Remote Manager

Novell QuickFinder Novell Backup/Storage Management Services (SMS), Novell Linux 
User Management, and Novell Remote Manager

Novell Remote 
Manager

Novell Backup/Storage Management Services (SMS) and Novell Linux 
User Management
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12b Type or select the information for each field requested on each page, then click Next until 
a summary of setting is displayed for that service.

12c Verify that the settings for each module are what you want.
If not, click Reset Configuration and provide the corrected settings.

12d Repeat Step 12a through Step 12c until all the required modules have been configured, 
then continue with Step 13.

13 Save the file.
13a Click File > Save.
13b Browse to a location that you want to save the file to.
13c Type filename.xml, then click Save.

Replace filename with an appropriate name to identify the control file for the installation 
you are performing.
By default, the file is saved in the /var/lib/autoinstall/repository/ 
directory.
For additional filename requirements and recommendations, see “The Auto-Installation 
Process” in Automatic Linux Installation and Configuration with Yast2 (http://
forgeftp.novell.com/yast/doc/SLES10/autoinstall/Invoking.html).

14 Exit the configuration management tool by clicking File > Exit.
15 Proceed with “Setting Up an Installation Source” on page 153.

8.4  Setting Up an Installation Source
AutoYaST requires an installation source. You have several options. For an explanation of each, see 
“Network Based Installation” (http://forgeftp.novell.com/yast/doc/SLES10/autoinstall/
Invoking.html) and “The Auto-Installation Process” in Automatic Linux Installation and 
Configuration with Yast2 (http://forgeftp.novell.com/yast/doc/SLES10/autoinstall/
Bootmanagement.html).

You can also set up an installation source on a NetWare server. See Appendix C, “Setting Up an 
Installation Source on NetWare,” on page 191.

For OES 2 SP1, you must set up a separate directory for the SLES 10 software and the OES Linux 
software.

Novell Samba Novell Backup/Storage Management Services (SMS), Novell Linux 
User Management, and Novell Remote Manager

Novell Storage 
ServicesTM

Novell Backup/Storage Management Services (SMS), Novell 
eDirectory, Novell Linux User Management, and Novell Remote 
Manager

Module Name Other Module Dependencies
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9Installing OES 2 SP1 Linux as a 
Xen VM Host Server

You can install Novell® Open Enterprise Server (OES) 2 SP1 Linux as a Xen VM host server. 

To understand why you might want your VM host server to have OES 2 SP1 installed, see “Why 
Install OES Services on Your VM Host?” in the OES 2 SP1: Planning and Implementation Guide.

To install OES 2 SP1 on your VM host server, add the following steps to the basic installation 
instructions found in “Setting Up a Virtual Machine Host (http://www.novell.com/documentation/
sles10/xen_admin/data/cha_xen_virtualization_vhost_setup.html)” in the Virtualization with Xen 
(http://www.novell.com/documentation/sles10/xen_admin/data/bookinfo.html) guide.

1 When you reach the Installation Mode page, select the Include Add-On Products from Separate 
Media option and complete the instructions in Section 3.3.3, “Specifying the Add-On Product 
Installation Information,” on page 37.

2 When you reach the Installation Settings page, click the Software heading.
3 Of the services listed in the OES Services category, only the following are supported on a Xen 

VM host server: 
Novell Linux User Management (LUM)
Novell Storage Management ServicesTM (SMS)
Novell Cluster Services® (NCS)

You can select any of these services that you want to be available on the host server, or you can 
leave all of the services deselected. In either case the server will be configured as an OES 
Linux server.

4 If you selected any of the supported OES services, you will notice that Novell Remote Manager 
(NRM) is also selected. Click the green checkmark by NRM to change it to a red taboo symbol 
and prevent NRM from being installed. NRM is not a supported OES service on a Xen VM 
host server.

5 In the Primary Functions category, select Xen Virtual Machine Host Server.
Because you want the host server optimized to manage your virtual machines, do not choose 
any additional primary functions. Other services should be installed on an OES Linux or SLES 
10 VM guest server or physical server.

6 In the Primary Functions category, deselect Print Server by clicking the option twice.
7 On the Configured LDAP Servers page, specify the tree name, admin name, and password for 

the eDirectory tree into which you are installing the host server.

IMPORTANT: If you didn’t select any OES services, the Novell Open Enterprise Server 
Configuration page appears instead. In that case, the Configured LDAP Servers page is 
accessible via the LDAP Configuration for Open Enterprise Services link.

8 Click Add and specify the IP address of a server in the tree that has eDirectory installed on it, 
then click Next.

9 On the Novell Open Enterprise Server Configuration page, click Next.
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10 When you reach the User Authentication Method page, do not change the Authentication 
Method.

11 On the New Local User page, do not create a local user.
12 After the server boots, make sure the GRUB boot loader is set to run the Xen kernel by doing 

the following:
12a On the desktop, click Computer > YaST.
12b In YaST click System > Boot Loader.
12c Make sure there is a check mark by the XEN label. If a different option is checked, select 

XEN and click the Set as Default button. 
12d Click Finish.
12e Close YaST and restart the server.

The server is now prepared to function as a Xen VM host server.
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10Installing, Upgrading, or Updating 
OES 2 SP1 Linux on a Xen-based 
Virtual Machine

In Novell® Open Enterprise Server (OES) 2 SP1 Linux, you can install OES 2 SP1 Linux as a guest 
operating system on a 

SUSE® Linux Enterprise Server (SLES) 10 Linux server 

See “Setting Up a Virtual Machine Host (http://www.novell.com/documentation/sles10/
xen_admin/data/cha_xen_virtualization_vhost_setup.html)” in the Virtualization with Xen 
(http://www.novell.com/documentation/sles10/xen_admin/data/bookinfo.html) guide.

or 
OES 2 SP1 Linux server that has been set up as a Xen-based host server
See Chapter 9, “Installing OES 2 SP1 Linux as a Xen VM Host Server,” on page 155.

For general information on the Xen virtualization technology in SLES 10 SP2, see the  
Virtualization with Xen (http://www.novell.com/documentation/sles10/xen_admin/data/
bookinfo.html) guide.

This section documents the system requirements, installation instructions, upgrade and migration 
instructions, and issues associated with setting up OES 2 Linux on a Xen-based virtual machine. 

Section 10.1, “System Requirements,” on page 157
Section 10.2, “Prerequisites,” on page 159
Section 10.3, “Preparing the Installation Software,” on page 159
Section 10.4, “Installing an OES 2 SP1 Linux VM Guest,” on page 160
Section 10.5, “Upgrading a Linux VM Guest to OES 2 SP1 Linux,” on page 163
Section 10.6, “Updating an OES 2 SP1 Linux VM Guest,” on page 163
Section 10.7, “Managing a Virtual Machine Running OES 2 SP1 Linux,” on page 163
Section 10.8, “Advanced Configuration Options,” on page 163

10.1  System Requirements
To create an OES 2 SP1 Linux VM guest, you need a SLES 10 SP2 or OES 2 SP1 Linux server that 
is set up as a Xen VM host server. 

Section 10.1.1, “OES 2 SP1 VM Guest Considerations,” on page 158
Section 10.1.2, “NSS Considerations,” on page 158
Section 10.1.3, “Setup Instructions,” on page 158
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10.1.1  OES 2 SP1 VM Guest Considerations
When setting up a virtual machine host for OES 2 SP1 Linux VM guests, ensure that the host server 
has the following:

Time synchronization:  Set the server’s time configuration to the same reliable, external 
time source as the eDirectoryTM tree that the virtual machines on that host will be joining. 
To set the time source, use Yast > Network Services > NTP Time Configuration.
The time source can be running NTP or Timesync. 
RAM: Enough memory to support each virtual machine that you want to run concurrently 
on the host server.
For example, if you are installing one OES 2 SP1 Linux virtual machine, you need a 
minimum of 1 GB of memory (512 MB for the host plus 512 MB for the OES 2 Linux 
VM). 
If you are installing two virtual machines, and the first VM guest’s services need 1 GB 
while the second guest’s need 1.5 GB, you need 2.5 GB for the VM guests and 512 MB 
for the host—a total of 3 GB. 
Disk Space: Enough disk space on the host for creating and running your VM guests.
The default disk space required for an OES 2 SP1 Linux VM guest is 4 GB and the  
default allocation for each VM guest in Xen is 10 GB, leaving approximately 6 GB for 
data files, etc. The space you need is dependent on what you plan to use the virtual server 
for and what other virtual storage devices, such as NSS volumes, that you plan to attach to 
it.

10.1.2  NSS Considerations
If you want to set up Novell Storage Services (NSS) on the virtual machine, note the following: 

NSS can recognize physical, logical, or virtual devices up to 2 TB in size (where 1 TB = 2E40 
bytes = 1,099,511,627,776 bytes).
In a virtual environment, the devices that you want to use for the NSS file system on the guest 
operating system cannot exceed the 2 TB limit, even if the host operating system and guest 
operating system can handle larger devices.
For information, see “Device Size Limit” in the OES 2 SP1: NSS File System Administration 
Guide.

10.1.3  Setup Instructions
For setup procedures, see

SLES 10 SP2: “Setting Up a Virtual Machine Host (http://www.novell.com/documentation/
sles10/xen_admin/data/cha_xen_virtualization_vhost_setup.html)” in the Virtualization with 
Xen (http://www.novell.com/documentation/sles10/xen_admin/data/bookinfo.html) guide.

or
OES 2 SP1: “Chapter 9, “Installing OES 2 SP1 Linux as a Xen VM Host Server,” on 
page 155.”
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10.2  Prerequisites
Before creating an OES 2 SP1 Linux virtual machine, you need the following:

If you want to use AutoYaST to specify the Installation settings, create an AutoYaST profile 
(control) file and download it to a directory on the host machine server or make it available on 
the network.
A static IP address for each virtual server that you want to create.

10.3  Preparing the Installation Software
Section 10.3.1, “Downloading the Installation Software,” on page 159
Section 10.3.2, “Preparing the Installation Source Files,” on page 159

10.3.1  Downloading the Installation Software
For information on downloading the following ISO image files, see the Novell Open Enterprise 
Server 2 Download Instructions (http://www.novell.com/documentation/oes2/esd/di_oes2.html).

Table 10-1   OES Linux ISO Images and CD Labels for i386

Table 10-2   OES Linux ISO Images and CD Labels for 64

10.3.2  Preparing the Installation Source Files
To create an OES 2 SP1 Linux VM guest, you must make the installation software available in one 
of the following locations:

A Local Installation Source: The 32-bit (Table 10-1) or 64-bit (Table 10-2) ISO files copied 
to the host server’s local drives. 

or
A Network Installation Source:  The 32-bit (Table 10-1) or 64-bit (Table 10-2) ISO files used 
to create a network installation source. For instructions, see “Setting Up the Server Holding the 
Installation Sources” in the SUSE Linux Enterprise Server 10 Installation and Administration 
Guide (http://www.novell.com/documentation/sles10/sles_admin/data/
sec_deployment_remoteinst_instserver.html#sec_deployment_remoteinst_instserver)

ISO Image File CD Label

OES2-SP1-i386-CD1.iso Novell Open Enterprise Server 2 SP1 CD 1

SLES-10-SP2-DVD-i386-GM-DVD1.iso SUSE Linux Enterprise Server 10 SP2 DVD

ISO Image File CD Label

OES2-SP1-x86_64-CD1.iso Novell Open Enterprise Server 2 SP1 CD 1

SLES-10-SP2-DVD-x86_64-GM-
DVD1.iso

SUSE Linux Enterprise Server 10 SP2 DVD
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10.4  Installing an OES 2 SP1 Linux VM Guest
Creating an OES 2 SP1 Linux virtual machine requires you to complete the following major tasks.

Section 10.4.1, “Specifying Options for Creating an OES 2 SP1 Linux VM Guest,” on 
page 160
Section 10.4.2, “Completing the OES 2 SP1 Linux VM Guest Installation,” on page 162

10.4.1  Specifying Options for Creating an OES 2 SP1 Linux VM 
Guest
The Create Virtual Machine Wizard helps you through the steps required to create a VM guest and 
install the desired operating system.

1 Launch the Create Virtual Machine Wizard by using one of the following methods:
From the virtualization host server desktop, click YaST > Virtualization > Create Virtual 
Machines
From within Virtual Machine Manager, click New.
At the command line, enter vm-install. 

If the wizard does not appear or the vm-install command does not work, review the 
process of installing and starting the virtualization host server. The virtualization software 
might not be installed properly.

2 After specifying that you want to create a virtual machine, click Forward.
3 Click Forward.

The option to set up a virtual machine based on an existing disk or disk image is only supported 
if the existing disk or disk image was originally set up through the Create Virtual Machine 
Wizard.

4 On the Type of Operating System page, select Novell Open Enterprise Server 2 (Linux), then 
click Forward.
The Summary page appears.
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NOTE: Detailed explanations of the Summary page settings are available in “Virtualization: 
Configuration Options and Settings (http://www.novell.com/documentation/sles10/xen_admin/
data/cha_xen_config_options.html)”in the Virtualization with Xen (http://www.novell.com/
documentation/sles10/xen_admin/data/bookinfo.html) guide.

5 Change the Summary page settings to meet your configuration requirements.
The following recommendations help you quickly set up a virtual machine running OES 2 SP1 
Linux: 
5a On the Name Of Virtual Machine page, specify a name for the virtual machine in the 

Name field, then click Apply.
For example, you might specify hostname_vm, where hostname is the DNS name of the 
server you are installing in the VM.

5b On the Hardware page: 
5b1 Specify the amount of initial and maximum memory for the virtual machine to 

consume from the available memory. The initial memory should not be less than 
1024 MB. 

5b2 Specify the number of processors that you want the virtual machine to use. 
5b3 Click Apply.

5c On the Graphics page, select the type of graphic support desired, then click Apply.
5d On the Disk page, specify the block device that you want to create the virtual device on.
5e then click Apply. Some options include a partition, a volume, or whether it is file backed.
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6 On the Network Adapters page, view the default setting, edit the default settings, or click New 
and specify the setting for another network board of your choice, then click Apply.

7 On the Operating System Installation page:
7a Specify the URL for the network installation source. 
7b If you are using an AutoYaST control file to specify the settings for virtual machine 

operating system, specify the path to the file in the AutoYaST File field or click the Find 
button to the right of the field to locate the file on the local host server. 

7c If needed, use the Additional Arguments field to specify additional install or boot 
parameters to assist the installation. 
For example, if you wanted to specify the parameters for an IP address of 192.35.1.10, a 
netmask of 255.255.255.0, a gateway of 192.35.1.254 for the virtual server, and use ssh to 
access installation, you could enter the following parameters in the Additional Argument 
field:
hostip=192.35.1.10 netmask=255.255.255.0 
gateway=192.35.1.254 usessh=1 sshpassword=password

7d Click Apply.
8 Click OK to start the virtual machine and launch the operating system installation program.
9 Continue with Section 10.4.2, “Completing the OES 2 SP1 Linux VM Guest Installation,” on 

page 162.

10.4.2  Completing the OES 2 SP1 Linux VM Guest Installation
1 Follow the on-screen prompts, using the information contained in the following sections:

1a Section 3.3.2, “Specifying the Installation Mode,” on page 36.
1b Section 3.3.3, “Specifying the Add-On Product Installation Information,” on page 37.
1c Section 3.3.4, “Setting Up the Clock and Time Zone,” on page 38.
1d Section 3.3.5, “Specifying the Installation Settings for the SLES Base and OES Linux 

Installation,” on page 38.
1e Section 3.3.6, “Specifying Configuration Information,” on page 42.

During the configuration portion of the installation, you might see additional prompts 
concerning hardware detection of the network cards, DSL, PPPoE DSL, ISDN cards, and 
modems.
When specifying the time source during the eDirectory configuration, use the same time 
source as the eDirectory tree you are installing the server into.
After the installation, enable the virtual machines Independent Wall Clock setting and 
reboot the virtual machine so the virtual machine will synchronize its time correctly. For 
more information on this configuration issue, “Virtual Machine Clock Settings (http://
www.novell.com/documentation/sles10/xen_admin/data/
sec_guest_suse.html#sec_xen_time)” in the Virtualization with Xen (http://
www.novell.com/documentation/sles10/xen_admin/data/bookinfo.html) guide.

1f Section 3.4, “Finishing the Installation,” on page 60.
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During the hardware configuration, graphics and sound cards are not recognized when 
installing OES 2 SP1 Linux as a VM guest.

2 Complete the server setup by following the procedures in “Chapter 6, “Completing Installation 
or Upgrade Tasks on OES 2 SP1 Linux,” on page 123.”

10.5  Upgrading a Linux VM Guest to OES 2 SP1 
Linux

Novell plans to deliver detailed instructions about this process as it pertains to OES 2 SP1. 
Meanwhile, please refer to the Virtualization with Xen guide (http://www.novell.com/
documentation/sles10/xen_admin/data/sec_guest_suse.html) for general instructions.

10.6  Updating an OES 2 SP1 Linux VM Guest
Patching or updating an OES 2 SP1 Linux VM guest is essentially the same as updating an OES 2 
SP1 Linux physical server. For instructions on updating a physical OES 2 SP1 Linux server, see 
“Updating an OES 2 SP1 Linux Server” in the OES2 SP1: Linux Installation Guide.

10.7  Managing a Virtual Machine Running OES 2 
SP1 Linux
Managing a virtual machine running OES 2 SP1 Linux is the same as managing virtual machines 
running other operating systems. For procedures, see “Managing a Virtualization Environment 
(http://www.novell.com/documentation/sles10/xen_admin/data/
cha_xen_virtualization_manage.html)” in the Virtualization with Xen (http://www.novell.com/
documentation/sles10/xen_admin/data/bookinfo.html) guide.

10.8  Advanced Configuration Options
This section includes advanced configuration options that you need to set up these services on an 
OES 2 SP1 Linux VM guest.

Section 10.8.1, “Setting Up an OES 2 SP1 Linux VM Guest to Use Novell Storage Services 
(NSS),” on page 163

10.8.1  Setting Up an OES 2 SP1 Linux VM Guest to Use Novell 
Storage Services (NSS)
When you install OES 2 SP1 Linux on a virtual machine, we recommend that you configure a 
virtual machine with multiple devices. Use the primary virtual disk as the system device with LVM2 
(the YaST install default) as the volume manager. After the install, you can assign additional storage 
resources from the host server to the virtual machine. In the guest server environment, the additional 
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disks can use LVM2 or EVMS as needed. In this scenario, NSS volumes are created only on 
additional virtual disks, not on the primary virtual disk that you are using for the guest server’s 
system device.

IMPORTANT: When you create the virtual machine, make sure to configure the size of the primary 
virtual disk according to the amount of space you need for the /boot, swap, and root (/) volumes. 

If you decide to use EVMS for the system device on the virtual machine, follow the install 
instructions in “Configuring the System Device to Use EVMS” in the OES2 SP1: Linux Installation 
Guide, just as you would for a physical machine.

After the virtual machine is set up, you need to perform additional tasks to set up additional Novell 
Storage Service (NSS) devices. See “Using NSS in a Virtualization Environment” in the OES 2 SP1: 
NSS File System Administration Guide.
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11Disabling OES 2 SP1 Linux 
Services

Although you can uninstall NovellTM Open Enterprise Server 2 (OES) Linux service RPMs using 
YaST, we do not recommend it because so many modules have interdependencies. Uninstalling 
services can leave the server in an undesirable state. Instead, we recommend disabling the service.

1 Log in as root and start YaST.
2 Click System > System Services (Runlevel).
3 Select Expert Mode.
4 Select the applicable_service_name, then click Set/Reset > Disable the service.
5 Repeat Step 4 for each service you want to disable.
6 Click Finish to exit the YaST Runlevel tool.

NOTE: YaST does not support removing products that create objects or attributes in eDirectory™. 
You need to use iManager to remove these objects and attributes. For procedures, see “Deleting an 
Object” in the Novell iManager 2.7.2 Administration Guide.
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12Security Considerations

This section includes issues that you should consider when installing and configuring an Novell® 
Open Enterprise Server 2 (OES) Linux server.

Section 12.1, “Password for User Admin Written in Clear Text in y2log,” on page 167
Section 12.2, “Password for User Admin Written in Clear Text in control.xml,” on page 167
Section 12.3, “Access to the Server During an Installation or Upgrade,” on page 167
Section 12.4, “Remote Installations Using VNC,” on page 168
Section 12.5, “Improperly Configured LDAP Servers,” on page 168

12.1  Password for User Admin Written in Clear 
Text in y2log
During the installation of OES 2 SP1 Linux or an upgrade to OES 2 SP1 Linux, the eDirectoryTM 
password for user Admin is written in clear text to the /var/log/YaST2/y2log file when you 
select the option to Clone the System for AutoYaST option at the end of the installation.

To prevent writing this user’s password to this file, update the server with the SLES10-SP2 yast2-
core-2.13.40 package during the installation or upgrade.

If you have already installed the server, you can update the server with this package and delete the 
password in all the y2log files.

If you need to send the y2log file to someone else for troubleshooting purposes, make sure you 
delete the password before sending the file.

For information on updating the server during the installation or upgrade, see “Updating the Server 
Software During the Installation” on page 47 and “Updating the Server Software During the 
Upgrade” on page 114.

12.2  Password for User Admin Written in Clear 
Text in control.xml
When you create a control.xml file using AutoYast, the eDirectory password for user Admin is 
written in clear text. This password can be read by anyone who has access to the file. Linux 
passwords are stored in the file in a hashed form.

We recommend controlling access to this file.

12.3  Access to the Server During an Installation 
or Upgrade
Because eDirectory passwords are not obfuscated in system memory during the installation or 
upgrade, we recommend not leaving a server unattended during the installation, upgrade, or 
configuration.
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You can use ssh (secure shell) to access the system to perform an installation. However, only 
authorized users can access the installation. YaST installation is always a down server installation, 
so unauthorized users cannot connect to the computer from other computers on the network during 
an installation or upgrade.

12.4  Remote Installations Using VNC
While installing the server, we recommend that you do not use Virtual Network Computing (VNC) 
for remote installation in an untrusted environment.

12.5  Improperly Configured LDAP Servers
Issue 1:  Improperly configured LDAP servers will allow any user to connect to the server and 
query for information

eDirectory LDAP server enabled NULL BIND by default, but allows it to be disabled on the server. 
To enhance the security of the OES server, disable the NULL bind on the LDAP server port 389. See 
“Configuring LDAP Services for Novell eDirectory” in the Novell eDirectory 8.8 Administration 
Guide.

Issue 2: Improperly configured LDAP servers will allow the directory BASE to be set to NULL. 
This allows information to be culled without any prior knowledge of the directory structure. 
Coupled with a NULL BIND, an anonymous user can query your LDAP server using a tool such as 
LdapMiner.

An eDirectory LDAP server allows the directory BASE to be set to NULL, and there is no way to 
disable it. However, with the NULL BIND disabled, as previously mentioned, the security threat 
posed by this feature is minimized.
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AInstalling Linux with EVMS as the 
Volume Manager of the System 
Device

This section describes how to modify the default partitioning scheme for the system device during 
the install of Novell® Open Enterprise Server 2 (OES) Linux server and Novell Storage ServicesTM 
(NSS) so that its system device is managed by the Enterprise Volume Management System (EVMS) 
instead of the Linux Volume Manager 2 (LVM2). 

IMPORTANT: For the purpose of this documentation, a system device is any device that contains 
the Linux /boot, swap, or root (/) partitions for your OES 2 SP1 Linux server. 

Section A.1, “Using EVMS to Manage the System Device,” on page 169
Section A.2, “Understanding the EVMS Partitioning Scheme for the System Device,” on 
page 170
Section A.3, “Configuring the System Device to Use EVMS,” on page 171
Section A.4, “Using EVMS to Manage Devices,” on page 186
Section A.5, “Upgrading a Server with EVMS and NSS on the System Device,” on page 188

A.1  Using EVMS to Manage the System Device
The Novell Storage Services file system requires that the Enterprise Volume Management System 
(EVMS) be used as the volume manager of devices that contain (or will contain) NSS pools and 
volumes. NSS management tools cannot see devices managed by non-EVMS volume managers, so 
those devices and the space on them are unavailable for creating NSS pools and volumes. EVMS 
also makes it possible to use the full range of services that NSS offers. NSS is not supported or 
tested for non-EVMS volume managers. For a list of the NSS capabilities that are not available 
when using a non-EVMS volume manager, see “NSS Limitations for Non-EVMS Volume 
Managers” in the OES 2 SP1: NSS File System Administration Guide.

IMPORTANT: NSS management tools require that the devices you use for NSS pools and volumes 
be managed by EVMS.

SUSE® Linux Enterprise Server 10 supports LVM2 and EVMS as volume managers, but a given 
device can be managed by only one volume manager at a time. LVM2 is the default volume manager 
for SUSE Linux. During the install, the YaST Installation Settings page automatically recommends 
a partitioning scheme that uses LVM2 as the volume manager of the primary device and that 
allocates the entire disk for the Linux system partitions and POSIX file systems. 

This default partitioning scheme creates two problems for administrators who want to use NSS 
pools and volumes on the same device as the system partitions. First, NSS management tools cannot 
see devices that are managed by LVM2 so any unpartitioned free space on the system device is not 
available to be used for NSS pools and volumes. Second, the default partitioning scheme allocates 
the entire device for Linux POSIX file systems, so there is no free space available to be used later. 
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Possible workarounds for these problems are:

(Recommended) Use Additional Disks for NSS Volumes: Use multiple devices on the 
server, and reserve the system device for system partitions and Linux POSIX file systems.

This solution does not require that the system device be managed by EVMS. During the install, 
use LVM2 as the volume manager for the system device. Do not partition or configure the non-
system devices during the install. Otherwise, follow the install procedures described elsewhere 
in this guide. Any free space on the LVM2-managed system device is not seen by NSS 
management tools, so any free space on the device is not available for creating NSS pools. 

After the install, you can create NSS pools or Linux POSIX file systems on the other devices. 
For information, see Section A.4, “Using EVMS to Manage Devices,” on page 186.
(Supported) Modify the Partitioning Scheme During Install: At install time, modify the 
partitioning scheme for the system device to use EVMS and to leave unpartitioned free space 
that can be used later for NSS pools.
During the YaST install, you can use the Partitioner to create an EVMS partitioning scheme for 
the system device. For information, see Section A.2, “Understanding the EVMS Partitioning 
Scheme for the System Device,” on page 170. 
To modify the partitioning scheme during the install, follow the procedure in Section A.3, 
“Configuring the System Device to Use EVMS,” on page 171.
After the install, you can create NSS pools or Linux POSIX file systems on the device. For 
instructions for creating pools and volumes, see the “Managing NSS Pools” and “Managing 
NSS Volumes” in the OES 2 SP1: NSS File System Administration Guide.

NOTE: These options apply to physical machines and virtual machines.

A.2  Understanding the EVMS Partitioning 
Scheme for the System Device
Using EVMS to manage the system device allows you to later add NSS pools and volumes on any 
unparttioned free space on it. You must modify the partitioning scheme to use EVMS during the 
install. It is not possible to change the volume manager for the system device after the install. 

IMPORTANT: Make sure to follow the detailed instructions in Section A.3, “Configuring the 
System Device to Use EVMS,” on page 171.

We recommend that you choose a size for the system device that is based on to your current and 
future needs. Resizing of the root and swap partitions is not supported. If you need more space for 
paths like /home, you can map it in with new partitions as needed.

Consider the following to determine what data should be stored within the system device structure 
and what data you want to store on additional NSS volumes and Linux POSIX volumes that are 
mapped to a location on the system device:

Linux operating system requirements
Table 3-3, “Partition Guidelines,” on page 39
OES 2 SP1 services that you plan to install
Novell applications that you plan to install
SP1: Linux Installation Guide



novdocx (en)  11 July 2008
Third-party applications that you plan to install
Home directories
Non-system data, including databases

For example, Figure A-1 illustrates how a 30-GB device can be partitioned during the install to 
enable EVMS to be used as the volume manager. After deleting the default partitioning scheme, you 
can specify a new partitioning scheme based on EVMS. Create a /boot volume of 300 MB at the 
beginning of the device. Next, create an EVMS container of type Linux LVM2 with only the amount 
of space needed to hold both the swap and  / (root) volumes. In this example, the EVMS container 
is 11 GB because we plan to use 1 GB for the swap and 10 GB for the /. Next, create the swap 
volume (1 GB) and the / (root) volume (10 GB) in the EVMS container. Do not partition the 
remaining space (17.7 GB) on the system device. This free space is where you can create NSS pools 
and partitions by using NSS management tools after the install.

Figure A-1   Using EVMS for the System Device

IMPORTANT: As illustrated, only the /boot partition, the EVMS container, and swap and /  
volumes inside of the EVMS container are configured at install-time. The remainder of the device 
remains as unpartitioned free space where you can create NSS pools and volumes after the install.

A.3  Configuring the System Device to Use EVMS
This section describes how to configure the system device during the Linux install to use EVMS as 
the volume manager instead of the current default of LVM2. 

Section A.3.1, “Prerequisites and Guidelines,” on page 172
Section A.3.2, “Modifying the Installation Settings for EVMS and NSS,” on page 173
Section A.3.3, “After the Linux Install,” on page 182
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A.3.1  Prerequisites and Guidelines
This section discusses the following:

“System Device” on page 172
“Device Size Limits” on page 172
“Storage Deployment Considerations for Data Devices” on page 172
“Data Loss Considerations for the System Device” on page 173

System Device

For the purpose of this documentation, a system device is any device that contains the Linux /
boot, swap, or root (/) partitions for your Linux computer. 

The instructions assume the following:

All three system partitions are on the same physical disk. 

If you use different disks for any of the system partitions, make sure to modify the install 
instructions for your deployment scenario so that all of the system partitions are managed by 
EVMS.
You must configure the boot partition within the BIOS-addressable space (such as 2 GB for x86 
or 8 GB for x86-64) of the first disk recognized by the system. 
If this restriction is not required for your hardware, you can modify the location of the /boot 
partition as desired.
Your system uses the Grub or LILO boot loaders. 
If you have an IA64 system, you must modify these install instructions to use the ELILO boot 
loader (/boot/efi/elilo.conf) instead. 

WARNING: Whenever you manually alter the kernel or initrd on your system, make sure 
to run /sbin/elilo before shutting down the computer. If you leave out this step, your 
system might not be bootable. 

Device Size Limits

NSS recognizes devices only up to 2 TB in size. If you plan to use a device for NSS data volumes, 
the device must be 2 TB or smaller. 

IMPORTANT: If necessary, use a third-party disk partitioner to carve the device into logical 
devices less than 2 TB in size.

Storage Deployment Considerations for Data Devices

During the install, if you set up Linux POSIX file systems on data devices where you later need to 
have EVMS support:

Configure the devices to use EVMS as the volume manager.
Leave unallocated free space on the device that can be used later for NSS pools and volumes.
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Data Loss Considerations for the System Device

When you modify the partitioning scheme, you delete the suggested partitioning settings, and create 
new partitions to use EVMS instead. This destroys all data on the disk.

WARNING: To avoid data loss, it is best to use the EVMS install option only on a new device. 

If you are upgrading, take one or more of the following precautionary measures before you install or 
upgrade: 

Move the data volumes from the system device to another device, and save your configuration 
files.
If you cannot move the volumes, make a backup copy of the data, so you can restore the data 
volumes later from a backup copy.

A.3.2  Modifying the Installation Settings for EVMS and NSS
The procedure in this section describes how to modify the partitioning settings to install Linux with 
EVMS as the volume manager for your boot and system partitions, and how to modify the software 
settings to install NSS and other OES 2 SP1 services that NSS uses to provide storage services on an 
OES 2 SP1 Linux server.

IMPORTANT: The procedure assumes SCSI devices and refers to device node names with the sdn 
notation. Other device drivers use different notation for device node names. For example, IDE 
drives use the hdn notation. 

WARNING: The following procedure destroys all data on the system device.

1 Begin the SLES 10 install for OES 2 SP1 Linux. 
For information, see “Installing Open Enterprise Server 2 SP1 Linux” on page 29.

2 When the installation reaches the Installations Settings page, you must first delete the proposed 
LVM2-based partitioning solution so that the device can be configured to use EVMS as the 
volume manager instead of LVM2.
2a In the list of Installation Settings, select Partitioning. 
2b On the Suggested Partitioning page under Partitioning, select Create Custom Partition 

Setup, then click Next.
2c On the Preparing Hard Disk: Step 1 page under Hard Disk, select Custom Partition (for 

experts), then click Next to open the Expert Partitioner page.
2d At the bottom of the Expert Partitioner page, click Expert, select Delete Partition Table 

and Disk Label from the pop-up menu, then click Yes to continue through the Caution 
advisory.
This deletes the default proposed partitions and the partition table on the system disk.

3 Create a primary partition on the system disk to use as the /boot partition:
3a At the bottom of the Expert Partitioner page, click Create.

If there are multiple devices connected to the server, a Device dialog box opens where you 
can specify which device to use. If only a single device is available, the Partition Type 
dialog box opens.
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3b If the Device dialog box opens, select the device you want to use for the /boot partition 
from the list of devices, such as /dev/sda, then click OK.
If there is only a single device available, the partitioner automatically selects it, and you 
are not prompted to specify which device to use.

3c In the Partition Type dialog box, select Primary Partition, then click OK.

The Create a Primary Partition on /dev/sda dialog box opens, where /dev/sda is the 
device node name of the specified device.

3d In the Create a Primary Partition on /dev/sda dialog box, specify the following values:
Format: Select Format, then select the Linux file system you want to use from the 
File System drop-down menu, such as Ext3.

IMPORTANT: In a Xen paravirtualized environment, use Ext2 as the file system for 
the boot device. For a technical explanation of why this is necessary, see “Paravirtual 
Mode and Journaling File Systems (http://www.novell.com/documentation/sles10/
xen_admin/data/sec_xen_filesystem.html)” in the Virtualization with Xen (http://
www.novell.com/documentation/sles10/xen_admin/data/bookinfo.html) guide.

Size: Do not modify the Start Cylinder value (0). Type an End value of 200 MB or 
larger to be the size of the /boot partition. 
For example, to set the size at 300 MB, type 300M.
Mount Point: Select /boot from the Mount Point drop-down menu.

3e Click OK to create the /boot partition.
On the Expert Partitioner page, the partition appears as a logical device in the devices list, 
such as /dev/sda1.
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4 Create a second primary partition on the system disk to use for both the swap and system 
volumes:
4a At the bottom of the Expert Partitioner page, click Create.

If there are multiple devices connected to the server, a Device dialog box opens where you 
can specify which device to use. If only a single device is available, the Partition Type 
dialog box opens.

4b If the Device dialog box opens, select the device you want to use for the second primary 
partition from the list of devices, such as /dev/sda, then click OK.
If there is only a single device available, the partitioner automatically selects it, and you 
are not prompted to specify which device to use.

4c In the Partition Type dialog box, select Primary Partition, then click OK.

The Create a Primary Partition on /dev/sda dialog box opens, where /dev/sda is the 
device node name of the specified device.

4d In the Create a Primary Partition on /dev/sda dialog box, specify the following values:
Format: Select Do Not Format, then select 0x8E Linux LVM from the File System ID 
drop-down list.
Size: Do not modify the Start Cylinder value. Type an End value of 5 GB or larger, 
depending on the combined partition size you need to contain your system and swap 
volumes.
For example, to create a system partition of 11 GB in size that allows 1 GB for a 
swap and 10 GB for the root (/) volume, type 11G.
If you intend to create additional NSS volumes on the same physical disk, you must 
leave unpartitioned space available. 

IMPORTANT: Do not make the system partition larger than necessary. The 
remaining unpartitioned free space on the system disk is used later to create the NSS 
pools and volumes. It can also be used to create Linux POSIX file systems.

 To determine how much space to use, consider the following recommendations:
The total size you specify for the system partition should be the size you need 
for your system volume plus the size you need for your swap volume.
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For your system volume, allow 2 GB (minimum) to 10 GB (recommended), 
depending on the OES services that you intend to install.
Set aside 128 MB or larger for the swap volume. 
Swap management is different for Linux kernel 2.4.10 and later. How much 
swap to add depends on the RAM size, the tasks that are planned for the system, 
and whether you want to make more virtual memory available than the RAM 
provides.
Some swap space (at least 128 MB) is good, to minimize the risk of losing data 
when active processes run out of RAM space. Swap is not required for systems 
with more than 1 GB of RAM. You must have at least 1 GB of virtual memory 
(RAM plus swap) during the install, but if the swap is more than 2 GB, you 
might not be able to install on some machines.

For example, suppose you have a 20 GB hard drive and 2 GB of RAM. If you plan to 
install all of the OES services on the system volume, your system partition should be 
about 11 GB (10 GB for the system volume and 1 GB for the swap). The remaining 
9 GB should remain as free unpartitioned space where you can later create NSS pools 
and volumes or other Linux partitions.

4e Click OK to create a second primary partition.
On the Expert Partitioner page, the system partition appears as a logical device in the 
devices list, such as /dev/sda2.

5 Create an EVMS container for the system partition that you created in Step 4:
5a At the bottom of the Expert Partitioner page, click EVMS to open the EVMS 

Configuration page.
Available partitions for EVMS now appear as devices under /dev/evms. For example, 
the system partition /dev/sda2 is listed as /dev/evms/sda2.
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5b On the EVMS Configuration page, select the system partition created in Step 4 (such as /
dev/evms/sda2), then click Create Container to open the Create EVMS Container 
dialog box.

5c In the Create EVMS Container dialog box, select the partition, specify the following 
parameters, then click OK:

Container Type: Select Linux LVM2 from the drop-down menu.
Container Name: Specify the container name, such as system.
Physical Extent Size: Specify the physical extent size for regions in the container, 
such as 4 MB.
The physical extent (PE) size is the granularity with which regions can be created. 
The default PE size for LVM2 is 32 MB. Unlike LVM1, there is no limitation to the 
number of extents that can be allocated to an LVM2 region.

5d Click Add Volume to create the lvm2/system container, where system is the container 
name.
The lvm2/system container name is displayed in the Container column, and the 
Container Size is shown beneath the Container Type.
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5e Click OK to create the container.
On the EVMS Configuration page, the container you just created should automatically be 
selected, and its information displayed in the upper left of the page. If it is not, you can 
select it from the EVMS Container drop-down menu.

6 Create the swap volume in the lvm2/system container that you created in Step 5:
6a On the EVMS Configuration page, select the lvm2/system container from the EVMS 

Container drop-down menu, then click Add.
6b In the Create Logical Volume dialog box, specify the following parameters:

Format: Select Format, then select Swap from the File System drop-down menu.
Volume Name: Specify swap as the volume name.
Size: Specify the size to use for the swap volume.
The swap size should be 128 MB or larger, with a recommended size of 1 GB. 
Specify the value you planned based on your calculations and recommendations in 
Step 4d. 
Mount Point: Select swap from the Mount Point drop-down menu.
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6c Click OK to create the swap volume.
On the EVMS Configuration page, the swap volume is listed as a device in the container, 
and its pathname is /dev/evms/lvm2/system/swap, where system is the name of 
the system partition and swap is the name of the swap volume.

7 Create the system volume in the lvm2/system container that you created in Step 5:
7a On the EVMS Configuration page, select the lvm2/system container from the EVMS 

Container drop-down menu, then click Add.
7b In the Create Logical Volume dialog box, specify the following parameters:

Format: Select Format, then select the file system to use from the File System drop-
down menu, such as Reiser or Ext3.
Volume Name: Specify a volume name. For example, name it sys_linux.
You can use any volume name that you know to be unique on the system. When you 
install OES 2 SP1 services, a sys volume that parallels the one on NetWare® is 
automatically created, so make sure not to use sys as the volume name.
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Size: Click Max to set the size of the system volume as the remaining space available 
in the lvm2/system partition. 
Mount Point: Select / (root) from the Mount Point drop-down menu.

7c Click OK to create the system volume.
On the EVMS Configuration page, the system volume is listed as a device in the container 
and its pathname is /dev/evms/lvm2/system/sys_linux, where system is the 
name of the system partition and sys_linux is the name of the system volume.

8 On the EVMS Configuration page, click Next to return to the list of devices on the Expert 
Partitioner page.
Your complete EVMS solution for the system devices is displayed on the Expert Partitioner 
page. Your setup depends on the number and type of devices connected to the server and the 
sizes you specified for the system partitions.
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9 Click Finish to return to the Installation Settings page.
If you get a warning that you should not mix EVMS and non-EVMS partitions on the same 
device, you can safely dismiss it.

10 Modify the software settings to install NSS.

IMPORTANT: This step describes essential services for NSS. You can optionally install other 
OES 2 SP1 services on the same server.

10a On the Installations Settings page, click Software to go to the Software Selections and 
System Tasks page.

10b Select Novell Storage Services from the available OES Services options. 
Novell Distributed File Services is part of NSS, so it is automatically installed whenever 
you install NSS. When you select Novell Storage Services, the following additional OES 
services are automatically selected:

Novell Backup / Storage Management ServicesTM

Novell eDirectoryTM

Novell Linux User Management
Novell NCPTM Server / Dynamic Storage Technology

10c Optionally select Novell iManager to be installed on the server.
You must install iManager somewhere in the same tree as the server. If you install 
iManager and NSS on the same server, the storage-related plug-ins are automatically 
installed.
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If you install iManager on a different server, make sure you install the storage-related 
plug-ins that you need to manage NSS file system and services. For information about 
installing storage-related plug-ins on an existing server, see “Novell iManager and 
Storage-Related Plug-Ins” in the OES 2 SP1: NSS File System Administration Guide.

10d Click Accept to return to the Installation Settings page. 
Licensing dialog boxes might open where you are prompted to accept proprietary modules 
being installed.

11 Continue with the OES 2 SP1 Linux installation.
Refer to the product documentation for information about configuring OES Services that are 
being installed. For general information about the install, see “Installing Open Enterprise 
Server 2 SP1 Linux” on page 29.

12 Some additional steps are required after the install to make sure that your system is bootable by 
EVMS. 

WARNING: Do not reboot automatically or perform other configurations until the post-install 
steps outlined in Section A.3.3, “After the Linux Install,” on page 182 are completed. 
Otherwise, your system might not be bootable by EVMS.

After the install is complete, do one of the following:
If this is a new install, you can reboot your system now to automatically run a script that 
performs the post-install steps outlined in Section A.3.3, “After the Linux Install,” on 
page 182.
If this is a new install and you prefer to manually perform the EVMS setup tasks, go to 
Section A.3.3, “After the Linux Install,” on page 182 and complete the tasks. You reboot 
the system after these tasks are done.
If you are post-installing OES 2 SP1 services and NSS, do not reboot now. You must 
perform the tasks manually. The special script does not run on a post-install. Go to 
Section A.3.3, “After the Linux Install,” on page 182 and complete the tasks.

A.3.3  After the Linux Install
The tasks in this section must be done to ensure that the system device functions properly under 
EVMS and that your system is bootable under EVMS. After the OES installation is complete, do not 
attempt to reboot the server until these tasks are complete, unless this is a new install. 

In a new install of OES 2 SP1 with NSS, a script runs automatically to complete these tasks if you 
reboot after the install. You can also perform these tasks manually before rebooting. In a post-install 
of OES 2 SP1 services and NSS, the script does not run, so the tasks must be performed manually.

WARNING: Without the setup modifications described in this section, your system is not bootable 
on EVMS.

Perform the following post-install tasks in the order indicated:

“Disable the boot.lvm and boot.md Services” on page 183
“Enable the boot.evms Service” on page 183
“Verify the Device Name for the /boot Partition in /etc/fstab” on page 183
“Reboot the Server” on page 184
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“Verify the System Services” on page 184
“Enable Write-Through Cache Management for SCSI Devices and RAID Controllers” on 
page 185

Disable the boot.lvm and boot.md Services

You can optionally disable the boot.lvm and boot.md services so they do not run at boot time 
(runlevel B) when they are not needed. EVMS now handles the boot. 

IMPORTANT: Whenever you upgrade the server, the boot.lvm service must be enabled in order for 
the YaST install to boot.

1 In YaST, click System > System Services (Runlevel) > Expert Mode.
2 Select boot.lvm.
3 Click Set/Reset > Disable the Service. 
4 Select boot.md.
5 Click Set/Reset > Disable the Service. 
6 Click Finish, then click Yes.

The changes do not take effect until the server is restarted.
7 Continue with “Enable the boot.evms Service” on page 183.

Enable the boot.evms Service

The boot.evms service should be enabled automatically after the install, but you must verify that 
it is enabled. Otherwise, your server cannot boot.

1 In YaST, click System > System Services (Runlevel) > Expert Mode.
2 Select boot.evms.
3 Click Set/Reset > Enable the Service.

The B runlevel option is automatically selected.
4 Click Finish, then click Yes.

The changes do not take effect until the server is restarted.

NOTE: Effective in SUSE Linux Enterprise 10, the /dev directory is on tmpfs, and the 
device nodes are automatically re-created on boot. It is no longer necessary to modify the /
etc/init.d/boot.evms script to delete the device nodes on system restart, as was 
required for previous versions of SUSE Linux.

5 Continue with “Verify the Device Name for the /boot Partition in /etc/fstab” on page 183.

Verify the Device Name for the /boot Partition in /etc/fstab

When you boot the system, the kernel reads the /etc/fstab file to identify which file systems 
should be mounted and then mounts them. This file contains a table of file system information about 
the root (/), /boot, and swap partitions plus other partitions and file systems you want to mount.
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The /boot partition is discovered by EVMS at startup, and requires that the device it uses be listed 
under /dev/evms in the fstab file so it can be found when booting with boot.evms. For 
example:

/dev/evms/sda1 /boot reiser defaults 1 1

During the OES 2 SP1 install, the /etc/fstab file was modified to make sure that the /boot 
partition entry is properly formatted in this manner to be detected by EVMS. A script runs 
automatically to perform the following tasks: 

Modifies the device node pathname of the /boot partition in the /etc/fstab file so that 
the node is located under /dev/evms instead of /dev. For example, if the device is sda1, 
the script changes the /boot partition entry from /dev/sda1 to /dev/evms/sda1.
Runs mkinitrd to create a new initrd file that incorporates the change made in the /
etc/fstab file.

These changes are applied when you reboot your system after the install is completed. Make sure 
that you reboot after the install and before you do anything that would alter these settings.

IMPORTANT: For a SUSE Linux Enterprise Server 10 server install without the OES 2 SP1 Add-
On CD, these tasks must be performed manually after the install and before you reboot. For 
information about a single-disk install with EVMS on a pure SLES 10 server install, see “After the 
Install (http://www.novell.com/documentation/sles10/stor_evms/data/
configsysdevatinstall.html#b1xfw90)” in the SUSE Linux Enterprise Server 10 Storage 
Administration Guide (http://www.novell.com/documentation/sles10/stor_evms/data/
bookinfo.html).

Avoid other methods of formatting the path for the /boot partition, such as by its device node name 
(such as /dev/sda1) or by the UUID pathname (such as /dev/disk/by-id/scsi-
SServeRA_Drive_1_600BC00000-part1). The name for the boot device must be in the 
form that includes evms in the path, such as /dev/evms/sda1. 

Continue with “Reboot the Server” on page 184.

Reboot the Server

1 After the install is complete, and the boot.evms service has been enabled, reboot the server.
2 On restart, if the system device does not appear, it might be because EVMS has not been 

activated. At the prompt, enter

evms_activate

Verify the System Services

After the post-install configuration is complete and you have rebooted the server, make sure the 
server is operating as expected. For example:

Check the server health. For information, see “Monitoring Server Health” in the OES 2 SP1: 
Novell Remote Manager for Linux Administration Guide.
SP1: Linux Installation Guide

http://www.novell.com/documentation/sles10/stor_evms/data/configsysdevatinstall.html#b1xfw90
http://www.novell.com/documentation/sles10/stor_evms/data/configsysdevatinstall.html#b1xfw90
http://www.novell.com/documentation/sles10/stor_evms/data/bookinfo.html
http://www.novell.com/documentation/sles10/stor_evms/data/bookinfo.html
http://www.novell.com/documentation/sles10/stor_evms/data/bookinfo.html
http://www.novell.com/documentation/sles10/stor_evms/data/bookinfo.html


novdocx (en)  11 July 2008
Make sure the free space on the system device is available to you in iManager. For information 
about how to view devices in iManager, see “Viewing Devices on a Server” in the OES 2 SP1: 
NSS File System Administration Guide.
Make sure that NSS modules are running. In YaST, click System > System Services (Runlevel) 
> Expert Mode. The NSS module should be enabled. Any changes you make do not take effect 
until you reboot the server.

Enable Write-Through Cache Management for SCSI Devices and RAID Controllers

Any journal based file system (including NSS) requires that when writes occur, they must be 
committed to disk in order to prevent corruption in event of a power failure. 

Using write-back cache management can improve performance by allowing data to be held in cache 
rather than being written to disk. However, write-back cache management introduces the risk of 
losing data if the power fails. Many array controllers have an on-board battery backup, which can 
reduce the risk of data loss when using write-back, but it might not eliminate the risk. It is up to you 
to determine if the power backup is sufficient for power loss scenarios in your production 
environment.

If your storage system does not have sufficient power loss protection, we require using write-
through cache management for SCSI devices to minimize the risk of losing data in the event of 
power failure. Write-Through cache management assures the file system that writes are being 
committed to disk as required. 

If the server uses a RAID controller, enable Write-Through (disable Write-Back) cache management 
when configuring the RAID device by using the controller’s BIOS setup routine or configuration 
utility.

“SCSI Devices in a Hardware RAID” on page 185
“Local SCSI Devices” on page 185

SCSI Devices in a Hardware RAID

If you have not already done so, use the RAID controller’s BIOS setup routine or configuration 
utility to enable Write-Through cache management for the controller and the RAID’s SCSI devices.

Local SCSI Devices

To enable Write-Through cache management for local SCSI devices: 

1 Log in to the server as root.
2 If the scsi-config utility is not already installed, install it by using the xscsi RPM. 

The xscsi RPM, which contains the scsi-config command, is not installed by default. 
2a In YaST, open the Software Management section, then search for xscsi. 
2b Install the xscsi RPM package, then close YaST. 

The xscsi package installs the scsi-config utility in /user/bin/scsi-
config. 

3 Enable Write-Through (disable Write-Back) cache management for each SCSI device by 
performing the following for each device where you plan to use NSS volumes.
3a In a terminal console, enter 
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scsi-config 

3b  In the window that opens, browse to select drive you want to manage, then click 
Continue.

3c Click Cache Control Page.
3d Enable Write-Through cache management mode by deselecting the Write cache enabled 

check box. 
3e Click Quit > Save Changes.
3f When prompted to confirm the change, click Go Ahead and Save > Quit. 

3g To verify the setting, enter the following at a terminal console prompt:

scsiinfo -c /dev/sdx

Replace /dev/sdx with the device you are checking.
A value of 0 for Write Cache means that the drive is in Write-Through cache management 
mode.

A.4  Using EVMS to Manage Devices
You can use the free space on devices for NSS or Linux POSIX file systems by using EVMS to 
manage devices. Consider the guidelines below when working with EVMS-managed devices.

When you use NSS tools to create a pool on a new EVMS-managed device, the tools automatically 
carve out a partition with the DOS Segment Manager so that the device can be used later for either 
NSS or Linux POSIX file systems. Then the NetWare Segment Manager creates the NSS partition 
and pool.

IMPORTANT: Always use NSS tools  (NSSMU and the Storage plug-in to iManager) to create 
NSS pools.

For EVMS-managed data devices, Linux POSIX file systems require that the Linux partitions be 
managed by the DOS Segment Manager (DOSSegMgr). Consider the following guidelines when 
working with evmsgui to create a Linux partition:

Scenario To create the Linux partition in evmsgui:

Disk is not initialized. 1. Select No at the prompt to initialize. 

On a pure SLES system (no NSS), ignore this step.

2. Delete the disk object from the Volumes tab.

3. Add the DOS Segment Manager to the device.

4. Create the Linux partition as usual.

Free space is controlled by the 
DOS Segment Manager.

Create the Linux partition as usual.
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If no partitions are on the device, do the following to add a DOS Segment Manager to a non-
clustered device:

1 Log in as the root user, open a terminal console, then enter

evmsgui

WARNING: EVMS administration utilities (evms, evmsgui, and evmsn) should not be 
running when they are not being used. EVMS utilities lock the EVMS engine, which prevents 
other EVMS-related actions from being performed. This affects both NSS and Linux POSIX 
volume actions.
NSS and Linux POSIX volume cluster resources should not be migrated while any of the 
EVMS administration utilities are running.

2 If necessary, remove the NetWare Segment Manager:
2a Click the Disks tab, then locate and select the device, such as device sdb.
2b Right-click, then select Remove segment manager from Object.

This option appears only if there is an existing segment manager for the selected disk.
2c Select the listed segment manager, click Remove, then click OK.

WARNING: All data on the selected disk space is destroyed.

2d Click Save, then click Save again to save your changes.
3 Add the DOS Segment Manager.

3a From the evmsgui menu, click Actions > Add > Segment Manager to Storage Object.
3b On the Add Segment Manager to Storage Object page, choose DOS Segment Manager, 

then click Next.
3c On the Select Plugin Acceptable Objects page, choose the device where you want to add 

the segment manager, then click Next.
3d On the Configurable Options page, select the disk type (Linux is the default), click Add, 

then click OK.
3e Click Save, then click Save again to save your changes.

4 Create a segment for the DOS Segment Manager.

Free space is controlled by the 
NetWare Segment Manager.

Do one of the following:

If no partitions are on the device, remove the NetWare Segment 
Manager from the device,  add the DOS Segment Manager, 
then create the partition as usual.

WARNING: Changing the segment manager initializes the disk 
again (destroys existing data), so you only want to do this with 
disks that have no partitions on it, or if you do not want any of 
the partitions that are currently on the disk.

If partitions exist, reboot the server to automatically give control 
of the device back to the DOS Segment Manager, then create 
the partition as usual.

Scenario To create the Linux partition in evmsgui:
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The DOS Segment Manager requires you to create a segment before creating an EVMS 
volume. Without a segment, the additional segment manager does not appear when you attempt 
to create an EVMS volume.
4a From the evmsgui menu, click Actions > Create > Segment.
4b On the Create Disk Segment page, select DOS Segment Manager, then click Next.
4c On the Select Plugin Acceptable Objects page, choose device where you want to add the 

segment, then click Next.
4d Specify the size of the segment, the partition type (such as Linux LVM), click Create, then 

click OK.
4e Click Save, then click Save again to save your changes.

For information about adding or changing segment managers when you are clustering a shared 
device with Novell Cluster Services, see “Creating Linux POSIX Volumes on Shared Disks” in the 
OES 2 SP1: Novell Cluster Services 1.8.5 for Linux Administration Guide.

A.5  Upgrading a Server with EVMS and NSS on 
the System Device
Because the YaST installer is designed to use LVM by default, it looks for the LVM partitions in the 
/dev/ device nodes path during an upgrade. When EVMS is the volume manager of the system 
devices, the Linux path for the /boot, swap, and / (root) partitions are under /dev/evms/, so 
the YaST installer will not find the system devices. The YaST installer looks for this information in 
the /etc/fstab file.

The YaST installer uses the boot.lvm boot loader when it attempts to boot the device for the upgrade. 
The boot.lvm and boot.md boot loaders were disabled in Section A.3.3, “After the Linux Install,” on 
page 182, because the boot.evms is used by EVMS to boot the system under normal conditions. If 
you enabled the boot loaders using the instructions in Section , “Preparing an OES 1 SP2 Server,” on 
page 99 and you want to disable the loaders again, repeat the instructions in “Disable the boot.lvm 
and boot.md Services” on page 183.
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BOES 2 SP1 Linux File and Data 
Locations

This section contains information about the general rules and conventions Novell® follows when 
determining where various data types and program components are stored on the Linux file system. 

Where possible, we have tried to ensure that OES 2 SP1 Linux components follow Linux Standard 
Base (LSB) requirements regarding file location. Efforts to do this are detailed here.

Section B.1, “General Rules,” on page 189
Section B.2, “Exceptions,” on page 190

B.1  General Rules
Where possible, product design has followed these rules:

/opt/novell:  Contains all static data in the following standard subdirectories. 

/etc/opt/novell:  Generally contains host-specific configuration data.
If a product has a single configuration file, it is named product or service.conf.
If a product uses multiple configuration files, they are placed in a subdirectory named for the 
product or service.
/var/opt/novell:  Contains all variable data.
Variable data (data that changes during normal run time operations) is stored in a product or 
service subdirectory.
/var/opt/novell/log:  Generally contains log files.
If a product or service has a single log file, it is stored in a file with the product or service name.
If a product or service has multiple log files, they are stored in a subdirectory named for the 
product or service.
All files and directories that could not follow the above rules have the prefix novell- where 
possible.

/opt/novell/bin Executable files that are used by multiple products or are 
intended to be executed by an end user.

/opt/novell/product/bin Executable files that are used only by a product and are 
not executed by an end user.

/opt/novell/lib Shared libraries that are used by multiple products and 
shared or static libraries that are part of an SDK.

/opt/novell/include Header files for SDKs, typically in a product subdirectory.

/opt/novell/oes_install The OES installation and uninstallation code.
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B.2  Exceptions
Some files must reside in nonstandard locations for their products to function correctly. Two 
examples are init scripts, which must be in /etc/init.d, and cron scripts, which must be in /
etc/cron.d. When possible, these files have a novell- prefix. 

When standard conventions preclude the use of prefixes (for example in the case of PAM modules, 
which use suffixes instead of prefixes), the standard conventions are followed.
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CSetting Up an Installation Source 
on NetWare

Complete the instructions that follow to set up an Novell® Open Enterprise Server (OES) 2 Linux 
installation source on an existing OES NetWare® server.

Section C.1, “Prerequisites,” on page 191
Section C.2, “Copy the Files and Mount Them as NSS Volumes,” on page 191
Section C.3, “Create the Boot CDs,” on page 193

C.1  Prerequisites
You need the following:

A NetWare 6.5 server accessible on the network where you plan to install the OES 2 SP1 Linux 
servers with the following:

6 GB free disk space on the server
The Apache Web Server for NetWare installed and running

The following ISO image files from Novell:
These will set up installation sources for both i386 (32-bit) and x86_64 (64-bit) servers. If you 
plan to install only one of the platforms, then you need only the images associated with that 
platform.

For information on downloading these image files, see the Novell Open Enterprise Server 2 
Download Instructions (http://www.novell.com/documentation/oes2/esd/di_oes2.html).

C.2  Copy the Files and Mount Them as NSS 
Volumes
The following instructions create unrestricted access to OES 2 SP1 installation files on a NetWare 
server on your network. Restricting access to the installation files requires additional configuration 
through Apache Manager or manual editing of the Apache configuration files. 

Image File Purpose

SLES-10-SP2-i386-CD1.iso Boot CD for i386 (32-bit) SLES 10 SP2 installations 

SLES-10-SP2-x86_64.iso Boot CD for x86_64 (64-bit) SLES 10 SP2 installations

SLES-10-SP2-i386-DVD1.iso Install source for i386 (32-bit) SLES 10 SP2

SLES-10-SP2-x86_64-DVD1.iso Install source for x86_64 (64-bit) SLES 10 SP2

oes2-i386-CD1.iso Install source for i386 (32-bit) OES 2 SP1 Linux services

oes2-x86_64-CD1.iso Install source for x86_64 (64-bit) OES 2 SP1 Linux 
services
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For more information on restricting access, see information about the Options, Order, Deny, Allow, 
and other directives on the Apache.org Web Site (http://httpd.apache.org/docs-2.0/mod/
directives.html).

To provide unrestricted access to the OES 2 SP1 image files, do the following:

1 Create a directory at the root of a server volume with at least 6 GB of free disk space.
For example, you might create a directory named OES2_INSTALL in a volume named 
TOOLS.

2 Restrict access to the directory to only those administrators who copy image files to the 
directory. 
This is important because if someone attempts to access these files after they are mounted as 
NSS volumes, the volumes are immediately dismounted and no longer available.

3 Copy the DVD image files listed in “Prerequisites” on page 191 to the directory you just 
created.

4 At the server console, mount each image file as an NSS volume.
4a Enter the following command:

nss /MountImageVolume=volume:directory/filename.iso

where volume is the NSS volume name, directory is the directory you created in Step 1, 
and filename is the name of the ISO file.
Continuing the example, you might enter the following:
nss /MountImageVolume=TOOLS:OES2_INSTALL/SLES-10-SP2-i386-
DVD1.iso

4b Note the assigned volume name.
For the first SLES DVD you mount (either 32-bit or 64-bit), the name is 
SLES10SP_001, which is the actual volume name in the image file. For the second 
image you mount, the assigned name is CD_ followed by a four-digit number, starting 
with 0000. 
The same principle applies to the OES 2 SP1 image files. The first file mounted is the 
actual OES 2 SP1 volume name, but the second image is assigned a CD_xxxx name.
Knowing which volume is for which platform is critical as you create an access URL to 
the volume in Apache Manager. 

5 In a supported browser, start Apache Manager by entering the following URL:
https://server_ip_address:2200/apacheadmin/login.jsp
Replace server_ip_address with the IP address of the NetWare server.

6 Log in as the Admin user or a user with administrative rights to the Apache server.
7 Click the Content Manager  icon.
8 Click Additional Document Directories.
9 In the URL Prefix field, specify an alias name you want people to use to access one of the 

mounted volumes.
For example, if you are mounting the volume with the SLES 10 i386 installation files, you 
might name the alias, sles10sp1-i386. 

10 Click the Search icon next to the File Path field.
11 Click the volume name that matches the alias name you specified in Step 9, then click Finish.
SP1: Linux Installation Guide
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For example, if CD_0001 is the volume name that NetWare assigned to ISO image of the 
SLES 10 i386 installation source, then you would click CD_0001.

12 Click Save > Save and Apply > OK.
The path to the volume is added as an additional document.

13 Repeat from Step 9 for the other three volumes.

All of the ISO files are now available for access through the Apache Web Server running on the 
NetWare server.

C.3  Create the Boot CDs
See Section 3.2.2, “Preparing Physical Media for a New Server Installation or Upgrade,” on 
page 32.
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